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Introduction

ManuScript isasimple, music-based programming language used to write plug-insfor Sibelius | Ultimate. ManuScript is based on
Simkin, an embedded scripting language devel oped by Simon Whiteside, and has been extended by him and therest of the Sibelius
team ever since. (Simkin is aspooky pet name for Simon sometimes found in Victorian novels.) For more information on Simkin,
and additional help on the language and syntax, visit the Simkin website at www.simkin.co.uk.

Q Throughout this guide, “ Sbelius’ refersto Sbelius| Ultimate for the sake of readability.

Rationale

Providing a plug-in language for Sibelius | Ultimate addresses several different issues:

» Music notation is complex and infinitely extensible, so some users will sometimes want to add to a music notation program to
expand its possibilities with these new extensions.

« Itisuseful to alow frequently repeated operations (for example, opening aMIDI file and saving it as a score) to be automated,
using a system of scripts or macros.

Certain more complex techniques used in composing or arranging music can be partly automated, but there aretoo many to include
as standard features in Sibelius.

There were several conditions that we wanted to meet in deciding what language to use:

¢ The language had to be simple, as we want normal users (not just seasoned programmers) to be able to use it.

« Wewanted plug-insto be usable on any computer, as the use of computers running both Windows and Mac OS X iswidespread
in the music world.

» We wanted the tools to program in the language to be supplied with Sibelius.

« Wewanted musical concepts (pitch, notes, bars) to be easily expressed in the language.

« We wanted programs to be able to talk to Sibelius easily (to insert and retrieve information from scores).

» We wanted simple dialog boxes and other user interface elements to be easily programmed.

C/C++, theworld’ s “standard” programming language(s), were unsuitable as they are not easy for the non-specialist to use, they

would need a separate compiler, and you would have to recompile for each different platform you wanted to support (and thus cre-
ate multiple versions of each plug-in).

The language Javawas more promising asit isrelatively simple and can run on any platform without recompilation. However, we
would still need to supply acompiler for people to use, and we could not express musical conceptsin Javaas directly aswe could
with a new language.

So we decided to create our own language that is interpreted so it can run on different platforms, integrated into Sibelius without
any need for separate tools, and can be extended with new musical concepts at any time.

The ManuScript language that resulted is very simple. The syntax and many of the concepts will be familiar to programmers of
C/C++ or Java. Built into the language are musical concepts (Score, Staff, Bar, Clef, NoteRest) that are instantly comprehensible.
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Technical Support

Since the ManuScript language is more the province of our programmersthan our technical support team (who are not, in the main, pro-
grammers), we can’t provide detailed technical help on it, any more than Oracle will help you with Java programming. This document
and the sample plug-ins should give you agood idea of how to do some simple programming fairly quickly.

We would welcome any useful plug-ins you write — please contact us at www.sibelius.com/plugins and we may put them on our web
site; if we want to distribute the plug-in with Sibeliusitself, we'll pay you for it.

Mailing list for plug-in developers

Thereisagrowing community of plug-in developersworking with ManuScript, and they can be an inval uable source of help when writ-
ing new plug-ins. To subscribe, go to http://avid-listsrv1.avid.com/mailman/listinfo/plugin-dev.

System Requirements and Compatibility Information

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and alist of qualified computers, operating systems, hard drives, and third-party devices, visit:
www.avid.com/compatibility

Conventions Used in Sibelius Documentation

Sibelius documentation uses the following conventions to indicate menu choices, keyboard commands, and mouse commands:

Convention Action

File > Save Choose Save from the File tab

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse but-
ton

Right-click Click with the right mouse button

The names of Commands, Options, and Settings that appear on-screen are in a different font.
The following symbols are used to highlight important information:

Q User Tips are helpful hints for getting the most from your Sbelius system.
A Important Notices include information that could affect data or the performance of your Sbelius system.
Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid documentation.
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How to Use this PDF Guide

This PDF provides the following useful features:
» The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.
 Click a+ symbol to expand that heading to show subheadings. Click the — symbol to collapse a subheading.

» The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns
into afinger. Then click to locate to that subject and page.

» All crossreferencesin blue are active links. Click to follow the reference.
 Select Find from the Edit menu to search for a subject.

» When viewing thisPDF on aniPad, it isrecommended that you open the file using iBooks to take advantage of active linkswithin
the document. When viewing the PDF in Safari, touch the screen, then touch Open in “iBooks”.

Resources

The Avid website (www.avid.com) is your best online source for information to help you get the most out of Sibelius.

Account Activation and Product Registration

Activate your product to access downloadsin your Avid account (or quickly create an account if you do not have one). Register your
purchase online, download software, updates, documentation, and other resources.

www.avid.com/account

Support and Downloads

Contact Avid Customer Success (technical support), download software updates and the latest online manuals, browse the Compatibil-
ity documentsfor system requirements, search the online Knowledge Base or join the worldwide Avid user community on the User Con-
ference.

www.avid.com/support

Training and Education

Study on your own using courses available online, find out how you can learn in aclassroom setting at an Avid-certified training center,
or view video tutorials and webinars.

www.avid.com/education

Products and Developers

Learn about Avid products, download demo software, or learn about our Development Partners and their plug-ins, applications, and
hardware.

www.avid.com/products
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Sibelius ManuScript Language Tutorial

Edit Plug-ins

A Simple Plug-in

Let'sstart asimple plug-in. Y ou are assumed to have some basic experience of programming (such asBASIC or C), soyou'rea-
ready familiar with ideas like variables, loops, and so on.

To create a new Sibelius plug-in:

1 Start Sibelius and open or create a new score.

2 Choose File > Plug-ins > Edit Plug-ins.

Home Note Input Notations Text Play

H Save
B save as Show info for: =
U] New
Some of the text below may be used in text in
ﬁ Open the first and subsequent pages of your parts.
Title:
‘ Close e
-~ Easy Piece
A d
&2 Appen Subtitle:
m tor pino
Composer:
Recent B Bennett
Arranger:
Print
Artist:
Share
Export Instrument changes:
Piano
Teaching
Help

[ Y Plug-ins -

Install Plug-ins

Edit Plug-ins
Show Plug-in Trace Window 2017
ManuScript Language Reference

Selecting Edit Plug-ins in the File tab
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3 Thefollowing dialog appears:

Edit Plugins
Find plug-in Find
Plug-in Location on ribbon New
¥ Accidentals Note Input {Default)
Add Accidentals to All Notes .
Add Accidentals to All Sharp and Flat Notes Edit...

Add Ficta Above Note

Respell Flats as Sharps

Respell Sharps as Flats Delete
Simplify Accidentals

¥ Analysis Review (Default)

Add Schenkerian Scale Degrees
Compare Staves

Find Motive

Find Range

Unload

Reload

¥ Batch Processing Home (Default)

Calculate Statistics

Convert Folder of MIDI Files

Convert Folder of MusicXML Files Expand All
Convert Folder of Scores to Earlier Sibelius Version

Convert Folder of Scores to Graphics

Convert Folder of Scores to MIDI Collapse All
Convert Folder of Scores to MusicXML

Convert Folder of Scores to Web Pages

Export Each Instrument as MIDI

Restore Default Locations Close

Edit Plug-ins dialog

4 Click New.

(ZHCHE]

New ManuScript Plug-in

Name (without spaces): |
if Add to Plug-ins menu
Menu name:

Category name:

Cancel . 0K |

New ManuScript Plug-in dialog

5 You areasked to typetheinternal name of your plug-in (used asthe plug-in’sfilename), the name that should appear on the menu and
the name of the category in which the plug-in should appear, which will determine which ribbon tab it appears on.

6 Type Test asthe interna name, Test plug-in as the menu name and Tests as the category name, then click OK.

7 You'll seeTest (user copy) added to thelist in the Edit Plug-ins dialog under anew Tests branch of thetree view. Click Close. This
shows the folder in which the plug-in islocated (Tests, which Sibelius has created for you), the filename of the plug-in (minus the
standard .plg file extension), and (user copy) tellsyou that this plug-in islocated in your user application datafolder, not the Sibelius
program folder or application package itself.

8 If youlook in the Home > Plug-ins gallery again you'll see a Tests category, with a Test plug-in underneath it.
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9 ChooseHome > Plug-ins > Tests > Test and the plug-in will run. You may first be prompted that you cannot undo plug-ins, in which
case click Yesto continue (and you may wish to switch on the Don’t say thisagain option so that you' re not bothered by thiswarning
in future.) What does our new Test plug-in do? It just pops up a dial og which says Test (whenever you start anew plug-in, Sibelius
automatically generatesin a one-line program to do this). You'll aso notice awindow appear with a button that says Stop Plug-in,
which appears whenever you run any plug-in, and which can be useful if you need to get out of a plug-in you're working on that is
(say) trapped in aninfinite loop.

10 Click OK on the dialog and the plug-in stops.

Three Types of Information

Let’slook at what' sin the plug-in so far. Choose File > Plug-ins > Edit Plug-ins again, then select Tests/Test (user copy) from thelist
and click Edit (or simply double-click the plug-in’s nameto edit it). You'll see adialog showing the three types of information that can
make up aplug-in:

Methods Similar to procedures, functions, or routines in some other languages.
Dialogs The layout of any special dialogs you design for your plug-in.

Data Variableswhose valueis remembered between running the plug-in. Y ou can only store stringsin these variabl es, so they’ re useful
for things like user-visible strings that can be displayed when the plug-in runs. For a more sophisticated approach to global variables,
ManuScript provides custom user properties for all objects—see Edit Plug-ins.

test/test

Methods: Dialogs:

Initialize

= Method Dialog Data

Add Edit Delete Run Cancel 0K

Example: Test plug-in
Methods

The actual program consists of the methods. As you can see, plug-ins normally have at |least two methods, which are created automat-
icaly for you when you create a new plug-in:

Initialize

Thismethod is called automatically whenever you start up Sibelius. Normally it does nothing more than add the name of the plug-in to
the Plug-ins menu, although if you look at some of the supplied plug-insyou’ll notice that it’s sometimes al so used to set default values
for data variables.

Run

Thisis caled when you run the plug-in, you'll be startled to hear (it'slikemain() in C/C++ and Java). In other words, when you
choose Home > Plug-ins > Tests > Test, the plug-in’s Run method iscalled. If you write any other methods, you haveto call them from
the Run method—otherwise how can they ever do anything?

Sibelius ManuScript Language Tutorial



Click on Run, then click Edit (or you can just double-click Run to edit it). This shows a dialog where you can edit the Run method:

ManuScript Method

MName: Run

Parameters: (eg.xy 2)

Sibelius.MessageBox ("Test™);

Check Syntax OK ] | Cancel

ManuScript Method dialog

In thetop field you can edit the name; in the next field you can edit the parameters (the variables where val ues passed to the method are
stored); and below is the code itself:
Sibelius_MessageBox(*'Test™);

This callsamethod MessageBox which pops up the dialog box that says Test when you run the plug-in. Notice that the method name
isfollowed by alist of parametersin parentheses. In this casethere’ sonly one parameter: becauseitisastring (that is, text) itisin double
quotes. Notice also that the statement endsin a semicolon, asin C/C++ and Java. If you forget to type a semicolon, you'll get an error
when the plug-in runs.

What istherole of theword Sibeliusin Sibel ius.MessageBox? In fact it's avariable representing the Sibelius program; the state-
ment istelling Sibelius to pop up the message box (C++ and Java programmers will recognize that this variable refersto an “object”).
If this hurts your brain, we'll gointo it later.

Editing the Code

Now try amending the code slightly. Y ou can edit the code just like in aword processor, using the mouse and arrow keys, and you can
also use Command+X/C/V (Mac) or Control+X/C/V (Windows) for cut, copy and paste respectively. If you right-click, you get amenu
with these basic editing operations on them as well.

Change the code to this:
X = 1;
X =x+ 1;
Sibelius.MessageBox("1 + 1 = " & X);

Y ou can check this makes sense (or, at least, some kind of sense) by clicking the Check Syntax button. If there are any blatant mistakes
(e.g. missing semicolons) you will be notified where they are.

Then close the dialogs by clicking OK, OK again then Close. Run your amended plug-in from the Plug-ins menu and a message box
withtheanswer 1 + 1 = 2 should appear.

How doesit work? Thefirst two lines should be obvious. Thelast line uses & to stick two stringstogether. Y ou cannot use + asthisworks
only for numbers (if you try it in the example above, you will get an interesting answer!).

One pitfal: try changing the second line to:
X += 13

Then click Check syntax. Y ou will encounter an error: this syntax (and the syntax x++) isallowed in various languages but not in
ManuScript. You havetodo x = x+1;.

Sibelius ManuScript Language Tutorial



Where Plug-ins are Stored

Plug-ins supplied with Sibelius are stored in folders buried deep within the Sibelius program folder on Windows, and inside the appli-
cation package (or “bundl€”) on Mac. It isnot intended that end users should add extraplug-insto thesel ocationsthemsel ves, aswe have
provided a per-user location for plug-insto beinstalled instead. When you create anew plug-in or edit an existing one, the new or mod-
ified plug-in will be saved into the per-user location (rather than modifying or adding to the plug-insin the program folder or bundle):

* On Windows, additional plug-ins are stored at C:\Users\<username>\AppData\Roaming\Avid\Sibelius\Plugins.
* On Mac, additional plug-ins are stored in subfolders at /Users/<username>/Library/Application Support/Avid/Sibelius/Plugins.

Thisisworth knowing if you want to give a plug-in to someone else. The plug-ins appear in subfolders which correspond to the cate-
goriesin which they appear in the various Plug-ins galleries. The filename of the plug-in itself is the plug-in’sinternal name plus the
.plg extension, such as Test.plg.

(Sibelius includes an automatic plug-in installer, which you can access via File > Plug-ins > Install Plug-ins. This makesit easy to
download and install plug-ins from the Avid website.)

Line Breaks and Comments

Aswith C/C++ and Java, you can put new lines wherever you like (except in the middle of words), as long as you remember to put a
semicolon after every statement. Y ou can put several statements on one line, or put one statement on several lines.

Y ou can add comments to your program, again like C/C++ and Java. Anything after 7/ isignored to the end of the line. Anything be-
tween /* and */ isignored, whether just part of aline or severa lines:

// comment lasts to the end of the line

/* you can put

several lines of comments here

*/

For instance:
Sibelius._MessageBox(""Hi!'"); // print the active score

or:
Sibelius /* this contains the application */ _MessageBox("Hi!");

Variables

X inthe Test plug-inisavariable. In ManuScript a variable can be any sequence of letters, digitsor _ (underscore), as long as it does
not start with a digit.

A variable can contain an integer (whole number), afloating point number, a string (text) or an object (such as a note)—more about ob-
jectsinamoment. Unlike most languages, in ManuScript avariable can contain any type of data—you do not have to declare what type
you want. Thus you can store a number in avariable, then store some text instead, then an object.

Try this:
X = 56; X = x+1;
Sibelius.MessageBox(x); // prints "57" in a dialog box
X = "now this is text"; // the number it held is lost
Sibelius._MessageBox(x); // prints "now this is text" in a dialog
X = Sibelius.ActiveScore; // now it contains a score
Sibelius.MessageBox(x); // prints nothing in a dialog

Variablesthat are declared within a ManuScript method are local to that method; in other words, they cannot be used by other methods
inthe same plug-in. Global Data variables defined using the plug-in editor can be accessed by all methodsin the plug-in, and their values
are preserved over successive uses of the plug-in.

A quick aside about strings in ManuScript isin order at this point. Like many programming languages, ManuScript strings uses the
back-slash \ as an “escape character” to represent certain special things. To include asingle quote character in your strings, use\ ", and
to include anew line you should use \n. Because of this, to include the backslash itself in a ManuScript string one has to write \\.

Sibelius ManuScript Language Tutorial



Converting Between Numbers, Text, and Objects

Notice that the method MessageBox is expecting to be sent some text to display. If you giveit anumber instead (asin thefirst call to
MessageBox above) the number is converted to text. If you give it an object (such as a score), no text is produced.

Similarly, if acalculation is expecting a number but is given some text, the text will be converted to a number:
x =1 + "1"; // the + means numbers are expected
Sibelius_MessageBox(x); // displays "2*

If the text doesn’t start with a number (or if the variable contains an object instead of text), it istreated as O:
x =1 + "fred";
Sibelius_MessageBox(x); // displays “1~

Loops

“for” and “while”

ManuScript hasawh i 1e loop which repeatedly executes ablock of code until acertain expression becomes True. Create anew plug-in
called Potato. Thisis going to amuse one and al by writing the words of the well-known song “1 potato, 2 potato, 3 potato, 4.” Type
in the following for the Run method of the new plug-in:

X = 1;

while (x<5)

{
text = x & " potato,';
Sibelius.MessageBox(text);
X = X+1;

}

Runit. It should display “1 potato,” “2 potato,” “3 potato,” “4 potato,” which is a start, though annoyingly you haveto click OK after
each message.

Thewhi le statement isfollowed by aconditionin ( ) parentheses, then ablock of statementsin { } braces (you don’t need a semi-
colon after thefinal } brace). While the condition istrue, the block is executed. Unlike some other languages, the braces are compul sory
(you can’'t omit them if they only contain one statement). Moreover, each block must contain at least one statement.

In this example you can see that we are testing the value of x at the start of the loop, and increasing the value at the end. This common
construct could be expressed more concisely in ManuScript by using a for loop. The above example could also be written as follows:
for x =1 to 5

{
text = x & " potato,';

Sibelius.MessageBox(text);

}

Here, the variable x is stepped from the first value (1) up to the end value (5), stopping one step before the final value. By default, the
“step” usedis 1, but we could have used (say) 2 by using thesyntax for x = 1 to 5 step 2, whichwouldthen print only “1 potato”
and “3 potato”!

Notice the use of & to add strings. Because a string is expected on either side, the value of x isturned into a string.

Notice also we' ve used the Tab key to indent the statements inside the loop. Thisis agood habit to get into as it makes the structure
clearer. If you have loops inside loops you should indent the inner |oops even more.
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The if statement

Now we can add an i f statement so that the last phraseisjust “4,” not “4 potato”:
X = 1;
whille (x<5)
{
if(x=4)

{
text = x & ".";
s

else

{
}

Sibelius._MessageBox(text);
X = X+1;

}

Therulefor if takestheform i f (condition) {statements}. Youcanalsooptionadly addelse {statements}, whichisex-
ecuted if the condition isfalse. Aswith whi le, the parentheses and braces are compulsory, though you can make the program shorter
by putting braces on the same line as other statements:

X =1;

whille (x<5)

{

text

X & ' potato,';

if(x=4) {

text = x & ".";
} else {

text = x & ' potato,";
s

Sibelius.MessageBox(text);
X = X+1;

}

The position of bracesis entirely a matter of taste.

Now let’ smakethis plug-inreally cool. We can build up the four messagesin avariable called text, and only display it at the end, saving
valuable wear on your mouse button. We can also switch round the if and else blocks to show off the use of not. Finally, we return to
the for syntax we looked at earlier.

text = "'; // start with no text
for x =1 to 5

if (not(x=4)) {

text = text & x & " potato, ; // add some text
} else {
text = text & X & ".'; // add no. 4
}
}
Sibelius_MessageBox(text); // finally display it

10
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Arithmetic

Hereis acomplete list of the available arithmetic operators in ManuScript:

a+b add
a—-»b subtract
a*b multiply
a/’b divide
a%b remainder
—a negate

a) evaluate first

ManuScript eval uates operators strictly from left-to-right, unlike many other languages; so 2+3*4 evauatesto 20, not 14 asyou might
expect. To get the answer 14, you'd have to write 2+(3*4).

ManuScript supports both integers and floating point numbers. Use at least one floating point value in any arithmetic operation that
might result in afloating point number, otherwise the result is rounded to the nearest integer (unless you are using literal strings). For
instance, when calculating division using only integer values, theresult istruncated; for example, theresult of 3/2 is1. However, using
at least one floating point value in the calculation resultsin afloating point number (thisistrueif any or al of the values are afloating
point number); for example, theresult of 3.0/2 is1.5.

Conversion from floating point numbersto integers can be achieved with theRoundUp (expr), RoundDown (expr), and Round (expr)
functions, which can be applied to any expression.

Objects

Now we come to the neatest aspect of object-oriented languages like ManuScript, C++ or Java, which sets them apart from traditional
languages like BASIC, Fortran and C. Variablesin traditional languages can hold only certain types of data: integers, floating point
numbers, strings and so on. Each type of data has particular operations you can do to it: numbers can be multiplied and divided, for in-
stance; strings can be added together, converted to and from numbers, searched for in other strings, and so on. But if your program deals
with more complex types of data, such asdates (which in principle you could compare using =, < and >, convert to and from strings, and
even subtract) you are left to fend for yourself.

Object-oriented languages can deal with more complex types of data directly. Thusin the ManuScript language you can set avariable,
let’ssay thischord, to be achord in your score, and (say) add more notesto it:

thischord.AddNote(60); // adds middle C (nhote no. 60)

thischord.AddNote(64); // adds E (nhote no. 64)

If this seems magic, it’ s just analogous to the kind of things you can do to stringsin BASIC, where there are very special operations

which apply to text only:
A$ = "1
A$ = A$ + " potato, ": REM add strings
X = ASC(A%): REM get first letter code

In ManuScript you can set avariable to be achord, anotein achord, abar, astaff or even awhole score, and do thingsto it. Why would
you possibly want to set a variable to be awhole score? So you can saveit or add an instrument to it for instance.
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Objects in Action

We'll havealook at how music isrepresented in ManuScript in amoment, but for alittle taster, let’ s plunge straight in and adapt Potato
to create a score:

X = 1;

text = "'"; // start with no text

while (x<5)

if (not(x=4)) {
text = text & x & " potato, '; // add some text

} else {
text = text & x & "."; // add no. 4
b

X = X+1;
}
Sibelius.New(); // create a new score
newscore = Sibelius.ActiveScore; // put it in a variable
newscore.Createlnstrument(*'Piano™);
staff = newscore.NthStaff(l); // get top staff
bar = staff_NthBar(1); // get bar 1 of this staff
bar._AddText(0,text,"Technique'); // use Technique text style

This creates a score with a Piano, and types our potato text in bar 1 as Technique text.

The code usesthe period (. ) severa times, dwaysintheformvariable.variable or variable.method(). Thisshowsthat the
variable before the period has to contain an object.

If there’ savariable name after the period, we' re getting one of the object’ ssub-variables (called “fields’ or “ member variables’ in some
languages). For instance, if n isavariable containing anote, then n.Pitch isanumber representing its MIDI pitch (60 for middie C), and
n.Name isastring describing its pitch (“C4” for middle C). The variables available for each type of object are listed later.

If there’ samethod name after the period (followed by () parentheses), one of the methods allowed for thistype of object iscalled. Typ-
ically amethod called in thisway will either change the abject or return avalue. For instance, if s isavariable containing a score, then
s.Createlnstrument("'Flute') addsaflute (changing the score), but s.NthStaff (1) returnsavalue, namely an object con-
taining the first staff.

Let’'slook at the new codein detail. Thereis apre-defined variable called Sibelius, which contains an object representing the Sibelius
programitself. We' ve aready seenthe method Sibel ius .MessageBox (). Themethod call Sibelius.New() tells Sibeliusto cre-
ate anew score. Now we want to do something to this score, so we haveto put it in avariable.

Fortunately, when you create anew score it becomes active (i.e. itstitle bar highlights and any other scores become inactive), so we can
just ask Sibelius for the active score and put it in avariable:
newscore = Sibelius.ActiveScore

Then we can tell the scoreto createaPiano: newscore.Createlnstrument(*'Piano™). But to add sometext to the score you
have to understand how the layout is represented.

Representation of a Score
A scoreistreated as a hierarchy: each score contains 0 or more staves; each staff contains bars (though every staff contains the same
number of bars); and each bar contains “bar objects.” Clefs, text and chords are all different types of bar objects.

To add a bar object (i.e. an object which belongs to a bar), such as some text, to a score:

1 Specify which staff you want (and put it in avariable): staff = newscore.NthStaff(1).

2 Specify which bar in that staff you want (and put it in avariable): bar = staff_NthBar(1); finaly you tell the bar to add the
text: bar .AddText (0, text,"Technique™).

3 Specify the name (or index number — see Text styles on page 141) of the text style to use (and it has to be a staff text style, because
we' re adding the text to a staff).
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Notice that bars and staves are numbered from 1 upwards; in the case of bars, thisisirrespective of any bar number changesthat arein
the score, so the numbering is always unambiguous. In the case of staves, thetop staff isno.1, and al staves are counted, even if they’re
hidden. Thus a particular staff has the same number wherever it appearsin the score.

The AddText method for bars is documented later, but the first parameter it takesis arhythmic position in the bar. Each note in abar
has arhythmic position that indicates where it is (at the start, one quarter after the start, etc.), but the same istrue for all other objects
in bars. This shows where the object is attached to, which in the case of Techniquetext is aso where the left hand side of the text goes.
Thusto put our text at the start of the bar, we used the value 0. To put the text a quarter note after the start of the bar, use 256 (the units
are 1024th notes, so aquarter is 256 units):

bar.AddText (256, text,"Technique™);

To avoid having to use obscure numbers like 256 in your program, there are predefined variables representing different note values
(which are listed later), so you could write:
bar._AddText(Quarter,text,"Technique'™);

or to be quaint you could use the British equivalent:
bar.AddText(Crotchet, text, " Technique');

For adotted quarter, instead of using 384 you can use another predefined variable:
bar.AddText(DottedQuarter,text, " Technique');

or add two variables:
bar.AddText(Quarter+Eighth, text,""Technique');

Thisis much clearer than using numbers.

The System Staff

Asyou know from using Sibelius, some objects don't apply to asingle staff but to al staves. These include titles, tempo text, rehearsal
marks and special barlines; you can tell they apply to al staves because (for instance) they get shown in al the instrumental parts.

All these objects are actually stored in a hidden staff, called the system staff. Y ou can think of it asan invisible staff which is aways
abovethe other stavesin asystem. The system staff isdivided into barsin the same way asthe normal staves. So to add thetitle“ Potato”
to our score we' d need the following code in our plug-in:

sys = newscore.SystemStaff; // system staff is a variable

bar = sys.NthBar(1);

bar.AddText (0, "POTATO SONG","Subtitle™);

Asyou can see, SystemStaffisavariableyou can get directly from the score. Remember that you have to use asystemtext style (here
Subtitle is used) when putting text in abar in the system staff. A staff text style like Technique won't work. Also, you have to specify
abar and position in the bar; this may seem slightly superfluous for text centered on the page as titles are (though in reality even this
kind of page-aligned text is aways attached to a bar), but for Tempo and Metronome mark text they are obviously required.

Representation of Notes, Rests, Chords, and Other Musical Items

Sibelius representsrests, notes and chordsin aconsistent way. A rest has no noteheads, anote has 1 notehead and a chord has 2 or more
noteheads. Thisintroduces an extrahierarchy: most of the squigglesyou seein ascore are actually aspecial type of Bar object that can
contain even smaller things (namely, noteheads). There's no overall name for something which can be arest, note or chord, so we've

invented the pretty name NoteRest. A NoteRest with 0, 1 or 2 noteheads is what you normally call arest, anote or a chord, respec-
tively.

If nisavariable containing aNoteRest, thereis avariable n.NoteCount which contains the number of notes, and n.Duration
which is the note-value in 1/256ths of a quarter. Y ou can also get n.Highest and n. Lowest which contain the highest and |owest
notes (assuming n.NoteCount isn't 0). If you set lownote = n.Lowest, you can then find out things about the lowest note, such
as lownote . Pitch (anumber) and lownote .Name (astring). Complete detail s about all these methods and variables may be found
in Object Reference.

Other musical objects, such as clefs, lines, lyrics and key signatures have corresponding objects in ManuScript, which again have var-
ious variables and methods available. For example, if you have aLine variable In, then In_EndPosition givesthe rhythmic posi-
tion at which the line ends.
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The “for each” Loop

It'sacommon requirement for aloop to do some operation to every staff in ascore, or every bar in astaff, or every Bar object in abar,
or every note in aNoteRest. There are other more complex requirements which are still common, such as doing an operation to every
Bar object in ascorein chronological order, or to every Bar object in amultiple selection. ManuScript has a for each loop that can
achieve each of these in a single statement.

The simplest form of for each islikethis:
thisscore = Sibelius.ActiveScore;
for each s in thisscore // sets s to each staff in turn
{ // ...do something with s
s

Here, since thisscore isavariable containing a score, the variable s is set to be each staff in thisscore inturn. Thisis because
staves are the type of object at the next hierarchical level of objects (see Hierarchy of Objects).

For each staff in the score, the statements in {} braces are executed.

Score objects contain staves, as we have seen, but they can also contain a Selection object, e.g. if the user has selected a passage
of music before running the plug-in. The Selection object isaspecial case: it isnever returned by a for each loop, because there
isonly asingle Selection object; if you use the Selection object inafor each loop, by default it will return Bar objects (not
Staves, Bars or anything else!).

Let’ stake another example, thistime for notesin a NoteRest:
noterest = bar.NthBarObject(l);
for each n in noterest // sets n to each note in turn

{
}

n isset to each note of the chord in turn, and its note name is displayed. Thisworks because Notes are the next object down the hierarchy
after NoteRests. If the NoteRest is, in fact, arest (rather than anote or chord), the loop will never be executed—you don’t have to check
this separately.

Sibelius.MessageBox("'Pitch is " & n_Name);

The same form of loop will get the bars from a staff or system staff, and the Bar objects from a bar. These loops are often nested, so
you can, for instance, get several bars from several staves.

Thisfirst form of the for each loop got a sequence of objectsfrom an object in the next level of the hierarchy of objects. The second form
of the for each loop lets you skip levels of the hierarchy, by specifying what type of object you want to get. This saves alot of nested
loops:

thisscore = Sibelius.ActiveScore;

for each NoteRest n in thisscore

n.AddNote(60); // add middle C
}

By specifying NoteRest after for each, Sibeliusknowsto produce each NoteRest in each bar in each staff in the score; otherwiseit would
just produce each staff in the score, because a Staff object isthe type of object at the next hierarchical level of objects. The NoteRests
are produced in a useful order, namely from the top to the bottom staff, then from left to right through the bars. Thisis chronological
order. If you want adifferent order (say, all the NoteRestsin thefirst bar in every staff, then all the NoteRestsin the second bar in every
staff, and so on) you'll have to use nested |oops.

So here’ s some useful code that doubles every note in the scorein octaves:
score = Sibelius.ActiveScore;
for each NoteRest chord in score
{
if(not(chord.NoteCount = 0)) // ignore rests
{
note = chord.Highest; // add above the top note
chord.AddNote(note.Pitch+12); // 12 is no. of half-steps (semitones)
T
s
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It could easily be amended to doublein octavesonly in certain barsor staves, only if the notes have a certain pitch or duration, and so on.

Thiskind of loop isalso very useful in conjunction with the user’ s current selection. This sel ection can be obtained from avariable con-

taining aScore object asfollows:
selection = score.Selection;

We can then test whether it’s a passage selection, and if so we can look at (say) all the barsin the selection by means of a for each
loop:
if (selection.lsPassage)

{

for each Bar b in selection

// do something with this bar

}
}

Be aware that you can not add or remove items from bars during iterating. The example of adding notesto chords above isfine because
you are modifying an existing item (in this case a NoteRest), but it’ s not safe to add or remove entireitems, and if you try to do so, your
plug-in will abort with an error. However, it s very useful to add or remove items from bars, so you need to do that in a separate for
loop, after first collecting the items you want to operate on into a ManuScript array, something like this:

num = O;

for each obj in selection

if (IsObject(obj))

{
n = "obj" & num;
@n = obj;
num = num + 1;
3

}

selection.Clear();
for i = 0 to num

{
n = "obj" & i;
obj = @n; // get an object from the pseudo array
obj.Select();

}

The @n in this example isthe array.

Indirection, Sparse Arrays, and User Properties

Indirection

If you put the @ character before a string variable name, then the value of the variable is used as the name of avariable or method. For

instance:
var=""Name";
X = @var; // sets x to the contents of the variable Name

mymethod=""Show";
@mymethod(); // calls the method Show

Thishas many advanced uses, though if taken to excessit can causethe brain to hurt. For instance, you can use @ to simulate“unlimited”
arrays. If name isavariable containing the string "x1", then @name is equivaent to using the variable x1 directly. Thus:

i = 10;
name = "X" & i;
@name = 0;

sets variable x10 to 0. The last two lines are equivalent to x[i] = 0; inthe Clanguage. This has many uses; however, you'll aso
want to consider using the built-in arrays (and hash tables), which are documented below.
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Sparse Arrays

The method described above can be used to create “fake” arrays through indirection, though thisis alittle fiddly. ManuScript al so pro-
vides Javascript-style sparse arrays, which can store anything that can be stored in a ManuScript variable, including references to ob-
jects. Like avariable, storing areference to an object in a sparse array will preserve the lifetime of that object (because objects are ref-
erence counted), but the underlying object in Sibelius may become invalid if (say) a Scoreis modified.

To create asparse array in ManuScript, use the built-in method CreateSparseArray(al,a2,a3,a4...an). Y ou can create an empty ar-
ray simply by passing in no variablesto the CreateSpareArray method.

Sparse arrays provide a read/write variable called Length that returns or sets the length of the array: when you set Length to a number
greater than the present size of the array, the array is padded with null values; if you set Length to anumber smaller than the present size
of the array, any values beyond this number are removed.

To push one or more values to the end of the array, use the method Push(al, a2, ... an). To remove and return the last element of an
array, use the method Pop().

An example of how to use a sparse array:
array = CreateSparseArray(4,5,6);
array[10] = 19; // creates 11th element of array, intervening elements are null
array.Length = 20; // extends array to 20 elements, new elements are all null

Sparse arrays by their nature may not have valuesin every array element. To return anew sparse array containing only the populated
indices of the original sparse array (those that are not null), use the array’sVal idIndices variable. For example, using the above
Sparse array:

array2 = array.Validlndices; // will contain values 0, 1, 2, 10 and 19

return array[array2[0]]; // returns the Ffirst populated element of array

Y ou can compare two sparse arrays for equality, for example:
if (array = array2) {
// do something
}

To accessthe end of an array, it’ sconvenient to use negativeindices; e.g. array[-1] returnsthelast element, array[-2] returnsthe
penultimate element, and so on. It’s not possible to access elements before the start of the array, so if you do e.g. array[-100] ona
six element array, you will get array[0] returned.

Some things to remember when using sparse arrays:
 Sparse arrays use a zero-based index.
» Elementsthat have not been initialized are null, and do not cause an error when referenced.
 Assigning to an index beyond the current length increases the Length to one greater than the index is assigned to.

« |f an array contains references to objects, whether the arrays are equal or not depends on the implementation of equality for those
objects.

User Properties

All ManuScript objects other than those listed below, including objects created by Sibelius, can have user properties attached to them,
alowing for convenient storage of extradata, encapsulation of several items of datawithin asingle object, and returning more than one
value from a method, among other things.

To create a new user property, use the following syntax:
object._property:property_name = value;

where object isthe name of the object, property_name isthe desired user property name, and value isthe value to be assigned to
the new user property. User properties are read/write and can be accessed as object.property_name.

To get asparse array containing the names of al the user properties belonging to an object:
names = object._propertyNames;
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Hereis an example of creating a user property:
nr = bar.NoteRest;
nr._property:original = true;
if (nr.original = true) {
// do something
}

Some things to remember when using user properties:
« If you attempt to get or set a user property that has not yet been created, your plug-in will exit with arun-time error.

» To check whether or not a user property has been created without causing a run-time error, use the notation object._prop-
erty:property_name, which will be null if no matching user property has been created yet.

 User properties cannot be created or accessed for normal data types (e.g. strings, integers, etc.), the globa Sibel ius object,
old-style ManuScript arrays created by CreateArray (), old-style hashes created by CreateHash(), and nul I.

» User properties that conflict with an existing property name cannot be accessed as object . property_name (though they can be
accessed using the . _property: notation).

 User properties belong to a particular ManuScript object and disappear when that object’s lifetime ends. To stop an object dying,
you can (for example) storeit in a sparse array, but be aware that its contents may become invalid if (say) the underlying score
changes.

Dictionary

Dictionary isaprogrammer extensible object, simply allowing the use of user properties as above with convenient construction. It
a so has methods allowing the use of arbitrarily named user properties, and can also have methodsin plug-ins attached to it allowing the
creation of encapsulated user objects (i.e. objects with variables and methods attached to them).

To createadictionary, use the built-in function CreateDi ctionary(namel, valuel, name2, value2, ... nameN, valueN). This creates
adictionary containing user properties called namel, name2, nameN with values valuel, value2, valueN respectively.

A dictionary can contain named dataitems (likeastruct inlanguageslike C++), or datathat isindexed by string, so that you can use
strings to look items up within it.

Thevaluesin adictionary can be accessed using square bracket notation, so you can use adictionary like a hash table. For example:
test = CreateDictionary(""fruit',apple,"vegetable' ,potato);
test["fruit'"] = banana;
test["meat™] = lamb;

Y ou can even put other objects, such as sparse arrays, inside dictionaries. For example:
test2 = CreateDictionary("'fruit”,
CreateSparseArray(apple,banana,orange));

Y ou can access the user properties within adictionary using the . _property : notation. For example:
return test2. property:fruit;

which would return the array specified above. Even more direct, you can access user propertiesin adictionary asif they werevariables
or methods, like this:
test2_fruit;

which would also return the array specified above. Y ou can aso return more than one value from any ManuScript method using a dic-
tionary, such as:

getChord()

value = CreateDictionary(''a", aNote, "b", anotherNote);

return value;

//. .. in another method somewhere

chord = getChord();

trace(chord.a);

trace(chord.b);

which returns two values, a and b, which you can accessviae.g. chord.a and chord.b.
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Y ou can compare two dictionaries for equality. For example:
if (test2 = testld) {
// do something
}

Whether or not dictionaries containing objects evaluate as equal depends on the implementation of equality for those objects.

If you' re comfortable with programming in general, you may find it useful to be able to add methodsto dictionaries, particularly if you
are writing code designed to act as alibrary for other methods or plug-insto call. Writing code in this way provides a degree of encap-
sulation and can make it easy for client code to use your library.

To add amethod to a dictionary, call the dictionary’s SetMethod () method. For example:
pluginmethod "(obj,x,y) {
// a method that does something to obj

}
test4 = CreateDictionary();

test4._SetMethod("'doSomething",Self,"pluginmethod');
test4._doSomething(3,4);
// call pluginmethod within the current plug-in, passing in
// test4 (obj in the method above) and 3 (x in the method
// above) and 4 (y in the method above)

In the example above, doSomething isthe name of the method belonging to the dictionary, Self tells the plug-in that the method is
defined in the same plug-in, and pluginmethod is the name of a method elsewhere in the plug-in (shown at the top of the example).

To return asparse array containing the names of the methods belonging to adictionary, use the dictionary’s GetMethodNames ()
method. Y ou can also check the existence of a particular method using the dictionary’ s MethodEx ists() method. Use the dictio-
nary’'s Cal IMethod () method to call a specific method, where the name of the method is the first parameter, and any parameters to
be passed to the specified method follow.

For example:
array = test4._GetMethodNames(); // create sparse array containing method names
first_method_name = array[0]; // sets first_method_name to name of first method
methodfound = test4_MethodExists(''doSomething'); // returns True in this case;
test4._CallMethod(*'doSomething™,5,6);

Everything you put into adictionary is auser property, so al of the methods outlined in User properties above can be used on datain
dictionaries too.

Using User Properties as Global Variables

Y ou can store SparseArray and Dictionary objects, and indeed any other object, as user properties of the Plugin object itself.
In the example below, Se Il ¥ isthe object that corresponds to the running plug-in, and a user property global Data is assigned to the
plug-in, containing a Dictionary:

Self._._property:globalData = CreateDictionary(1,2,3,4);

// globalData and Self._globalData can be used interchangeably

trace(globalData);

trace(Self._globalData);

User properties assigned to the plug-in are persistent between invocations. Take care to ensure that these user properties are created be-
fore you attempt to use them, otherwise your plug-in will abort with arun-time error. Using the _property : property_name syntax
never causes run-time errors, but direct references to property_name force aruntime error if property_name hasn't been created yet.
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The example bel ow shows how to test the existence of a specific user property, globalCounter, initiaizeitto O if itisnot found, then
increment it by 1 every time the plug-in runs:
// Test the persistence of user properties
if (Self__property:globalCounter = null) {
Self._property:globalCounter = 0;

}

globalCounter = globalCounter + 1;

// this number increases by one every time the plug-in is run
trace(globalCounter);

trace(Self._globalCounter);

If you store areferenceto amusical object in auser property that isassigned to the plug-in, thereisan increased danger of that reference
becoming invalid due to the score being closed or edited, etc. Use the IsVal id() method to validate such data before using it.

User properties of plug-inswill be inaccessible (except by using the _property : property_name syntax) if thereis an existing global
variable of the same name.

Watch Out for Recursive Cycles!

Be careful not to create recursive cycles using arrays, user properties and dictionaries. When you use, say, an array in adictionary, you
are not creating a copy of the array or itsvalues, but areference to the origina array: dictionaries and arrays are objects, not values. As
aresult, you could write something where an array contains adictionary that itself refersto the original array: thiswill lead to Sibelius
crashing. So be careful!

Other Things to Look Out For

The Parallel 5ths and 8ves plug-in illustrates having several methods in a plug-in, which we haven't needed so far. The Proof-read
plug-in illustrates that one plug-in can call another — it doesn’t do much itself except call the CheckPizzicato, CheckSuspectClefs,
CheckRepeats and CheckHarpPedaling plug-ins. Thus you can build up meta-plug-ins that use libraries of others. Cool!

(Y ou object-oriented programmers should be informed that this works because, of course, each plug-in is an object with the same pow-
ers as the objects in a score, so each one can use the methods and variables of the others.)

Dialog Editor

For more complicated plug-ins than the ones we' ve been looking at so far, it can be useful to prompt the user for various settings and
options. This may be achieved by using ManuScript’s simple built-in dialog editor. Dialogs can be created in the same way as methods
and data variables in the plug-in editor.

Showing a Dialog in a Plug-In

To show adialog from a ManuScript method, we use the built-in call
Sibelius.ShowDialog(dialogName, Self);

where dialogName isthe name of the dialog we wish to show, and Sel ¥ isa“special” variable referring to this plug-in (telling Si-
belius to whom the dialog belongs). Control will only be returned to the method once the dialog has been closed by the user.

Creating or Editing a Dialog

To create anew dialog, choose the Dialog radio button at the bottom of the window that lists methods, dataand dialogs, and click Add.
To edit an existing dialog, select it from the Dialogs list box at the top right-hand corner of the window, and click Edit.
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The dialog form will then appear, aong with along thin “palette” of available controls, as follows:

-\
&’
-

Radio button

Checkbox

Button

Static text

Editable text

Combo box

List box

MM IO E» 08 ®

Group box

Control palette
To create anew control, just drag and drop it from the palette onto the dialog.

Dialog Properties

With no controls selected, either double-click on ablank part of the dialog (or right-click, and then choose Properties) to access the di-
alog’'s Properties dialog, which allows you to specify:

« Name: the value of dialogName for the Sibel ius.ShowDialog() method call (see Showing adialog in a plug-in above).

« Title: the name of the dialog asit appearsin itstitle bar.

 Size: the Width and Height (measured in somewhat arbitrary dialog units); you can al so set the size of the dialog by resizing it directly
when editing it.

« Position: the X and Y position that the dialog should open at by default.

Laying Out Controls

The diaog editor includes a number of simple options for producing a pleasing layout:
» To select acontrol, either click it or hit Tab to select the next control in the creation order (Shift-Tab selects the previous control).
 To nudge a selected control, use the arrow keys.

» Todign controls, select them using Command-click (Mac) or Control-click (Windows), then use Command+Left Arrow (Mac) or
Control+Left Arrow (Windows) to align all of the selected controlswith the left-hand edge of the left-most control, or Command+Up
Arrow (Mac) or Control+Up Arrow (Windows) to align all of the selected controls with the top edge of the top-most control.

 To space controls evenly, select them using Command-click (Mac) or Control-click (Windows), then use Command+Option+Op-
tion+Down Arrow (Mac) or Control+Alt+Shift+Down Arrow (Windows) to space the controls evenly in the distance between the top
edge of the top-most and the bottom edge of the bottom-most controls, or Command+Option+Option+Left Arrow (Mac) or Con-
trol+Alt+Shift+Left Arrow (Windows) to space the controls evenly in the distance between the left-hand edge of the left-most and the
right-hand edge of the right-most controls. Once controls are spaced evenly, you can increase or decrease the space between them pro-
portionally by typing Command+Option+Option+Up, Down, Right, Left Arrow keys (Mac) or Control +Alt+Shift+Up, Down, Right,
Left Arrow keys (Windows) as appropriate.
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Y ou can optionally display agridto aid with alignment. Right-click on ablank part of the dial og and choose Grid from the context menu
to see a dialog with settings for the grid:

Grid Settings

V| Show grid
Dots
@ Lines
Opacity: D
V| Snap to grid

Horizontal size: 16

RINER

Vertical size: 16

[ 0K ] | Cancel

Grid Settings dialog

Switch on Show grid to show the grid in the editor. Choose between Dots or Lines, and specify the Opacity of the grid display by ad-
justing the slider. Switch on Snap to grid to enable control snapping asyou drag them with the mouse. Although acontrol that you nudge
with the keyboard will not snap to the grid, one side of its selection outline will flash when it comesinto alignment with thegrid in either
the horizontal or vertical directions.

Undo and Redo

Y ou can undo and redo everything you have done while editing a dialog using Command+Z (Mac) or Control+Z (Windows) to undo
and Command+Y (Mac) or Control+Y (Windows) to redo.

Testing the Dialog

To test the dialog within the editor, right-click ablank part of the dialog and choose Test from the context menu, or type the shortcut
Command+T (Mac) or Control+T (Windows). To finish testing and return to the editor, press Esc or click any control whose properties
are set to close the dialog (e.g. an OK or Cancel button, if you have created one).

Saving Changes

To save the changesto the dialog, click the close button in the dialog’ stitle bar. If there are any unsaved changes, Sibelius promptsyou
to save the changes.

Set Creation Order

If you have done any programming in other languages that allow you to edit dialogs, you will probably be familiar with the concept of
tab order, which refers to the order in which controls are given the focus when the user repeatedly hits the Tab key to cycle through
them. ManuScript has asimilar concept called creation order, so named because the order in which the controlsin adialog are created
affects not only the tab order but also some other subtle things (including radio button grouping—see Radio Buttons).
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To set the creation order of controlsin your plug-in’s dialog, right-click on ablank part of the dialog and choose Set Creation Order
from the context menu. A special display appears overlaid on the controlsin your dialog, like this:

f [8) change Dynamics - @1

[ #t | [ c8a || 90 |

L5

Plug-in dialog with creation order overlay

To set the creation order, simply click on each control in order. If you make a mistake, press Command (Mac) or Control (Windows)
and click onthelast control whose order is correct to restart the sequence from that point, then release Command (Mac) or Control (Win-
dows) and resume clicking on the remaining controls. Once you' re done, press Esc to finish editing the creation order.

Control Properties

Every control that you create also has a Properties dial og, which can be accessed by double-clicking aselected control, by right-clicking
and choosing Properties from the context menu, or by pressing Command+Return (Mac) or Control+Return (Windows). The dialog for

aradio button control, for example, is shown below:

Radio Button Properties

D:  IDC_WHOLE_SCORE_RADIO

il hole score|
Position Size
X: 15 Width: 80
Y= | 17 Height: 16

Action

Variable storing control's value:  WholeScore

Method called if dicked: WholeScoreOr

[ Click doses dialog, returning. ..
() True
(7 False

[ Give this contral focus

Start a new radio button group

L5

Radio Button Properties dialog
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With a control selected, the properties window varies depending on the type of the control, but most of the options are common to al
controls, and these are as follows:

¢ ID: aninternal string that identifies the control; Sibelius generates this for you automatically, but you can change if you like.

« Text: the text appearing in the control.

« Position (X, Y): where the control appearsin the dialog, in coordinates relative to the top left-hand corner.

¢ Size (width, height): the size of the control.

 Variable storing control’svalue: the ManuScript Datavariable that will correspond to the value of this control when the plug-inisrun.

» Method called when clicked: the ManuScript method that should be called whenever the user clickson thiscontrol (leave blank if you
don’t need to know about users clicking on the control).

 Click closes dialog: select thisoption if you want the dialog to be closed whenever the user clicks on this control. The additional op-
tions Returning True/ False specify the value that the Sibel ius . ShowDialog method should return when the window is closed
in thisway.

« Givethiscontrol focus: select this option if the “input focus’ should be given to this control when the dialog is opened (such as
whether this should be the control to which the user’s keyboard applies when the dialog is opened). Thisis mainly useful for editable
text controls.

Other options vary according to the type of control selected.

Combo Boxes and List Boxes

Combo boxes and list boxes have an additional property; you can set avariable from which the control’ slist of values should be taken.
Likethe value storing the control’ s current value, this should be aglobal Datavariable. However, in thisinstance they have arather spe-
cial format, to specify alist of strings rather than simply a single string. Look at the variable _Combo I tems in Add String Fingering
for an example —it looks like this:

_Comboltems

{
"y
Hou
ngn
vy
"1 and 3"
"2 and 4"

}

List boxes have one further property, which isto determine whether they should allow a single selection or multiple selections. The re-
turn value from acombo box or asingle-selection list box isasingle string. If alist box is set to allow multiple selections, the selection
isreturned as an array of strings.

Radio Buttons

Radio buttons al so have an additional property that allows oneto specify groups of radio buttonsin plug-in dialogs. When the user clicks
on aradio buttonin agroup, only the other radio buttons belonging to that groups are desel ected; any othersin the dialog are left asthey
are. Thisis extremely useful for more complicated dialogs.

To specify aradio group, pick one control from each group that representsthe first button of the group, and for these controls ensure that
the checkbox Start a new radio group is selected in the control’ s Properties dialog. Then set the creation order of the controls (see Set
Creation Order). A radio button group is defined as being al the radio buttons created between two buttons that have the Start a new
radio group flag set (or between one of these buttons and the end of the dialog). So to make the radio groups work properly, ensure that
each group is created sequentially in order, with the button at the start of the group created first, and then all therest of the radiosin that
group. To finish, click the Set Creation Order menu item again to deactivate this mode.
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Static Text

Static text controls additionally allow you to determine whether the text should be aligned to the L eft (useful for explanatory text) or to
the Right (useful for text associated with a specific control to itsright, such as an edit control, checkbox or combo box).

Buttons

In most plug-in dialogs, you will want the OK button to be the default button for the dialog, such that if the user presses Return or Enter
on their keyboard, the dialog is confirmed, and closes. Likewise, you will want the Cancel button to respond to the user hitting Esc on
their keyboard, closing the dialog without making any changes.

For OK buttons, or other buttons that should confirm the dialog, switch on the Default button for dialog checkbox in the button’ s Prop-
erties dialog. Each dialog should only have one default button. Y ou will also normally set Click closes dialog, returning to True. De-
pending on the other controlsin your dialog, you may additionally want to check Give this control focus; if you have one or more edit
controlsin the dialog, you should probably set Give this control focus on the first of those controlsinstead.

Cancel buttons, by contrast, should normally only have Click closes dialog, returning set to False.

Debugging Plug-ins

When developing any computer program, it’s all too easy to introduce minor (and not so minor!) mistakes, or bugs. ManuScript per-

formsitsowninternal error checking at al times, and you' Il find that if you try to access anon-existent method or variable on an object,
or make a syntax error, or attempt to add or remove bars or items from bars while iterating over them, the plug-in will throw an error
and open the plug-in editor window at the line that generated the error.

As ManuScript is asimple, lightweight system, thereis no specia purpose debugger, but there are a handful of tools provided to help
you debug your plug-ins.

Undo

One good technique for finding problemsin your plug-insisto set Sibelius's undo buffer to avery small size, or to disableit altogether
(by dragging the slider on the Other page of File > Preferences to itsleftmost position). In the unlikely event that M anuScript does not
throw an error when you perform an illegal operation (e.g. adding or deleting an object while iterating over a bar), reducing the undo
buffer to its smallest possible size will expose the problem right away — though be warned, the result of such a problem may be that Si-
belius will crash.

Plug-in Trace Window

Thetrace window can be shown by choosing Plug-ins > Plug-in Trace Window. A special ManuScript command, trace (string), will
print the specified string in the trace window. Thisis useful to keep an eye on what your plug-inisdoing at particular points. These com-
mands can then be removed when you’ ve finished debugging. Another useful feature of the trace window isfunction call tracing. When
thisisturned on, the log will show which functions are being called by plug-ins.

One potential pitfall with the trace(string)approach to debugging is that the built-in hash table and array objects discussed earlier
aren’t strings, and so can’t be output to the trace window. To avoid this problem, both of these objects have a corresponding method
caledWriteToString(), which returns astring representing the whole structure of the array or hash at that point. So we could trace
the current value of an array variable as follows:

trace(array variable = " & array.WriteToString());

Checking the Validity of Objects

One of the common problems that you might encounter when writing complex plug-insisthat the object you are trying to operateonis
no longer valid (e.g. it has already been deleted). Y ou can enable error checking — either for all objects, or for individual objects— that
will cause your plug-in to throw an error if an object is no longer valid.
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To enableerror checking, usethe ManuScript command Val idationChecking(enable[, objectl[, object?]...]), and set the Boolean
parameter enableto true. If enableisthe only parameter, validation checking is enabled for all types of objects, and al plug-ins. If you
supply one or more object parameters (e.g. Tuplet, Score, BarObject, etc.), only those objectswill be checked, and only in the cur-
rently running plug-in. Y ou should ensure Val idationChecking isset to false before you give your plug-insto anybody elseto use.

Y ou can aso use the special method IsVal id() to determine whether an object isvalid: it will return false if the object in question
no longer exists. GetVal idationError(object) returnsan empty string if thereis no error, or returns a string if an error has oc-
curred, use trace(GetValidationError(score)); totrace any validation error returned by a Score object to the trace win-
dow.

Stopping the Plug-in

If you want to force your plug-in to stop on a particular error condition, use StopP lugin([message]), which will stop your plug-in,
display the optional message in an aert box, and open the plug-in editor at the line of code reached.

You can also use ExitPlugin(), which exits the plug-in cleanly without dropping into the plug-in editor.

Storing and Retrieving Preferences

In Sibelius 4 or later, you can use Preferences.plg, contributed by Hans-Christoph Wirth, to store and retrieve user-set preferences for
your plug-ins.

How Does it Work?

Preferences.plg storesitsdatain atext filein the user’ sapplication datafol der. Strings are accessed as associated pairs of akey (the name
of the string) and a value (the contents of the string). The value can also be an array of strings, if required.

Initializing the Database

errorcode = Open(pluginname,featureset) ;

Open the library and lock for exclusive access by the calling plug-in. The calling plug-in isidentified with the string pluginname. It is
recommended that this string equals the unique Sibelius menu name of the calling plug-in.

Parameter featureset is the version of the feature set requested by the calling plug-in. The version of the feature set is currently 020000.
Each library release showsinitsinitial dialog alist of supported feature sets. The call to Open() will fail and show a user message if
you request an unsupported feature set. If you should want to prevent this user information (and probably setup your own information
didog), use CheckFeatureSet() first.

After Open() the scopeis undefined, such that you can access only global variables until the first call to SwitchScope().
Return value: Open () returns zero or apositive value on success. A negative result indicatesthat therewasafatal error and the database
has not been opened.

» -2 other error

e -1 library does not support requested feature set

0 no common preferences database found

1 no preferences found for current plug-in

2 preferences for current plug-in loaded

In case of errors (e.g. if the database file is unreadable), Open () offersthe user an option to recover from the error condition. Only if
thisfailstoo will an error code be returned to the calling plug-in.
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errorcode = CheckFeatureSet(featureset) ;
Check silently if the library supports the requested feature set.

Return value: CheckFeatureSet() returnszero or apositive value on success. A negative value indicates that the requested feature
set is not supported by this version.

errorcode = Close();

Release the exclusive access lock to the library. If there were any changes since the last call to Open() or Write(), dump the data
changes back to disk (probably creating a new score, if there was none present).

Return value: Close () returns zero or a positive value on success. A negative result indicates that there was afatal error and the da-
tabase has not been written.

errorcode = CloseWithoutWrite();
Release the exclusive access |lock to the library, discarding any changes performed since last call to Open() or Write().

Return value: CloseWithoutWrite() returns zero or apositive value on success. A negative result indicates that there was afatal
error, namely that the database was not open at the moment.

errorcode = Write(dirty);

Force writing the data back to disk immediately. Keep library locked and open. If dirty equals 0, the write only takes place if the data
has been changed. If dirty is positive, the common preferences scoreis unconditionally forced to be rewritten from scratch.

Return value: Write() returns zero or a positive value on success. A negative result indicates that there was afatal error and the da-
tabase has not been written.

Accessing Data

index = SetKey(keyname, value) ;

Store a string value under the name keyname in the database, overwriting any previously stored keys or arrays of the same keyname.

If keyname has been declared as alocal key, the key is stored within the current scope and does not affect similar keys in other scopes.
Itisan error to call SetKey() for local keysif the scope is undefined.

Return value: SetKey () returns zero or a positive value on success, and a negative value upon error.

errorcode = SetArray(keyname, array, size) ;

Storean array of stringsunder the name keyname in the database, overwriting any previously stored keysor arrays of the same keyname.
size specifies the number of elementsin the array. A size of -1 isreplaced with the natural size of the array, i.e., array .NumChi l-
dren.

If keyname has been declared asalocal key, the array is stored within the current scope and does not affect similar keysin other scopes.
Itisan error to cal SetArray() for local keysif the scope is undefined.

Return value: SetArray () returns zero or a positive value on success, and a negative value upon error.

value = GetKey(keyname) ;

Retrievethe value of key keyname from the database. It isan error to call GetKey () on anidentifier which had been stored the last time
using SetArray(). For local keys, the value isretrieved from the current scope which must not be undefined.

Return value: The value of the key or Preferences.VOID if no key of that name found.
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size = GetArray(keyname, myarray) ;

Retrieve the string array stored under name keyname from the database. It is an error to call GetArray () on an identifier which has
been stored the last time by SetKey (). For local arrays, the value is retrieved from the current scope which must not be undefined.

Y ou must ensure before the call that myarray is of ManuScript’s array type (i.e., created with CreateArray()).

Return value: size equalsthe number of retrieved elementsor -1 if the array was not found. Note that size might be smaller than myar -
ray .NumChi ldren, because there is currently no way to reduce the size of an aready defined array.

size = GetListOflds(myarray);

Fill thearray myarray with alist of all known Idsin the current score (or in the global scope, if undefined). Before you call this method,
ensure that myarray is of ManuScript’s array type (i.e. created with CreateArray()).

Return value: returns the size of the list, which might be smaller than the natural size of the array, myarray.Numchi ldren.
index = Unsetld(keyname);

Erase the contents stored with an identifier (there is no distinction between keys and arrays here). If the key isdeclared aslocdl, itis
erased only from the local scope which must not be undefined.

Return value: The return value is zero or positive if the key has been unset. A negative return value meansthat a key of that name has
not been found (which is not an error condition).

Remove Id(keyname) ;

Erase all contents stored in the database with an identifier (there is no distinction between keys and arrays here). If the key is declared
aslocal, it is erased from all local scopes.

Return value: The return valueis always zero.
RemoveAlllds();
Erase everything related to the current plug-in.

Return value: the return value is always zero.

Commands for Local Variables
errorcode = DeclareldAsLocal (keyname) ;

Declare anidentifier asalocal key. Subsequent callsto Set. . . and Get. . . operationswill be performed in the scope whichis set at
that time. The local stateis stored in the database and can be undone by a call to DeclareldAsGlobal or Removeld.

Return value: Non-negative on success, negative on error.

size = GetListOfLocallds(myarray);

Fill the array myarray with alist of al Ids declared aslocal. Before you call this method, ensure that myarray is of ManuScript’s array
type (i.e. created with CreateArray()).

Return value: Returns the size of the list, which might be smaller than the natural size of the array, myarray .NumChi Idren.
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errorcode = SwitchScope(scopename) ;

Select scope scopename. If scope scopename has never been selected before, it is newly created and initialized with no local variables.
Subsequent Set. . . and Get. . . operations for keys declared as local will be performed in scope scopename, while access to global
keysis still possible.

Thecall SwitchScope (') selects the undefined scope which does not allow access of any local variables.

Return value: Non-negative on success, negative on error.

errorcode = RemoveScope();

Erase dl local keys and arrays from the current scope and del ete the current scope from the list of known scopes. It isan error to call
RemoveScope () if the current scope is undefined. After the call, the database remains in the undefined scope.

errorcode = RemoveAllScopes();

Erase dl local keysand arrays from all scopes and delete all scopes from the list of known scopes. After the call, the database remains
in the undefined scope. Note that this call does retain the information which Ids are local (see DeclareldAsLocal ()).

Return value: Non-negative on success.

string = GetCurrentScope();
Retrieve the name of the currently active scope, or the empty string if the database is in undefined scope.

Return value: Returns a string.

size = GetListOfScopes(myarray) ;

Fill the array myarray with alist of al known scope names. Y ou must ensure before the call that myarray is of ManuScript’ sarray type
(i.e., created with CreateArray()).

Return value: Returns the size of the list, which might be smaller than the natural size of the array, myarray .NumChi ldren.

Miscellaneous

Trace(tracelevel) ;

Select level of tracing for the library. Useful levels are: O for no trace, 10 for sparse trace, 20 for medium trace, 30 for full trace.
This command can also be run when the library is not open, to specify the tracing level for the Open() call itself.

TraceData();

Writes afull dump of the data stored currently in ThisData array to the trace window. Thisisthe full data belonging to the current
plug-in. TraceData() aways traces the data, regardless of the current trace level selected.

filename = GetFilename();

Return the full filename of the preferences database (including path).

Editor();

Invoke the interactive plug-in editor. This method must not be called while the database is open. Direct callsto Editor () from
plug-ins are deprecated, since the end-user of your plug-inwill probably not expect to be able to edit (and destroy) the saved preferences
of al plug-ins at this stage.

Basic Example

Suppose you have a plug-in called myplugin and would like to save some dialog settings in a preferences file such that these settings
are persistent over several Sibelius sessions and computer reboots. Y our dialog may contain two checkboxes and alist box. Let
DialogDontAskAgain and DialogSpeedMode be the global variables holding the status of the checkboxes, respectively, and let
DialogJobList hold the contents of the list box item.

28

Sibelius ManuScript Language Tutorial



The work with the database can be reduced to four steps:

1 Open the database and retrieve initial data. At begin of your plug-in, e.g. right at top of your Run() method, you have to add some
codeto initialize the database. You probably aso want to initialize your global keys based on the information currently stored in the
database. See below for a detailed example. (Depending on your program, you might have to define prefOpen asaglobal variable
in order to prevent trying to access an unopened database in future.)

// At first define hard coded plug-in defaults, in case that the plug-in
// is called for the first time. ITf anything else fails, these defaults
/7 will be in effect.
DialogDontAskAgain = 0;
DialogSpeedMode = 0;
DialogJobList = CreateArray();
DialogJobList[0] = "Ffirst job";
DialogJobList[1] = *"second job™;
// Attempt to open the database
prefOpen = Preferences.Open( "myplugin®™, 020000 );
if( prefOpen >= 0 ) {
// Database successfully opened. So we can try to load the
// information stored last time.
// 1t’s a good idea to work with a private version scheme, in order
// to avoid problems in the future when the plug-in is developed
// further, but the database still contains the old keys. In our
// example, we propose that the above mentioned keys are present
// if "version" key is present and has a value of "1".
version = Preferences.GetKey( "Version" );
switch( version ) {
case( "1" ) {
// Now overwrite the above set defaults with the information stored
// in the database.
DialogDontAskAgain = Preferences.Getkey( "DontAskAgain™ );
DialogSpeedMode = Preferences.Getkey( ''SpeedMode' );
Preferences.GetArray( "JobList"™, DialogJobList );

}
default {
// handle other versions/unset version gracefully here ...

}
}
}

2 Work with the data. After the initialization step, you can and should work with global variables DialogDontAskAgain,
DialogSpeedMode, and DialogJobList asyou are used to: read from them to base control flow decisions on their setting,
write to them (mostly from within your own dialogs) to set new user preferences.

3 Write data back to the database. To make any changes persistent, you must tell the database the new values to be written to the hard
disk. See below for adetailed example. According to taste, you can execute these lines each time the settings are changed, or only
once, at the end of your plug-in.

if( prefOpen >= 0 ) {
Preferences.SetKey( "Version™, "1" );
Preferences.SetKey( ""DontAskAgain', DialogDontAskAgain );
Preferences.SetKey( "'SpeedMode', DialogSpeedMode );
Preferences.SetArray( "JobList", DialogJobList, -1 );

}

4 Closethedatabase. In any case, you must release thelock to the library on exit of your plug-in. Thiswrites dataactually back to disk,
and enables other plug-ins to access the shared database later. To do this, use:

Preferences.Close();
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Object Reference

Syntax

Hereisaninformal run-down of the syntax of ManuScript.

A method consists of alist of statements of the following kinds:

{ statements }

for example:
Block {
a=4;
bs
while {expression} block
for example:
While while (i < 3) {

Sibelius.MessageBox(1);
i =i+ 1;

switch (test-expression) {
case (case-expression-1) block
[ case (case-expression-2) block ]

[ defaultblock]

IThe switch statement consists of a “test” expression, multiple case statements and an optional default statement. If the
value of test-expression matches one of the case-expressions, then the statement block following the matching case
statement will be executed. If none of the case statements match, then the statement block following the default state-
ment will be executed. For example:
Switch switch (note.Accidental) {
case (DoubleSharp) {
Sibelius.MessageBox(*'Double sharp™);
}
case (DoubleFlat) {
Sibelius.MessageBox("'Double flat'™);
}
default {
Sibelius.MessageBox("'No double'™);

}

if (expression) block [ else block]

for example:

) if (found) {

it else Application.ShowFindResults(found);

} else {
Application._NotFindResults();
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for each

For each variable in expression block

IThis sets variable to each of the sub-objects within the object given by the expression.

Normally there is only one type of sub-object that the object can contain. For instance, a Note

Rest (such as a chord) can only contain Note objects. However, if more than one type of sub-object is possible you can
specify the type:

for each Typevariable in expression

block

for example:
for each NoteRest n in thisstaff {
n.AddNote(60); // add middle C

3

for

For variable = value to value[ step value]
block

[The variable is stepped from the first value up to or down to the end value by the step value. It stops one step before
the final value.

ISo, for example:

for x=1 to note.NoteCount {

}

works correctly.

assignment

variable = expression;

for example:

value=value+ 1;

or

variable. variable = expression;

for example:
Question.CurrentAnswer=True;

method call

\variable.identifier (comma-separated expressions) ;

for example:
thisbar.AddText(0, "Mozart", "text.system.composer');

selfmethod
call

identifier (comma-separated expressions) ;

Calls a method in this plug-in, for example:
ChecklIntervals();

return

return expression;

Returns a value from a plug-in method, given by the expression. If a method doesn’t contain a return statement, then
la “null” value is returned (either the number zero, an empty string, or the nul I object described below).

Expressions

Here are the operators, literals and other beasts you' re allowed in expressions.

Self

null

Identifier

This is a keyword referring to the plug-in owning the method. You can pass yourself to other methods, for
example:
other.Introduce(Self);

This is a literal object meaning “nothing.”
This is the name of a variable or method (letters, digits or underscore, not starting with a digit) you can pre-

cede the identifier with @ to provide indirection; the identifier is then taken to be a string variable whose value
is used as the name of a variable or method.

variable.variable

member variable

integer

floating point

number

This accesses a variable in another object.
for example:

.1,100, -1

for example:

1.5,3.15,-1.8

Object Reference
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string

not

and

or

equality

subtract

add

minus

concatenation

subexpression

Object Reference

Text in double quotes, for example: “some text.” For strings that are rendered by Sibelius as part of the
score, i.e. the contents of some text object, there is a small but useful formatting language allowing one to
specify how the text should appear. These “styled strings” contain commands to control the text style. All
commands start and end with a backslash (\) The full list of available styling commands is as follows:

\n\ New paragraph
\N\ New line

\B\ Bold on

\b\ Bold off

\I\ Italic on

\i\ Italic off

\U\ Underline on
\u\ Underline off

\fArial Black\ Font change to Arial Black (for example)
\ctext.character._musictext\
Character style change to Music text (for example)

\f_\ Font change to text style’s default font, including removing any active character
styles

\s123\ Size change to 123 (units are 1/32nds of a space, not points)

v\ Vertical scale in percent

\h\ Horizontal scale in percent

\t\ Tracking (absolute) in 1/32nds of a space

\p\ Baseline adjustment: use normal, sub (for subscript) or super (for superscript)
\$keyword\ Substitutes a string from the Score Info dialog (see below)

A consequence of this syntax is that backslashes themselves are represented by \\, to avoid conflicting
with the above commands.

The substitution command \$keyword\ supports the following keywords:

Title, Composer, Arranger, Lyricist, Morelnfo, Artist, Copyright, Publisher and
PartName.

Each of these correspond to a field in the File > Score Info dialog.

not expression

Logically negates an expression, for example:
not (x=0)
expression and expression

Logical and, for example:
FoxFound and BadgerFound
expression or expression

Logical or, for example:
FoxFound or BadgerFound
expression = expression

Equality test, for example:
Name=""Clock""
expression — expression

Subtraction, for example:
12-1
expression + expression

Addition, for example:
12+1
—expression

Inversion, for example:
-1
expression & expression

Add two strings, for example:
Name = "Fred" & '""Bloggs'"; // “Fred Bloggs’

You can't use + as this would attempt to add two numbers, and sometimes succeed (!). For instance:
X = "2" + "2"; // same as x = 4

(expression)

For grouping expressions and enforcing precedence, e.g.
(4+1)*5



variable. identifier(comma-separated expressions) ;
method call for example:

X = monkey.CountBananas();
I dentifier (comma-separated expressions) ;

self method call Calls a method in this plug-in, for example:
X = CountBananas();

Operators

Condition Operators

Y ou can put any expressionsin parentheses after an i f or whi le statement, but typically they will contain conditions such as=and <.
The available conditions are very simple:

a=>b equals (for numbers, text or objects)
a<bhb less than (for numbers)

a>b greater than (for numbers)

c and d both are true

cord either are true

not c inverts a condition, e.g. not(x=4)
<= less than or equal to

>= greater than or equal to

1= not equal to

Use = to compare for equality, not == as found in C/C++ and Java.

Arithmetic

a+b add
a->b subtract
a*hb multiply
a/b divide
a%b remainder
-a negate

() evaluate first

ManuScript will evaluate expressions from left to right, so that 2+3*4 is 20, not 14 as you might expect. To avoid problems with eval-
uation order, use parentheses to make the order of evaluation explicit. To get the answer 14, you'd have to write 2+(3*4).

ManuScript aso now supports floating point numbers, so whereasin previous versions 3/2 would work out as 1, it now evaluatesto
1.5. Conversion from floating point numbers to integers is achieved with the RoundUp (expr), RoundDown (expr) and
Round (expr)functions, which can be applied to any expression.
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All Objects

Methods

AddToPluginsMenu(*'menutext', **function name') Addsanew menuitem to the Plug-ins menu. When the menu itemis selected
the given function is called. Thisis normally only used by plug-ins themselves. This method may only be called once per plug-in (that
is each plug-in may only add one item to the Plug-ins menu); subsequent method calls will be ignored.

Asc(expression) Returnsthe ASCII value of agiven character (the expression should be a string of length 1).

CharAt(expression, position) Returns the character from the expression at the given (zero-based) position, for example
CharAt(**Potato’,3) would give“a.”

Chr(expression) Returns a character (as a string) with the given ASCII value. This can be used for inserting double quotes (**) into
strings with Chr(34).

CreateArray() Returnsanew array object.
CreateHash() Returnsanew hash-table object.

GetValidationError(object) Returnsthe validation error, if any, of the specified object. Useful to pass validation errorsto the
plug-in trace window.

ExitPlugin() Exitsthe plug-in cleanly without dropping into the plug-in editor
IsObject(expression) Returns 1 (or True) if expression evaluates to an object rather than a null, boolean, string, or any number.

(Not to be confused with the I sPassage variable of Selection objects!)

IsvValid(object) Returns 1 (or True) if the object isvalid, returns O (or False) if the object no longer exists (that is has been de-
leted).

JoinStrings(expression, delimiter) Joinstogether (concatenates) an array of stringsinto asingle string, separated by the string de-
limiter.

Length(expression) Givesthe number of charactersin the value of the expression.

Round(expression) Returnsthe nearest integer to the value of the expression, for example Round(1.5) would be“2” and
Round(1.3) wouldbe“1.”

RoundDown (expression) Returns the nearest integer less than the value of the expression, for example RoundDown (1 .5) would be
E

RoundUp(expression) Returnsthe nearest integer greater than the val ue of the expression, for example RoundUp(1.5) wouldbe“2.”

SplitString(expression,[delimiter,][trimEmpty] ) Splitsastring into an array of strings, using the given delimiter. The delimiter
can be asingle character or a string containing several characters—for instance **. ,"* would treat either acommaor full stop asade-
limiter. The default delimiter isthe space character. If the trimEmpty parameter is True then thiswill ignore multiple delimiters (which
would otherwise produce some empty strings in the array). The default value of trimEmpty is Fal se.

s=":a:b:c";

bits=SplitString(s,":", false);

// bits[0] = "7; bits[1] = "a"; bits[2] = "b"

s="a b c";

bits=SplitString(s,” ", true);

// bits[0] = "a"; bits[1]="b"

StopPlugin([message]) Stops the plug-in, and shows the optional message in an aert box. Opens the plug-in editor at the line of
code reached.

Substring(expression, start, [length]) Thisreturns a substring of the expression starting from the given start position (zero-based)
up to the end of the expression, for example Substring(*'Potato’,2) would give “tato”. When used with the optional length pa-
rameter, Substring returns a substring of the of the expression starting from the given start position (zero-based) of the given length, for
example Substring(*'Potato’,2,2) would give “ta’.

Trace(expression) Sends a piece of text to be shown in the plug-in trace window, for example Trace(*'Here's a trace');
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ValidationChecking(enable] , objectl], object?]...]) If enableisthe only parameter, validation checking isenabled for all types
of objects, and acrossall plug-ins. If you supply one or more object parameters (suchasTuplet, Score, BarObject, and so on), only
those objects will be checked, and only in the currently running plug-in. Y ou should ensure Val idationChecking isset to false
before you give your plug-insto anybody else to use.

User Properties

All objects (except for the Sibel ius object, old-style ManuScript arrays created using CreateArray(), old-style ManuScript
hashes created using CreateHash (), and nul I) can aso have user properties assigned to them.

Accessibility
Accessed from the Sibel ius object.

Methods

None.

Variables
ScoreDescription

Returns true if Sibelius' s built-in score description functionality is enabled (read/write).

Bar

A Bar contains BarObject objects.
for each variable in producesthe BarObjects in the bar

for each typevariable in producesthe BarObjects of the specified type in the bar

Methods

AddBarNumber (new bar number[ , format[ , extra_text[ , prepend] , skip thisbar]]]]) Adds abar number change to the start of this
bar. new bar number should be the desired external bar number. The optional format parameter takes one of the three pre-defined con-
stantsthat define the bar number format; see Global Constants. Theoptional extra_text parameter takesastring that will be added after
the numeric part of the bar number, unless the optional boolean parameter prepend is True, inwhich casetheextra_text isadded before
the numeric part of the bar number. If the optional skip thisbar parameter is True, the bar number changeis created with the Don't in-
crement bar number option set. Returns the BarNumber object created.

AddChordSymbol FromPitches(position, pitcheq , instrument style] ) Adds achord symbol from the given array of pitchesat the
specified position. The optional instrument style parameter operates the same asin the AddGu i tarFrame method (see above). If the
method is unable to create a chord symbol, the method returns null; otherwise it returns the Gui tarFrame object created.

AddClef(pos, concert pitch clef[ , transposed pitch clef]) Adds a clef to the staff at the specified position. concert pitch clef deter-
minesthe clef style when Notes > Transposing Score is switched off; the optional transposed pitch clef parameter determinesthe clef
style when thisis switched on. Clef styles should be an identifier like “ clef .treble”; for acomplete list of available clef styles, see Clef
Styles. Alternatively you can give the name of aclef style, such as“Treble,” but bear in mind that this may not work in non-English
versions of Sibelius. Returns the Clef object created.

AddComment(sr, text[ , color[ , maximized]]) Addsacomment at the specified sr position in the current bar, displaying the specified
text. The optional color parameter allowsyou to specify the color of the comment that is created (if not specified, the comment is created
with its default color), and the optional maximized Boolean parameter allows you to set the comment to be minimized (if not specified,
the comment is created maximized by default). If you want to specify the maximized parameter without specifying aparticular color, set
color to -1.

36

Object Reference



AddCommentWithName(sr,text, username| , color[ ,maximized]]) Addsacomment that will display a given username at the spec-
ified sr position in the current bar, displaying the specified text. The optional color parameter allows you to specify the color of the com-
ment that is created (if not specified, the comment is created with its default color), and the optional maximized Boolean parameter al-
lows you to set the comment to be minimized (if not specified, the comment is created maximized by default). If you want to specify
the maximized parameter without specifying a particular color, set color to -1.

AddGraphi c(file name, poq , below staff[ , x displacement[ , y displacement[ , size ratio]]]]) Addsagraphic above or below the bar
at agiven position. If below staff is True, Sibelius will position the graphic below the staff to which it is attached, otherwise it will go
above (the default). Y ou may additionally displace the graphic from its default position by specifying x- and y displacements. These
should be expressed in millimeters, the latter defining an offset from the top or bottom line of the staff, as appropriate. By default, the
graphic will be created 5mm away from the staff. To adjust the size of the graphic, you may set afloating point number for itssizeratio.
When set to 1.0 (the default), the graphic will be created with a height equal to that of the staff to whichit is attached. A value of 0.5
would therefore halve its size, and 2.0 doubleit. The graphic may be rescaled to a maximum of five timesthe height of its parent staff.
This function returns True if successful, otherwise False.

AddGraphicToBlankPage(file name, nth page, x offset, y offset[ , size ratio]) Addsagraphic to ablank page belonging to the cur-
rent bar. nth page specifies the particular blank page you would like the graphic to, starting from 1. The x offset and y offset parameters
arefloating point valuesrel ative to the size of the page the graphic is being added to. For example, an x offset of 0.0 would position the
graphic at the very left of the page; 0.5 in the center. Y ou may specify the size of the graphic by specifying avaue for sizeratio. This
defaultsto 1.0, which has the same effect as creating a graphic in Sibelius manually using Create > Graphic. (Aswith AddGraphic,
0.5 would halveitssize, and 2.0 doubleit.) The graphic may be rescal ed to amaximum of fivetimesitsinitial size. Thisfunction returns
True if successful, otherwise False.

AddGui tarFrame(position, chord name| , instrument style| , fingerings] ) Addsachord symbol for the given chord nameto the bar.
The optional instrument style parameter should refer to an existing instrument type that uses tab, and should be specified by identifier;
see Instrument Types. If instrument styleis not specified, Sibeliuswill create a chord symbol that will optionally display a chord di-
agram using the default tab tuning associated with the instrument type used by the staff to which the chord symbol will be attached. The
position isin 1/256th quarters from the start of the bar. The optional fingerings parameter gives the fingerings string to display above
(or below) the guitar frame, if supplied. If the method is unable to create a chord symbol, the method returns null; otherwiseit returns
the GuitarFrame object created.

AddInstrumentChange(pos, stylelD[ , add_clef[ , show_text[ ,text_label[ , show_warning[ , warning_label,[full_instrument_nam
¢[,short_instrument_name]]]]1]]) Adds an instrument change to the bar at the specified position. stylel D is the string representing the

instrument type to change to (see Instrument Types for alist). The optional boolean parameter add_clef, True if not specified, deter-
mines whether Sibeliuswill add a clef change at the same position as the instrument change if required (that isif the clef of the new in-
strument is different to that of the existing instrument). show_text is an optional boolean parameter, True if not specified, determining
whether or not the text |abel attached to the instrument change should be created shown (the default) or hidden. text_label isan optional

string parameter; if specified, Sibeliuswill usethisstring instead of the default string (the new instrument’ slong name). show_warning
isan optional boolean parameter, True if not specified, determining whether or not Sibelius should create a text object (using the In-

strument change staff text style) above thelast note preceding the instrument change, announcing the instrument change and giving the
player timeto pick up the new instrument. warning_label isan optional string parameter; if specified, Sibeliuswill usethisstring instead
of the default string (the word “ To” followed by the new instrument’ s short name). Y ou can also override the names Sibelius will give
the instruments on subsequent systems. If anull string is passed to either full_instrument_name or short_instrument_name (or if the ar-
guments are omitted), the instrument names will remain unchanged. Returns the InstrumentChange object created.

AddKeySignatureFromText(pos, key name, major key[ , add double barling[ , hidden[ , one staff only]]]) Adds akey signature
tothe bar. The key signatureis specified by text name, such as“Cb” or “C#". Thethird parameter isaBoolean flag indicating if the key
ismajor (or minor). Unlessthefourth parameter is set to Fal se, adouble barline will ordinarily be created alongside the key signature
change. Y ou may additionally hide the key signature change by setting hidden to True, and make the change of key appear onthebar’'s
parent staff only with the one staff only flag. Returns the KeySignature object created.

AddKeySignature (pos, num sharps, major key[ ,add double barling[ , hidden[ , one staff only]]]) Addsakey signatureto the bar.
The key signature is specified by number of sharps (+1 to +7), flats (-1 to —7), no accidentals (0) or atonal (-8). The third parameter is
aBoolean flag indicating if the key ismajor (or minor). Unlessthe fourth parameter is set to Fal se, adouble barline will ordinarily be
created alongside the key signature change. Y ou may additionally hide the key signature change by setting hidden to True, and make
the change of key appear on the bar’ s parent staff only with the one staff only flag. Returns the KeySignature object created.
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AddLine(pos, duration, line style[ , dx[ , dy[ , voicenumber| , hidden]]]]) Addsalineto the bar. The line style can be an identifier
such as“line.staff.hairpin.crescendo” or aname, such as*“ Crescendo” . For acompletelist of line styleidentifiersthat can be used in any
Sibelius score, seeLine Styles. Styleidentifiers are to be preferred to named line styles as they will work across all language versions
of Sibelius. Returnsthe Line object created, which may be one of a number of types depending on the Line style used.

AddLiveTempoTapPoint(position) Addsalive Tempo tap point at the rhythmic position specified by position, in 1/256th quarters
from the start of the bar.

AddLyric(position,duration, text[ , syllable type [ , number of notes, voicenum]]]) Thismethod addsalyricto the bar. The position
isin 1/256th quarters from the start of the bar, and the duration isin 1/256th quarter units. The two optional parameters allow you to
specify whether the lyricisat the end of aword (valueis“1”, and isthe normal value) or at the start or middle of aword (valueis“0"),
and how many notes the lyric extends beneath (default value 1). Y ou can aso optionally specify the voice in which the lyric should be
created; if voicenumis 0 or not specified, the lyric is created in al voices. Returnsthe Lyricltem object created.

AddNote (pos, sounding pitch, duration, [tied [ , voice] , diatonic pitch[ , string number]]]]) Adds a note to staff, adding to an exist-
ing NoteRest if already at this position (in which case the duration isignored); otherwise creates a new NoteRest. Will add a new bar

if necessary at the end of the staff. The position isin 1/256th quarters from the start of the bar. The optional tied parameter should be

True if you want the note to betied. Voice 1 is assumed unless the optional voice parameter (with avalue of 1, 2, 3 or 4) is specified.

Y ou can also set the diatonic pitch, that isthe number of the “ note name” to which this note corresponds, 7 per octave (35 = middle C,

36 =D, 37 = E and so on). If adiatonic pitch of zero is given, a suitable diatonic pitch will be calculated from the MIDI pitch. The op-
tional string number parameter gives a string number for this note, which is only meaningful if the note is on atablature stave. If this

parameter is not supplied then adefault string number is cal culated based on the current tablature stave type and the guitar tab fingering
options (specified on the Notes page of File > Preferences). Returnsthe Note object created (to get the NoteRest containing the note,

use Note.ParentNoteRest).

AddPageNumber ([blank page offset]) Creates and returns a page number change at the end of the bar. Due to the nature of adding a
page number change, a page break will also be created at the end of the bar. Therefore, the page number change will actually be placed
at the start of the next bar. The desired properties of the page number change can be set by calling the appropriate methods on the Page
Number Change object returned.

The blank page offset flag allows you to create page number changes on blank pages. If aBarOb ject isfollowed by one or more blank
pages, each blank page may also have a page number change of its own. If unspecified, the page number change will be created on the
next available page (whether it contains music or not) after the bar, otherwise the user may specify a 1-based offset which refersto the
nth blank page after the bar itself.

AddPageNumberAtStartOfBar() Createsand returnsapage number changeat the start of the bar. Thisisuseful for adding apage
number change at the very start of the score, that isto change the initial page number, by using this method on the first bar of the score.
If used on abar later in the score, it will create the page number change at the end of the previous bar, but unlike the AddPageNumber
method, it will not force a page break, so in general the AddPageNumber method is recommended.

AddRehearsalMark ([ consecutive] , mark] , new prefix and suffix[ , prefix[ , suffx[ , override defaults]]]]]) Adds arehearsal mark
above the bar. If no parameters have been specified, the rehearsal mark will inherit the properties of the previous rehearsal mark in the
score, incrementing accordingly. Optionally, the appearance of the rehearsal mark may be overridden. If consecutiveis False, Sibelius
will not continue the numbering of the new rehearsal marks consecutively, but allow the user to set anew mark. A mark may be ex-
pressed as a number of a string. For example both 5 and “e” are both valid and equivalent values. If new prefix and suffix is True, the
values set for prefix and suffix will be applied to the new rehearsal mark. Thefinal parameter, override defaults, is a Boolean defaulting
to False whose purpose it is to mimic the behavior of the option with the same name in the Rehearsal Mark dialog in Sibelius.

AddSpecialBarline(barlinetype , pos]) Addsaspecia barlineto agiven positionin abar; see Global Constants. If no position
has been specified, start repeat barlines will snap to the start of the bar by default. All other special barline types will snap to the end.

AddSymbo I (pos, symbol index or name) Addsasymbol to the bar at the specified position. If the second parameter isanumber, this
istaken to be an index into the global list of symbols, corresponding to the symbol’ s position in the Create > Symbol dialog in Sibelius
(counting left-to-right, top-to-bottom from zero in the top-left hand corner). Some useful symbols have pre-defined constants; see
Global Constants. There are also constants defined for the start of each group in the Create > Symbol dialog, so that to accessthe 8va
symbol, for example, you can use theindex OctaveSymbols + 2.

It' s better to useindices rather than names, because the names will be different across the various language versions of Sibelius. Returns
the Symbol object created, or nul I if no symbol can be added to the score.
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AddText(pos, text, style[ , voicenum] ) Adds thetext at the given position, using the given text style. A staff text style must be used
for anormal staff, and a system text style for asystem staff. The styles should be an identifier of the form “text.staff.expression”; for a
complete list of text styles present in all scores, see Text Styles. Alternatively you can give the name of atext style, such as“Expres-
sion”, but be aware that this may not work in non-English versions of Sibelius. Y ou can also optionally specify the voicein which the
lyric should be created; if voicenumis 0 or not specified, the text object is created in all voices. Returns the Text object created.

AddTextToBlankPage (xPos, yPos, text, style, pageOffset) Adds the text at the given position, using the given text style. A blank

page text style must be used; you cannot add staff text or system text to a blank page. styletakes astyle ID, using the form “text.blank-
page.title”; for acomplete list of text styles present in all scores, see Text Styles. xPos and yPos are the absolute position on the page.

pageOffset takes a positive number for a blank page following a specia page break (thefirst blank pageis 1), and negative for a blank

page preceding thefirst bar of the score (the blank pageimmediately beforethefirst bar is-1, the one beforethat -2, and so on). Returns
the Text object created.

To add text to ablank page, first create the special page break using the Bar . BreakType variable, and set the number of blank pages
using Bar .NumBlankPages or Bar . NumBlankPagesBefore. Then use Bar .AddTextToBlankPage.

AddTimeSignature(top, bottom, allow cautionary, rewrite music| , use symbol]) Returns an error string (which will be empty if
therewas no error) which if not empty should be shown to the user. The first two parameters are the top and bottom of the new time sig-
nature. The third tells Sibelius whether to display cautionary time signatures from thistime signature. If rewrite music is True then all
the bars after theinserted thetime signature will be rewritten. Y ou can al so create common time and allabreve time signatures. If you're
creating atime signaturein 4/4 or 2/2, set use symbol to True and Sibeliuswill replace the numbers of the time signature with their sym-
bolic equivalent.

AddTimeSignatureReturnObject(top,bottom, allow cautionary, rewrite music| , use symbol]) As above, but returns the time
signature object created, or null if unsuccessful.

AddTuplet(pos, voice, left, right, unit[, style[ , bracket[ , fullDuration]]]) Addsatuplet to abar at agiven position. Theleft and
right parameters specify the ratio of the tuplet, for example 3 (left) in the time of 2 (right). The unit parameter specifies the note value
(in 1/256th quarters) on which the tuplet should be based. For example, if you wish to create an eighth note (quaver) triplet group, you
would use the value 128. The optional style and bracket parameters take one of the pre-defined constants that affect the visual appear-
ance of the created tuplet; see Global Constants. If fullDuration istrue, the bracket of the tuplet will span the entire duration of the tu-
plet. Returns the Tupl et object created.

If AddTuplet() hasbeen givenillegal parameters, it will not be able to create avalid Tuplet object. Therefore, you should test for
inequality of the returned Tup et object with null before attempting to useiit.

Bar[array element] Returnsthe nth item in the bar (counting from Q) for example Bar [0]

Clear([voice number]) Clearsabar of al itsitems, leaving only abar rest. If a particular voice number is specified, only the items
in that voice will be removed.

ClearNotesAndModifiers([voice number]) Clearsabar of al its notes, rests, tuplets and slurs, replacing them with asingle bar
rest. If aparticular voice number is specified, only the itemsin that voice will be removed.

Delete() Deletesand removes an entire bar from a score. This, by definition, will affect all the stavesin the score.

DeletePageNumber ([blank page offset] ) Deletes the page number change at the end of the bar, or if there are one or more blank
pages after the bar, any page number change that occurs on any of those blank pages. If blank page offset isunspecified, the page number
change on the first page after the bar will be deleted.

GetClefAt(pos) ReturnsaClef object corresponding to the current clef at the specified rhythmic position.
GetKeySignatureAt(pos) Returns aKeySignature object corresponding to the current clef at the specified rhythmic position.

GetlnstrumentTypeAt(pos) Returnsan InstrumentType object representing the instrument type used by the bar at the speci-
fied rhythmic position.

GetPageNumber ([blank page offset]) Returns the page number change object at the end of the bar, or if the bar contains no page
number change, null. Aswith AddPageNumber, you may get the page number change from any of the blank pages that follow the bar
by specifying avalid blank page offset.
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InsertBarRest(voice number[ ,rest type]) Insertsabar rest into the bar, but only if the bar isvoid of any NoteRests (or an existing
bar rest) using the same voice number. The optional rest type parameter allows you to specify the type of bar rest or repeat bar to be cre-
ated, defined by the constantsWho leBarRest (the default if rest typeisnot specified), BreveBarRest, OneBarRepeat, TwoBar -
Repeat and FourBarRepeat. Returns True if successful.

NthBarObject(n) Returnsthe nth object in the bar, counting from 0.

RemoveL iveTempoTapPoint(position) RemovesaLlive Tempo tap point at the rhythmic position specified by position, in 1/256th
guarters from the start of the bar.

ResetSpaceAroundBar (above, below) Doesthe equivaent of Layout > Reset Space Above Staff and/or Reset Space Below
Staff for the given bar. Set above to True to reset the space above the staff, and below to True to reset the space below the staff.

Respace() Respacesthe notesin this bar.

Variables
BarNumber The bar number of this bar. Thisisthe internal bar number, which always runs consecutively from 1 (read only).
BarObjectCount The number of objectsin the bar (read only).

BreakType The break at the end of this bar, given by the constants Midd 1e0fSystem, EndOfSystem, MiddleOfPage, End-
OfPage, NotEndOfSystem, EndOfSystemOrPage or SpecialPageBreak. To learn the correspondence between these con-
stants and the menu in the Bars panel of the Properties window, see the discussion in Global Constants.

When you set the break at the end of abar to be SpecialPageBreak, Sibeliuswill add one blank page after the break. Y ou can then
adjust the number of pages by setting the value of either Bar .NumBlankPages or Bar .NumBlankPagesBeTfore, or tell Sibelius
to restart the music on the next Ieft or right page with Bar .MusicRestartsOnPage.

ExternalBarNumber Thishasbeen deprecated as of Sibelius 5, becauseit can only return a number, and bar numbers that appear
in the score may now include text. Use ExternalBarNumberString instead, which returnsthe external bar number of thisbar, tak-
ing into account bar number changesin the score (read only). Note that you cannot pass this bar number to any of the other ManuScript
accessors; they all operate with the internal bar number instead.

ExternalBarNumberString Theexterna bar number of thisbar as astring, taking into account bar number changes and bar num-
ber format changes (read only). Note that you cannot pass this bar number to any of the other ManuScript accessors; they all operatewith
theinternal bar number instead.

GapAfter Setsthe gap (in spaces) after the bar (read/write)
GapBefore Setsthe gap (in spaces) before the bar (read/write).

InMultirest Returnsone of four global constants describing if and/or where the bar fallsin a multirest (read only). The constants
areNoMultirest, StartsMultirest, EndsMultirest and MidMultirest; see Global Constants.

Length Therhythmic length (read only).

MusicRestartsOnPage Tells Sibeliusto restart the music on the next |eft or right page after a specia page break, and can only
be set if BreakType is SpecialPageBreak. This variable may be set to only two of the global special page break constants:
MusicRestartsOnNextLeftPage or MusicRestartsOnNextRightPage (write only).

NthBarInSystem Returnsthe position of the bar in the system, relative to the first bar on the system (bar 0) (read only).
NumBlankPages The number of blank pages following the bar containing a special page break.

NumBlankPagesBefore Thenumber of blank pages preceding the bar containing aspecial page break. Thisvalue only has an effect
if aspecial page break existsin bar 1.

OnHiddenStave ReturnsTrue if the bar is currently hidden by way of Hide Empty Staves (read only).
OnNthPage Returnsthe zero-based page number on which the bar occursin the current part (read only).

OnNthPageExternal Returnsastring containing the externa page number (which isthe page number displayed in the score) of the
page in which the bar occurs.

OnNthSystem Returnsthe zero-based system number (relative to its parent page) in which the bar occurs (read only).
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ParentStaff The staff containing this bar (read only).
SectionEnd Corresponds to the Section end checkbox on the Bars panel of Properties (read/write).
Selected ReturnsTrue if theentire bar is currently selected (read only).

SpecialPageBreakType Returnsthe type of the specia page break; see the documentation for the Special page break typesin
Global Constants (read only).

SplitMultirest When True, amultirest intersecting the bar in question will be split (read/write).

Time Thetime at which the bar startsin the scorein milliseconds (read only).

Barline
Accessed from aBar lines object.

Methods

None.

Variables
BottomStave Returnsthe Staff object at which the barline ends, relative to the current part.

BottomStaveNum Returnsthe number of the bottom staff included in the barline, relative to the current part.
TopStave Returnsthe Staff object at which the barline starts, relative to the current part.

TopStaveNum Returnsthe number of the top staff included in the barline, relative to the current part.

Barlines
Accessed from a Score Object. Corresponds to the barline groupingsin the score.

for each barline in iterates through all the barlinesin the list, for example:
s = Sibelius.ActiveScore;
barlines = s_Barlines;
for each barline in barlines {
// do something with barlines here

}

Array access [int n] returnsthe nth barline in the list, or null if the barline does not exist.

Methods

AddBar I ine (top staff number , bottom staff number) Creates a new bar line inclusively spanning the staff numbers (relative to the
current part) supplied. Returns the new Barl ine object created, or null if it fails.

ClearAl1 () Removesal the barlines from the score.

DeleteNthBar line(index) Removes agiven barline identified by index from the score.

Variables

NumChi ldren Returnsthe number of unique barlinesin the score (read only).
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BarObject

BarObjectsinclude Clef, Line, NoteRest, and Text objects. All the methods and variables below apply to all specific types of
BarObject—they arelisted hereinstead of separately for each type. (To object-oriented programmers, the NoteRest, Clef, and those
types are derived from the base classBarObject.)

Methods

Delete() Deetesanitem from the score. Thiswill completely remove text objects, clefs, lines and so on from the score; however,
when aNoteRest isdeleted, it will be converted into arest of similar duration. To delete multipleitemsfrom abar, see Deleting Multiple
Objects from a Bar.

Deselect() Removesthe object from the selection list of the parent score. If the selection is currently a passage selection, it isfirst
changed to amultiple selection before the object is deselected. Returns True if the object is successfully removed from the selection.

FreezeMagneticlLayoutPositions() Doesthe same as selecting an object and choosing Layout > Freeze Magnetic Layout
Positions, that explicitly setsthe object’s Dx/Dy to the position produced by Magnetic Layout, then disables Magnetic Layout for that
object.

GetlslInVoice(voicenum) Returns True if the object isin the voicenum specified.
GetPlayedOnNthPass(n) Returns True if the object is set to play back the nth time.

Nextltem([voice[, itemtype]]) Returnsthe next item in the parent bar of the current item, or null if no item exists. If no arguments
have been supplied, the very next item in the bar will be returned, regardless of its voice number and item type. Y ou may additionally
specify the voice number of the object you' re looking for (1 to 4, or 0 for any voice number), and the item’ stype. Note that an item will
only bereturned if it existsin the same bar asthe source item. By way of example, to find the next crescendo linein voice 2, you would
type something along the lines of: hairpin = item.Nextltem(2, “CrescendoLine™);

Previousltem([voice, itemtype]]) Asabove, but searches backwards.
RemoveVoi ce (voicenum) Removes the object from the specified voicenum, leaving the object in al remaining voices.

ResetPosition([horizontal[, vertical]]) Performs Layout > Reset Position on the object. If you supply no parameters, this
method will reset both the horizontal and vertical position of the object. If either or both of the optional Boolean parameters horizontal
or vertical is set to True, you can reset the position of the object either horizontally or vertically independently if required.

ResetDesign() PerformsLayout > Reset Design on the object.

Select() Appendsthe object tothe selection list of the parent score. A multiple selection consisting of any number of individual ob-
jectscan bebuilt up by repeatedly calling Se lect on each object you wish to add to thelist. Notethat calling Select onaBarObject
will first clear any existing passage selection.

SetAllVoices() Setstheobject to beinal voices. This has no effect on some types of object, such as NoteRests.

SetVoice(voicenun , clear other voices]) Setsthe object to be in voice voicenum, optionally removing the object from all other
voicesif the Boolean parameter clear other voicesis True.

ShowlInAll () Showsthe object in the full score, and in al relevant parts; equivalent to Edit > Hide or Show > Show In All.

ShowlInParts() Hidesthe object inthe full score, and showsit in all relevant parts; equivalent to Edit > Hide or Show > Show In
Parts.

ShowlInScore() Hidesthe object in all relevant parts, and showsiit in the full score; equivalent to Edit > Hide or Show > Show In
Score.

SetPlayedOnNthPass(n, do play) Tells Sibelius whether or not the object should play back the nth time.

TimeOnNthPass(n) Returnsthetime at which the object occursin the score in milliseconds on the nth pass through the score, where
nisan integer specifying the pass (specify 1 for the first pass through the score), or returns -1 in the case of an error (because the spec-
ified value of nisout of range).
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Variables

CanBelnMultipleVoices Returns True if the object can be in more than one voice (read-only).

Color Thecolor of thisBarObject (read/write). The color valueisin 24-bit RGB format, with bits 0—7 representing blue, bits 8-15
green, bits 16-23 red and bits 24-31 ignored. Since ManuScript has no bitwise arithmetic, these values can be alittle hard to manipul ate;
you may find the individual accessors for the red, green and blue components to be more useful (see below).

ColorAlpha The aphachannel component of the color of thisBarObject, in the range 0-255 (read/write).
ColorRed Thered component of the color of thisBarObject, in the range 0-255 (read/write).

ColorGreen The green component of the color of thisBarObject, in the range 0-255 (read/write).

ColorBlue The blue component of the color of thisBarObject, in the range 0-255 (read/write).

CueSize True if the object is cue-size in the current part or score, and Fal se if the object is normal size (read/write).
CurrentTempo Returnsthetempo, in bpm, at the location of the object in the score (read only).

DrawOrder Returnsthelayer at which the object is currently drawn. When used to set the layer of an object, valuesfrom 1 (meaning
the bottom layer) to 32 (meaning the highest layer) can be used; 0 isaspecial value that tells Sibelius to use the default layer for that
type of object (read/write).

Dx The horizontal graphic offset of the object from the position implied by the Position field, in units of 1/32 spaces (read/write).
Dy The vertical graphic offset of the object from the center staff line, in units of 1/32 spaces, positive going upwards (read/write).
HasCustomDrawOrder Returns True if the object is set to alayer other than its default layer (read only).

Hidden True if the object is hidden in the current part or score, and False if the object is shown (read/write).

OnNthBlankPage ReturnsO if the object occurs on a page of music, otherwise a number from 1 upwards indicating the nth blank
page of the bar on which the object occurs (read only).

ParentBar TheBar containing thisBarObject (read only).
Position Rhythmic position of the object in the bar (read only).
Selected Returns True if the object is currently selected (read only).

Time Thetime at which the object occursin the scorein milliseconds; if the score contains repeats, thiswill aways return the time as
if for the first pass through the score (read only). Returns -1 in the case of an error.

Type A string describing the type of object, such as “NoteRest,” “Clef.” Thisis useful when hunting for a specific type of objectin a
bar. See GuitarScaleDiagram for the possible values (read only).

UsesMagneticLayout ReturnsTrue if the object is positioned by Magnetic Layout. Returns Fal se if the object is set not to be
taken into account by Magnetic Layout. To set whether or not an object should use Magnetic Layout, use one of the global constants
AlwaysDodge (equivalent to Edit > Magnetic Layout > n), SuppressDodge (Edit > Magnetic Layout > Off) or DefaultDodge
(Edit > Magnetic Layout > Default) (read/write).

UsesMagneticLayoutSettingOverridden ReturnsTrue if the object has had its Magnetic Layout settings overridden; other-
wise False.

VoiceNumber [sO if theitem belongsto more than one voice (alot of items belong to more than one voice) and 1 to 4 for itemsthat
belong to voices 1 to 4 (read only).

Voices Returnsor sets Sibelius' sinternal bit field that represents the voices to which an object belongs; useful for copying the voices
used by a given object (read/write).

43

Object Reference



Deleting Multiple Objects from a Bar

If you wish to delete multiple objects from abar, you should first build up alist of itemsto delete, then iterate over the list deleting each
object in turn. It is not sufficient to simply delete the objects from the bar as you iterate over them, as this may cause the iterator to go
out of sync.

Therefore, code to delete all tuplets from a bar should look something like this:
counter = 0;
for each Tuplet tup in bar {
name = "tuplet" & counter;
@name = tup;
counter = counter + 1;
¥
// Delete objects In reverse order
while(counter > 0) {
counter = counter - 1;
name = "tuplet" & counter;
tup = @name;
tup.Delete();
}

BarRest

Derived from aBarObject object.

Methods

None.

Variables

PauseType Returnsthetype of fermata (pause), if any, on the bar rest. Returns one of the constants PauseTypeNone
(0), PauseTypeSquare (1), PauseTypeRound (2), PauseTypeTriangular (3) (read/write).

RestType Returnsthetype of bar rest via one of the constants WholeBarRest (0), BreveBarRest (1), OneBarRepeat (2),
TwoBarRepeat (3), FourBarRepeat (4) (read only). To create abar rest of a particular type, use bar . InsertBarRest() (see
above).

Bracket
Accessed from aBracketsAndBraces object.

Methods

None.

Variables
BottomStave Returnsthe Staff object at which the bracket ends, relative to the current part.

BottomStaveNum Returnsthe number of the bottom staff included in the bracket, relative to the current part.
BracketType Returnsthe type of the bracket: BracketFull, BracketBrace or BracketSub.
TopStave Returnsthe Staff object at which the bracket starts, relative to the current part.

TopStaveNum Returns the number of the top staff included in the bracket, relative to the current part.
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Brackets and Braces

Accessed from aScore object. Describesthe brackets (which may be brackets, sub-brackets or braces) present in the score. for each
bracket in iteratesthrough all the bracketsin thelist. Array access [int n] returnsthe nth bracket in thelist, or null if the bracket does
not exist.

Methods

AddBracket(type, top staff number , bottom staff number) Creates abracket of agiven type, spanning the range of staves specified
between top staff number and bottom staff number inclusive, and returnsthe new Bracket object. The staff numbersarerelativeto the
current part view. Values for type are BracketFul I (0), BracketBrace (1) and BracketSub (2).

ClearAll1 () Removesall existing brackets, sub-brackets and braces from the current part, and returns the number of brackets re-
moved.

DeleteNthBracket(n) Deletes the nth bracket from the current part, and returns True if successful.

Variables
NumChi ldren Returnsthe number of child brackets, sub-brackets and bracesin the list.

Clef

Derived from aBarObject.

Methods

None.

Variables
ClefStyle Thename of this clef, which may be different depending on the state of Notes > Transposing Score (read only).

ConcertClefStyleld The concert pitch identifier of the style of this clef (read only).
ConcertClefStyle The concert pitch name of this clef (read only).

Styleld Theidentifier of the style of this clef, which may be different depending on whether or not Notes > Transposing Score is
switched on. This can be passed to the Bar . AddClef method to create a clef of this style (read only).

TransposingClefStyle Thetransposing score name of this clef (read only).

TransposingClefStyleld Thetransposing scoreidentifier of the style of this clef (read only).

Comment

Derived from aBarObject.

Methods

None; create viaBarObject.

Variables

Maximized ReturnsTrue if the comment is maximized, otherwise returns False (read/write).

Text Returnsthe text of the comment (read/write).

45

Object Reference



TextWithFormatting Returnsan array containing the various changes of font or style (if any) within the comment’stext in anew
element (read only). For example, “This text is \B\bold\b\, and this is \Nitalic\i\" would return an array with eight elements containing
the following data:

arr[0] = “This text is “
arr[1] = *“\B\”

arr[2] = “bold”

arr[3] = “\b\”

arr[4] = **, and this is “
arr[5] = “\I\”

arr[6] = “italic”

arr[7] = “\i\”

TextWithFormattingAsString The comment’stext including any changes of font or style (read only).
TimeStamp ReturnsaDateTime object corresponding to the date the comment was created or last edited (read only).

UserName Returns the username of the user who created or last edited the comment (read only).

ComponentList

An array that is obtained from Sibel ius .HouseStyles or Sibelius.ManuscriptPapers. It canbeusedinafor each loop
or as an array with the [n] operator to access each Component object:

Methods

None.

Variables
NumChildren Number of plug-ins (read only).

Component

This represents a Sibelius “component,” namely a house style or a manuscript paper. Examples:
// Create a new score using the first manuscript paper
papers=Sibelius.ManuscriptPapers;
score=Sibelius._New(papers[0]):

// Apply the first house style to the new score
styles=Sibelius.HouseStyles;
score . ApplyStyle(styles[0], "ALLSTYLES™);

Methods

None.

Variables

Name The name of the component (read only).

DateTime

This object returns information about the current date and time.

Methods

None.
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Variables

Seconds Returns the number of seconds from the time in a date (read only).

Minutes Returnsthe number of minutes from the timein a date (read only).

Hours Returnsthe number of hours from the time in a date (read only).

DayOfMonth Returnsthe nth day on the month, 1-based (read only).

Month Returnsthe nth month of the year, 1-based (read only).

Year Returnstheyear (read only).

NthDayOfWeek Returnsthe nth day of the week, 0-based (read only).

NthDayOfYear Returnsthe nth day of the year, 0-based (read only).

LongDate Returnsthe date in a human-readable format, for example: 1st May 2008 (read only).

ShortDate Returnsthe datein a human-readable format, for example: 01/05/2008 (read only).

LongDateAndTime Returnsthe date and timein a human-readable format, for example: 1st May 2008 14:07 (read only).
ShortDateAndTime Returnsthe date and time in a human-readable format, for example: 01/05/2008 14:07 (read only).
TimeWithSeconds Returnsthetimein ahuman-readable format, for example: 14:07 (read only).

TimeWithoutSeconds Returnsthetimein ahuman-readable format, for example: 14:07:23 (read only).

Dictionary

To create adictionary, use the built-in function CreateDictionary(namel, valuel, name2, value2, ... nameN, valueN).
This creates adictionary containing user properties called namel, name2, nameN with values valuel, value2, valueN respectively.

To iterate over dictionaries:

1 Toiterate over element valuesin Dictionary objects, use for each nin Dictionary or for each Valuenin
Dictionary.

2 Toiterate over element namesin Dictionary objects, use for each Name nin Dictionary.

3 Toiterate over value .name pairsin Dictionary objects, use for each Pair nin Dictionary; thisreturns anew
Dictionary object: n.Name isthe element name, n.Value is the element value.

Methods

Cal IMethod(methodname, paraml, param?2, ...paramN) Calls the specified method methodname in the dictionary, passing in any
other values that are required for the method as further parameters.

GetMethodNames() Returnsasparse array containing the names of the methods belonging to a dictionary.
GetPropertyNames() Returnsasparsearray of the namesof all the user propertiesinthedictionary (sameas_propertyNames).
MethodExists(methodname) Returns True if the specified method methodname exists in the dictionary.
PropertyExists(propertyname) Returns True if the specified user property propertyname exists in the dictionary.

SetMethod(methodname, Se Il ¥, method) Binds a method to the dictionary. methodname is the name by which you want to access
the method viathe dictionary, Sel T refers to the plug-in in which the method is found, and method is the name of the method itself,
found elsewhere in the plug-in.

Variables

None.
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Converting Old-Style Hash Tables to Dictionaries

TheDictionary object is, anong other things, areplacement for the old Hash object, which was asimple hash table object. You are
recommended to use the new Dictionary object instead of the old Hash object in your plug-ins, but if you have an existing plug-in
in which old-style hashes are used, you can convert them to Dictionaries as follows:

Hash.ConvertToDictionary() Returnsanew Dictionary object, populated with strings converted from the old-style Hash.

DocumentSetup

Accessed from a Score object, DocumentSetup corresponds to the settingsin Layout > Document Setup.

When you first accessthe DocumentSetup object, the units default to millimeters; if you want to use another unit of measurement, set
DocumentSetup.Units beforeyou set any of the other values. Thiswill not, however, change the units displayed in Layout > Doc-
ument Setup; to do that, set DocumentSetup.UnitslInDocumentSetupDialog.

Be careful aso that if you set DocumentSetup.PageSize after setting DocumentSetup.PageWidth or
DocumentSetup . PageHe ight, the page size specified will override any custom height/width you may have just set: so set the page
size before you then adjust the width or height of the page.

Methods

None.

Variables
AboveTopStaveGap Returns or setsthe top staff margin on each page in the units specified by the Units variable (read/write).

AboveTopStaveGapAfterFirstPage Returnsor setsthetop staff margin on pages after thefirst pagein the units specified by the
Units variable (read/write). To set this, first set FirstPageHasUniqueVerticalStaveMarginsto True.

BelowBottomStaveGap Returnsor setsthe bottom staff margin on each page in the units specified by the Units variable
(read/write). To set this, first set FirstPageHasUniqueVerticalStaveMargins to True.

BelowBottomStaveGapAfterFirstPage Returnsor setsthe bottom staff margin on each page after the first page in the units
specified by the Units variable (read/write).

FirstPageHasUniqueVerticalStaveMargins ReturnsTrue if the After first page checkbox is switched on in Document
Setup, specifying that the first page of the score has different top and bottom staff margins to subsequent pages; otherwise returns
False (read/write).

Orientation Returnsor setsthe current page orientation. Values are OrientationPortrait (0) and OrientationLand-
scape (1). If you changethe orientation, thiswill swap the PageTopMargin and PageBottomMargin vaueswith the PagelLeft-
Margin and PageRightMargin values, to reflect the change in orientation (read/write).

PageHeight Returnsor setsthe height of a pagein the units specified by the Units variable (read/write).

PageSize Returnsor setsthe current page size. Values are listed in PageSize Values. If you attempt to set PageSize to Page-
SizeCustom, Sibeliuswill do nothing; to set a custom page size, set PageWidth and PageHe ight individually. Setting any default
PageSize value will aso change the PageWidth and PageHe ight values (read/write).

PageWidth Returns or setsthe width of a page in the units specified by the Units variable (read/write).

MarginType Returnsor setsthe current page margin type. Vaues are PageMarginsSame (0), PageMarginsMirrored (1),
PageMarginsDifferent (2) (read/write).

PageBottomMargin Returns or setsthe bottom page margin in the units specified by the Uni ts variable (read/write).
PageLeftMargin Returnsor setsthe left page margin in the units specified by the Units variable (read/write).
PageRightMargin Returnsor setsthe right page margin in the units specified by the Uni ts variable (read/write).

PageTopMargin Returns or sets the top page margin in the units specified by the Units variable (read/write).
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RightPagelLeftMargin Returnsor setsthe left page margin for right-hand pages in the units specified by the Units variable
(read/write). Setting this value automatically setsMarginType to PageMarginsDi fferent.

RightPageRightMargin Returnsor setsthe right page margin for right-hand pages in the units specified by the Units variable
(read/write). Setting this value automatically setsMarginType to PageMarginsDi fferent.

StaffLeftMarginFul INames Returnsor setsthe margin to theleft of staves showing full instrument namesin the units specified
by the Uni ts variable (read/write).

StafflLeftMarginNoNames Returnsor setsthe margin to the left of staves showing no instrument namesin the units specified by
the Units variable (read/write).

StaffLeftMarginShortNames Returnsor setsthe margin to the left of staves showing short instrument namesin the units spec-
ified by the Units variable (read/write).

StaffSize Returnsor setsthe staff size in the units specified by the Units variable (read/write).

Units Returns or sets the units of measurement for all of the relevant variables of the DocumentSetup object. Alwaysreturns O
(millimeters). Values are DocumentSetupUnitsmm (0), DocumentSetupUnitsinches (1), DocumentSetupUnitsPoints
(2) (read/write).

UnitsInDocumentSetupDialog Returnsor setsthe units of measurement currently shown in the Layout » Document Setup dia-
log. Values are asfor Units.

DynamicPartCollection

Accessed from a Score object. DynamicPartCol lection contains DynamicPart objects.

The DynamicPartCol lection object aways contains the full score asthe first entry, whether or not any dynamic parts exist. The
DynamicPart objectsarereturned in the order in which they were created (the last part returned isthe most-recently created one). For
scores in which dynamic parts were generated automatically, the parts will normally be returned in top to bottom score order.

The edit context for ManuScript is stored in the score itself which means that ManuScript can only ever access one part at atime —the
“current” Dynami cPart for that Score object. Thisisirrespective of the number of score windows open for a score, which dynamic
parts are open, and even if the user has managed to create two different ManuScript Score objects referring to the same Sibelius score.

It isinadvisable to modify Staves, Bars, or any BarObjects that do not exist on Stavesin Score.CurrentDynamicPart. Doing so
will create part overridesfor part-specific properties of these objectswhich will beinvisible until those Staves are added to the part. Dy -
namicPart. IncludesStaff() can be used to test if aDynami cPart contains a particular Staff object.

Both DynamicPartCol lection and DynamicPart refer to an underlying Score and part(s) and will generate errorsif the Score
and/or part(s) arenolonger valid (for example, if aDynami cPart hasbeen deleted). DynamicPart arenever “re-used.” For example,
if you delete aDynami cPart and create anew Dynami cPart, the old ManuScript Dynami cPart object will not refer to the
newly-created DynamicPart.

for each variable in iteratesthrough all valid Dynami cPart objectsfor the Score, always starting first with the full score. Adding
or deleting parts whileiterating will have undefined results, and is not recommended.

Array access [int n] returnsthe nth part (O is always the full score), or null if the part does not exist.

Methods

CreateDefaultParts() Createsthedefault set of dynamic parts, as created automatically by Sibeliuswhen clicking the New Part
button in the Parts window. This method does nothing and returns Fal se if the Score has no staves.

CreatePartFromStaff(staff) Createsadynamic part from the specified Staff object, if valid. Returns the new DynamicPart
object for success, or null for failure.

DeletePart(dynamic part) Deletesthe specified part, if it'svalid. Returns True for success, False for failure. This method fails
is the specified dynamic part is the currently active part for the Score, or isthe full score, or refersto a different Score.
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Variables
NumChi ldren Returnsthe number of Dynami cPart objects for the Score returned by iteration (read only).

DynamicPart

Accessed from aDynamicPartCol lection object.
for each variable in returnsthe Staff objectsin the dynamic part, in top to bottom order.

A\ Thiscanreturn a Staff that is not included in Score . CurrentDynamicPart.

Methods

AddStaffToPart(staff) Adds the specified staff to the bottom of the dynamic part. Returns False for failure. This method will
cause an error if it is called on the full score, or if attempting to add a staff that is aready present in the part or a staff from a different
score.

DeleteStaffFromPart(staff) Deletesthe specified staff from the dynamic part. Returns False for failure. This method will cause
an error if called on the full score, or if attempting to delete a staff that is not present in the part, or if deleting the last staff in apart, or
attempting to delete a part from a different score.

IncludesStaff(staff) Returns True if the specified staff is contained in this dynamic part.

Variables

IsFullScore Returns True if thisisthe full score (read only).
IsSelectedInPartsWindow Returns True if the part is selected in the Parts window (read only).
StaveCount Returnsthe number of stavesin the part (read only).

ParentScore Returnsthe Score object containing this dynamic part (read only).

EngravingRules
Accessed viathe Score object. Corresponds to selected settingsin the House Style > Engraving Rules diaog.

Methods

None.

Variables

AdjustTranspositionlfKeySigWraps Returns True if Sibeliuswill adjust note spelling for transposing instrumentsin ex-
tremekeys, Fal se otherwise; correspondsto the Adjust note spelling in transposing instruments in remote keys option on the Clefs
and Key Signatures page (read/write).

BarlineWidth Returnsor setsthe width of normal barlinesin spaces, from the Barlines page (read/write).
BeamThickness Returnsor sets the thickness of beamsin spaces, from the Beams and Stems page (read/write).

CautionaryNaturalslInKeySignatures ReturnsTrue if key changeswill show cautionary naturals; Fal se otherwise, from
the Clefs and Key Signatures page (read/write).

CueNoteScale Returnsor setsthe percentage by which cue-sized notes are scaled rel ative to normal-sized notes, from the Notes and
Tremolos page (read/write).

DashedBarlineWidth Returnsor setsthe width of dashed barlinesin spaces, from the Barlines page (read/write).
DoubleBarlineSeparation Returnsor setsthe distance between the two lines in double barlines in spaces, from the Barlines

page (read/write).
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DoubleBarlineWidth Returnsor setsthe width of double barlinesin spaces, from the Barlines page (read/write).

DoubleTremoloStyle Returnsor setsthe style used for double tremolos in the score, from the Notes and Tremolos page; values
areDoubleTremolosTouchingStems (0), DoubleTremolosBetweenStems (1), DoubleTremolosOuterTremolo-
TouchingStems (2) (read/write).

ExtraSpacesAboveForSystemObjectPositions Returnsor setsthe n extra spaces above for System Object Positions
value on the Staves page (read/write).

ExtraSpacesBelowVocalStaves Returnsor setsthe n extra spaces below vocal staves (for lyrics) value on the Staves page
(read/write).

ExtraSpaceBetweenGroupsOfStaves Returnsor setsthe n extra spaces between groups of staves value on the Staves page
(read/write).

FinalBarlineSeparation Returnsor setsthe distance between the two linesin fina barlines in spaces, from the Barlines page
(read/write).

FinalBarlineWidth Returnsor setsthe width of the thick line of final barlinesin spaces, from the Barlines page (read/write).

GraceNoteScale Returnsor setsthe percentage by which grace notesare scaled rel ative to normal notes, from the Notes and Trem-
olos page (read/write).

InstrumentNamesFirstSystem Corresponding to the option for instrument names on the first system on the Instruments page;
values are InstrumentNamesFull (0), InstrumentNamesShort (1), InstrumentNamesNone (2) (read/write).

InstrumentNamesNewSections Corresponding to the option for instrument names at the start of new sections on the Instruments
page; values are InstrumentNamesFull (0), InstrumentNamesShort (1), InstrumentNamesNone (2) (read/write).

InstrumentNamesSubsequentSystems Corresponding to the option for instrument names on subsequent systems on the
Instruments page; values are InstrumentNamesFull (0), InstrumentNamesShort (1), InstrumentNamesNone (2)
(read/write).

JustifyGrandStavelnstruments Returns True if Justify both staves of grand staff instruments on the Staves pageis
switched on, otherwise Fal se (read/write).

JustifyMultiStavelnstruments ReturnsTrue if Justify all staves of multi-staff instruments on the Staves pageis switched
on, otherwise Fal se (read/write).

LegerLineThickness Returnsor setsthe thickness of leger linesin spaces, from the Notes and Tremolos page (read/write).

Respel IRemoteKeysInTransposingScore Returns True if Sibeliuswill choose the equivalent key signature with one fewer
flat or sharp for transposing instruments; Fal se otherwise, corresponding to the option Respell remote key signatures in transposing
score on the Clefs and Key Signatures page (read/write).

ShowNameOfPrevai lingInstrumentChangeAtStartOfSystems Returns True if Sibeliuswill update the instrument name
at the start of each system to reflect the current instrument change, Fal se otherwise; corresponds to the Change instrument names
at start of system after instrument changes option on the Instruments page (read/write).

SlurMiddleThickness Returnsor setsthe default thickness of the middle of dlursin spaces, from the Slurs page (read/write).
SlurOutlineWidth Returnsor setsthe thickness of slur endsin spaces, from the Slurs page (read/write).

Smal IStaffSizeScale Returnsor setsthe percentage by which small staves are scaled relative to normal-sized staves, from the
Staves page (read/write).

SpacesBetweenStaves Returnsor setsthe n spaces between staves value on the Staves page (read/write).
SpacesBetweenSystems Returns or setsthe n spaces between systems value on the Staves page (read/write).

StaffJustificationPercentage Returnsor setsthe Justify staves when page is at least n% full value on the Staves page
(read/write).

StaffLineWidth Returnsor setsthe width of astaff linein spaces, from the Staves page (read/write).

StemThickness Returns or sets the thickness of stemsin spaces, from the Beams and Stems page (read/write).
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TieMiddleThickness Returns or setsthe thickness of the middle of tiesin spaces, from the Ties 1 page (read/write).

TieOutlineWidth Returns or setsthe thickness of tie ends in spaces, from the Ties 1 page (read/write).

File

Retrievable using for each on afolder.

Methods
Delete() Deetesafile, returning True if successful.

Rename (newFileName) Renames afile, returning True if successful.

Variables

CreationDate Returnsthefil€' s creation date and time asaDateT ime object, in local time (read only).
CreationDateAndTime A string giving the date and time the file was last modified in GMT (read only).
ModificationDate Returnsthefile's modification date and time as aDateT ime object, in local time (read only).
Name The complete pathname of thefile, no extension (read only).

NameWithExt The complete pathname of thefile, with extension (read only).

NameNoPath Just the name of the file, no extension (read only).

Path Returnsjust the path to the file (read only).

Type A string giving the name of the type of the object; Fi le for file objects (read only).

Folder

Retrievable from methods of the Sibelius object.

for each variable in producesthe Sibeliusfilesin the folder, as Fi le objects

for each typevariable in produces the files of type in the folder, where type is a Windows extension.

Useful valuesare SIB (Sibeliusfiles), MID (MIDI files) or OPT (PhotoScore files), because they can all be opened directly by Sibelius.
On the Macintosh files of the corresponding Mac OS Type are also returned (so, for example, for each MID fwill return al files
whose namesend in .MID, and dl files of type “Midi").

Both these statements return subfolders recursively.

Methods
FileCount(Type) Returnsthe number of files of type Typein the folder. As above, useful values are SIB, MID, or OPT.

Variables
FileCount Thenumber of Sibeliusfilesin the folder (read only).

FileCountAlITypes The number of files of al typesin the folder (read only).
Name The name of the folder (read only).

Type A string giving the name of the type of the object; Folder for folder objects (read only).
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GuitarFrame

Derived from aBarObject. Thisrefersto chord symbols as created by Create > Chord Symbol, whether or not they show a guitar
chord diagram (guitar frame), but is called GuitarFrame in ManuScript for historical reasons.

Methods

CopyOutSuffixes() Returnsan array containing alist of the suffix elements present in the chord. If the chord symbol isan
unrecognised chord type, the array returned will be empty. The values that can be returned in the array are as follows:

halfdim dim
add6/9 6/9
sus2/4 aug
omiths alt
omit3 b13
maj13 #11
add13 13
majll 11
diml3 #9
dimll b9
maj9 b6
add9 #5
maj7 b5
dim9 #4
dim7 nc
sus9 9
sus4 7
add4 6
sus2 5
add2 m
maj /

GetChromaticPitchesOfChordInClosePosition(consider root) Returns an array containing the chromatic pitches of the
notesin the chord, assuming avoicing in close position. If consider root is True (it defaultsto False), the pitches returned will be offset
according to the chromatic value of the root note on which the chord is based.

GetEndStringForNthBarre(barreNum) Returns the string number on which the nth barré ends.
GetPitchOfNthString(stringNum)] Returns the pitch of the given (open) string stringNum, as aMIDI pitch.
GetPositionOfFingerForNthBarre(barreNum) Returnsthe fret position that the nth barré occupies.

GetPositionOfFingerOnNthString(stringNum) Returns the position of the black dot representing the finger position on a
given string stringNum, relative to the top of the frame. A return value of 0 means the string is open (that is a hollow circle appears at
the top of the diagram), and -1 means that the string is not played (that is an X appears at the top of the diagram). Used in conjunction
with GetPitchOfNthString(), you can calculate the resulting pitch of each string.

GetStartStringForNthBarre(barreNum) Returns the string number from which the nth barré begins.
IsNthStringPartOfBarre(stringNum) Returns True if the given string is part of abarré.
NthStringHasClosedMarkingAtNut(nth string) Returns True if there’s an X marking at the top or Ieft of the specified string.

NthStringHasOpenMarkingAtNut(nth string) Returns True if there’s an O marking at the top or left of the specified string.

Variables

BassAsString The note name of the chord symbol’s altered bass note (for example: “F”).

ChordNameAsStyledString The name of the chord represented by this chord symbol asit appearsin the score, for example:
“Cm7” (read only).

53

Object Reference



ChordNameAsPlainText Thename of the chord represented by this chord symbol asit appears when editing the chord symbol, so
that inits plain text representation, for example: “Cmmaj7” (read only).

ChromaticRoot The chromatic pitch (C =0, B = 11) of the chord symbol’s root note (read only).
ChromaticBass The chromatic pitch (C = 0, B = 11) of the chord symbol’s altered bass note (read only).

DiatonicRoot Thediatonic pitch, that isthe number of the “note name” to which this note corresponds, 7 per octave (0=C, 1 =D,
2 = E and so on), of the chord symbol’ s root note (read only).

DiatonicBass Thediatonic pitch, that isthe number of the “note name” to which this note corresponds, 7 per octave (0=C, 1 =D,
2 = E and so on), of the chord symbol’s altered bass note (read only).

Fingerings Thefingerings string for this chord. Thisisatextual string with as many characters as the guitar frame has strings (for
example, six for standard guitars). Each character corresponds to a guitar string. Use to denote that a string has no fingering.

FramelsVisible Trueif the chord symbal is currently showing a guitar chord diagram (read only).
Horizontal True if the guitar chord diagram is horizontally orientated, False if it is vertically orientated (read/write).

LowestVisibleFret Thenumber of the top fret shown in the guitar chord diagram; setting the special value -1 resets the lowest
visible fret to the default for that chord diagram (read/write).

NumBarresInChord The number of unique barrésin the guitar chord diagram (read only).

NumberOfFrets Thenumber of fretsin the guitar chord diagram, that is the number of horizontal lines; setting the specia value -1
resets the number of frets to the default for that chord diagram (read/write).

NumberOfStrings The number of stringsin the guitar chord diagram, for example,. the number of vertical lines (read only).

NumPitcheslInClosePosition Thenumber of unique pitchesin the chord, assuming avoicing in close position with no dupli-
cates.

Recognized ReturnsTrue if the chord symbol isaspecific recognized chord type, and Fal se otherwise, that isif the chord symbol
isshown in red in the score because Sibeliusis unable to parse the user’ s input (read only).

RootAsString The note name of the chord symbol’sroot (for example, “C#").

ScaleFactor Thescaefactor of theguitar chord diagram (as adjustableviathe Scale parameter on the General panel of Properties),
expressed as a percentage (read/write).

ShowFingerings Setto True if the fingerings string should be displayed, Fal se otherwise (read only).
SuffixText Thesuffix part of the chord symbol asit appearsin the score, or an empty string if the chord isn’t recognized (read only).
TextlsVisible Trueif the chord symbol is currently showing atext chord symbol (read only).

TransposingChromaticRoot Returnsthe chromatic pitch of theroot note for the specified chord symbol asif the scoreis shown
at transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.

TransposingChromaticBass Returnsthe chromatic pitch of the altered bass note for the specified chord symbol, if present, asif
the score is shown at transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.

TransposingDiatonicRoot Returnsthe diatonic pitch of the root note for the specified chord symbol asif the score is shown at
transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.

TransposingDiatonicBass Returnsthediatonic pitch of the altered bass note for the specified chord symbol, if present, asif the
score is shown at transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.

TransposingRootAsString Returnsastring representing the pitch of the root note for the specified chord symbol asif the score
is shown at transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.

TransposingBassAsString Returnsastring representing the pitch of the atered bass note for the specified chord symboal, if pres-
ent, asif the scoreis shown at transposed pitch, but regardless of whether or not Notes > Transposing Score is switched on.
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VisibleComponents Thevisible partsof the chord symbol, that iswhether it displaysatext chord symbol only (TextOnly), agui-
tar chord diagram only (FrameOnly), both atext chord symbol and a guitar chord diagram (FrameAndText), or whether or not the
chord symbol shows a guitar chord diagram based on the type of instrument to which it is attached

(InstrumentDependent) (read/write).

GuitarScaleDiagram

Derived from aBarObject. Thisrefersto guitar scale diagrams as created by Create > Guitar Scale Diagram.

Methods

GetDotFingeringsOnNthString(nth string) Returnsan array of strings containing the text that has been entered on the dots on
agiven string.

GetDotSymbolsOnNthString(nth string) Returns an array of values describing the appearance of each of the dots on agiven
string. The possible values are DotStyleCircle, DotStyleFilledCircle, DotStyleSquare, DotStyleFilledSquare,
DotStyleDiamond, and DotStyleFil ledDiamond.

GetPitchesOfDotsOnNNthString(nth string) Returnsan array containing the pitches of all the dots on agiven string, in ascend-
ing order of pitch.

GetPitchOfNthString(stringNum) Returns the pitch of the given (open) string stringNum, asaMIDI pitch.

Variables

Fingerings Thefingeringsstring for this scale diagram. Thisis atextua string with as many characters as the scale diagram has
strings (for example, six for standard guitars). Each character corresponds to a guitar string. Use — to denote that a string has no finger-

ing.
Horizontal True if the guitar scale diagram is horizontally orientated, False if it is vertically orientated (read/write).

LowestVisibleFret Thenumber of thetop fret shownintheguitar scale diagram; setting the special value -1 resetsthe lowest vis-
ible fret to the default for that scale diagram (read/write).

NumberOfFrets The number of fretsin the guitar scale diagram, for example, the number of horizontal lines; setting the special
value -1 resets the number of fretsto the default for that scale diagram (read/write).

NumberOfStrings The number of stringsin the guitar scale diagram, for example, the number of vertical lines (read only).
Root Returns the chromatic pitch (C = 0) of the scale’ sroot note (read only).

ScaleFactor Thescaefactor of the guitar scale diagram (as adjustable viathe Scale parameter on the General panel of Properties),
expressed as a percentage (read/write).

ScaleType Returnsthe type of the guitar scale diagram, as specified in the list of GuitarScaleDiagram Type Values (read only).

ShowFingerings Setto True if the fingerings string should be displayed, Fal se otherwise (read only).

HitPointList

Retrievable asthe Hi tPoints variable of ascore. It can beused inafor each loop or asan array with the [n] operator—this gives
accesstoaHitPoint object. The HitPoint objects are stored in time order, so be careful if you remove or modify the time of the
objectsinside aloop. If you want to change the times of al the hit points by the same value then use the ShiftTimes function.

Methods

Clear() Removesal hit points from the score.

CreateHitPoint(timeMs,label) Createsahit pointin the score at the given time (specified in milliseconds) with a specified string
label. Returns the index in the HitPointList at which the new hit point was created.

Remove (index) Removes the given hit point number.
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ShiftTimes(timeMs) Addsthe giventime (in milliseconds) onto all the hit points. If the timeis negative then thisis subtracted from
al the hit points.

Variables
NumChi ldren Number of hit points (read only).

HitPoint

Individual element of theHitPointList object.

Methods

None.

Variables
Bar The bar in which this hit point occurs (read only).

Label The name of the hit point (read/write).
Position The position within the bar at which this hit point occurs (read only).

Time Thetimeof thehit pointin milliseconds. Notethat changing thisvalue may changethe position of thehit point in the HitPointList
(read/write).

InstrumentChange

Derived from aBarObject. Provides information about any instrument changes that may exist in the score.

Methods

None.

Variables
Styleldword Returnsthe style ID of the new instrument; see Instrument Types (read only).

TextLabel Returnsthe text that appears above the staff containing the instrument change in the score (read only).

InstrumentTypeList

Containsalist of InstrumentType objects common to a given score.

for each typevariable in returns each instrument type in the list, in aphabetical order by the instrument type's style ID.

Array access[int n] returnsthe nthinstrument type, in the same order asusing a for each iterator, or null if the instrument type does

not exist.

Methods

None.

Variables

NumChi ldren Returnsthe number of unique instrument typesin thelist (read only).
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InstrumentType

Provides information about an individual instrument type.

Methods

Clone() Makes an exact copy of an existing instrument type.

PitchOfNthString(string num) Returnsthe pitch of agiven string in atablature staff, with string number 0 being the lowest string
on the instrument.

Variables
Balance Returnstheinstrument’s default balance, in the range 0—100 (read only).

Category Returnsanindex representing the category of the staff type belonging to thisinstrument type; 0 = pitched; 1 = percussion;
2 = tablature (read only).

ChromaticTransposition Returnsthe number of half-steps (semitones) describing the transposition of transposing instruments;
such asfor B-flat Clarinet, thisreturns -2 (read/write).

ChromaticTranspositionInScore Returnsthe number of half-steps (semitones) describing the transposition of transposing in-
strumentsin ascore shown at concert pitch. Typicaly thisisonly used by instruments that transpose by octaves, so thiswill return, for
example, 12 for piccolo or —12 for guitars (read only).

ComfortableRangeHigh Returnsthe highest comfortable note (MIDI pitch) of the instrument (read only).
ComfortableRangelLow Returnsthelowest comfortable note (MIDI pitch) of the instrument (read only).
ConcertClefStyleld Returnsthe style ID of the normal clef style of the instrument (read only).
DefaultSoundld Returnsthe default sound ID used by the instrument (read only).

DiatonicTransposition Returnsthe number of diatonic steps describing the transposition of transposing instruments; such asfor
B-flat Clarinet, this returns -1 (read/write).

DiatonicTranspositionInScore Returnsthe number of diatonic steps describing the transposition of transposing instruments
in a score shown at concert pitch (read only).

DialogName Returnsthe name of theinstrument as displayed in the Create > Instruments dialog in Sibelius (read/write).
Ful IName Returnsthe name of the instrument as visible on systems showing full instrument names (read only).
HasBracket ReturnsTrue if the instrument has a bracket (read only).

HasKeySignatureOrTuning ReturnsTrue if theinstrument typehasthe Key signature / Tuning checkbox switched oninthe Edit
Staff Type diaog.

InstrumentTypeForChordDiagrams Returnsthe style D of the tab instrument type that determines the tuning used for chord
diagrams shown for thisinstrument, that is corresponding to the Tab instrument to use for string tunings in the New/Edit Instrument
dialogs.

IsVocal ReturnsTrue if theinstrument type used hasthe Vocal staff option switched on, meaning that, for example, the default po-
sitions of dynamics should be above the staff rather than below (read only).

NumStavel ines Returnsthe number of staff linesin the staff (read only).
NumStrings Returnsthe number of stringsin atablature staff (read only).

OtherClefStyleld Returnsthe style ID of the clef style of the second staff of grand staff instruments, piano for example (read
only).

Pan Returnsthe instrument’s default pan setting, in the range —127 (hard left) to 127 (hard right) (read only).
ProfessionalRangeHigh Returnsthe highest playable note (MIDI pitch) of the instrument for a professional player (read only).
ProfessionalRangeLow Returnsthe lowest playable note (MIDI pitch) of the instrument for a professional player (read only).
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ShortName Returnsthe name of the instrument as visible on systems showing short instrument names (read only).
Styleld Returnsthestyle ID of the instrument; see Global Constants (read only).

TransposingClefStyleld Returnsthe style ID of the clef to be used when Notes > Transposing Score is switched on (read
only).

KeySignature

Derived from aBarObject.

Methods

None.

Variables
AsText The name of the key signature as a string (read only).

I1sOneStaffOnly Trueif thiskey signature belongs to one staff only (read only).
Major Trueif thiskey signatureisamajor key (read only).

Sharps The number of sharps (positive) or flats (negative) in this key signature (read only).

Line

Anything you can create from the Create > Line dialog isaL ine object, such as CrescendoLine, DiminuendoL ine, and so on.
These objects are derived from aBarObject.

Methods

None.

Variables
Duration Thetota duration of the line, in 1/256th quarters (read/write).

EndBarNumber The bar number in which the line ends (read only).
EndPosition The position within the final bar a which the line ends (read only).
RhDx The horizontal graphic offset of the right-hand side of the line, in units of 1/32 spaces (read/write).

RhDy The vertical graphic offset of the right-hand side of the line from the center staff line, in units of 1/32 spaces, positive going up-
wards (read/write).

Styleld Theidentifier of the line style associated with thisline (read only).

StyleAsText The name of the line style associated with this line (read only).

Lyricltem

Derived from aBarObject

Methods

None.
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Variables
The total duration of the lyric line, in 1/256th quarters (see Line) (read/write).

NumNotes Givesthe number of notes occupied by this lyric item (read/write). Note that changing this value will not automatically
change the length of the lyric line; you also need to set the lyric line's Duration variable to the correct length.

StyleAsText Thetext style name (read/write).
Styleld heidentifier of the text style of thislyric (read/write).

SyllableType Aninteger indicating whether thelyricisthe end of aword (EndOfWord) or the start or middle of one (Midd1eOf-
Word) (read/write). This affects how thelyric isjusitifed, and the appearance of hyphensthat follow it. EndOfWord and Midd1eOf-
Word are global constants; see SyllableTypes for Lyricltems.

Text Thetext asastring (read/write).

NoteRest

Derived from aBarObject. A NoteRest contains Note objects, stored in order of increasing diatonic pitch.

for each variable in returns the notes in the NoteRest.

Methods

AddAcciaccaturaBefore(sounding pitch, [duration[ ,tied [ ,voice [, diatonic pitch[ , string number[ ,
force stemdir]]]]1]1]) Adds agrace note with a slash on its stem (acciaccatura) before a given NoteRest. The duration should be speci-

fied asnormal, for example, 128 would create a grace note with one beam/flag. The optional tied parameter should be True if you want
the note to betied. Voice 1 is assumed unless the optional voice parameter (with avalue of 1, 2, 3 or 4) is specified. If force stem dir is
set to True (the default), stems of graces notesin voices 1 and 3 will always point upwards, and stems of notesin voices 2 and 4, down-
wards. Y ou can also set the diatonic pitch, that isthe number of the “ note name” to which this note corresponds, 7 per octave (35 = mid-
dleC, 36 =D, 37 =E and so on). If adiatonic pitch of zero is given then asuitable diatonic pitch will be calculated from the MIDI pitch.

The optional string number parameter gives a string number for this note, which is only meaningful if the note is on a tablature stave.

If this parameter is not supplied then adefault string number is cal cul ated based on the current tablature stave type and the guitar tab fin-
gering options (specified on the Note Input page of File > Preferences). Returns the Note object created (to get the NoteRest contain-
ing the note, use Note . ParentNoteRest).

Note that adding a grace note before a NoteRest will always create an additional grace note, just to the left of the note/rest to which it
is attached. If you wish to create grace notes with more than one pitch, you should call AddNote on the object returned.

AddAppoggiaturaBefore(sounding pitch, [duration[ ,tied [ , voice [ , diatonic pitch[ , string number[ , force stemdir]]]111)
Identical to AddAcciaccaturaBefore, only no slash is added to the note’ s stem.

AddNote(pitch[ , tied[ , diatonic pitch[ , string number]]]) Addsanotewith thegiven MIDI pitch (60 = middle C), for exampleto cre-
ate achord. The optional second parameter specifies whether or not thisnoteistied (True or False). The optional third parameter gives
adiatonic pitch, which is the number of the ‘ note name’ to which this note corresponds, 7 per octave (35=middleC, 36 =D, 37=E
etc.). If this parameter is 0 then a default diatonic pitch will be calculated from the MIDI pitch. The optional fourth parameter gives a
string number for this note, which is only meaningful if the note is on atablature stave. If this parameter is not supplied then a default
string number is calculated based on the current tablature stave type and the guitar tab fingering options (specified on the Notes page
of File > Preferences). Returns the Note object created.

Delete() Deetesall the notesin the NoteRest, converting the entire chord into arest of similar duration.
FlipStem() Flipsthe stem of this NoteRest—this acts as atoggle.

GetArticulation(articulation number) Returns True or False depending on whether the given articulation is currently set on
this note. The valid articulation numbers are defined in Articulations.

NoteRest[array element] Returnsthe nth notein the chord, in order of increasing diatonic pitch (counting from 0). For example,
NoteRest[0] returnsthe lowest note (in terms of diatonic pitch—see AddNote below).

RemoveNote (note) Removes the specified Note object.
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SetArticulation(articulation number, set) If setis True, turns on the given articulation; otherwise turnsit off. The valid articu-
lation numbers are defined in Articulations.

Transpose (degree, interval type[,keep double accs]) Transposes the entire NoteRest up or down by a specified degree and interval
type. To transpose up, use positive valuesfor degree; to transpose down, use negative values. Note that degrees are 0-based, so 0 isequal
toaunison, 1 to asecond and so on. For descriptions of the various availableinterval types, see Global Constants. By default, Sibelius
will transpose using double sharps and flats where necessary, but this behavior may be suppressed by setting the keep double accs flag
to False.

For help in calculating the interval and degree required for a particular transposition, see the documentation for the Sibelius.Cal-
culatelnterval and Sibelius.CalculateDegree methods.

Variables

ArpeggioDx The horizontal offset of the arpeggio line on the NoteRest (read/write), in units of 1/32nd of a space (the distance be-
tween two adjacent staff lines).

ArpeggioType The type of note-attached arpeggio line present on the NoteRest. Values are ArpeggioTypeNone, Arpeggio-
TypeNormal, ArpeggioTypeUp, ArpeggioTypeDown (read/write).

ArpeggioTopDy The vertical offset of the top of the note-attached arpeggio line on the NoteRest (read/write), in units of 1/32nd of
aspace.

ArpeggioBottomDy The vertical offset of the bottom of the note-attached arpeggio line on the NoteRest (read/write), in units of
1/32nd of a space.

ArpeggioHidden Returns True if the note-attached arpeggio line on the NoteRest is hidden (read/write).
Articulations

Letsyou copy aset of articulations from one NoteRest to another (read/write), for example:
destNr._Articulations = sourceNr.Articulations;

Beam Takesvalues StartBeam, ContinueBeam, NoBeam and SingleBeam. (see Global Constants for details). These corre-
spond to the keys 7, 8, * (/ on Mac) and / (* on Mac) on the third (F9) Keypad layout.

DoubleTremolos Givesthe number of doubletremolo strokes starting at this note, in the range 0—7. Means nothing for rests. To cre-
ate adouble tremol o between two successive notes, ensure they have the same duration and set the DoubleTremolos of thefirst one
(read/write).

Duration Theduration of the note rest (read only).
FalIDx The horizontal offset of afall, if present on the NoteRest (read/write), in units of 1/32nd of a space.

FallType Thetypeof note-attached fall present on the NoteRest. Valuesare Fal ITypeNone, Fal ITypeNormal and Fal 1 Type-
Doit (read/write)

FeatheredBeamType Returnsone of three values, based on whether anote is set to produce a feathered beam. Values are Feath-
eredBeamNone (0), FeatheredBeamAccel (1) and FeatheredBeamRit (2) (read/write).

GraceNote True if it'sagrace note (read only).

HasStemlet ReturnsTrue if thenoteisshowing astemlet, according either to the state of the Use stemlets on beamed rests option
on the Beams and Stems page of Engraving Rules or the stemlet button on the Keypad (read only).

Highest The highest Note object in the chord (read only).

IsAcciaccatura True if it's an acciaccatura, that is. a grace note with a slash through its stem (read only).
IsAppoggiatura True if it's an appoggiatura, that is a grace note without a slash through its stem (read only).
Lowest Thelowest Note object in the chord (read only).

NoteCount The number of notesin the chord (read only).

ParentTupletlfAny If the NoteRest intersects atuplet, the innermost Tuplet object at that point in the score is returned. Other-
wise, null is returned (read only).
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PositionInTuplet Returnsthe position of the NoteRest relative to the duration and scal e-factor of its parent tuplet. If the NoteRest
does not intersect a tuplet, its position within the parent Bar is returned as usua (read only).

RestPosition Thevertica position of arest (read/write).
ScoopDx The horizontal offset of a scoop or plop, if present on the NoteRest (read/write), in units of 1/32nd of a space.

ScoopType Thetype of note-attached scoop present on the NoteRest. Values are ScoopTypeNone, ScoopTypeNormal, Scoop-
TypePlop (read/write).

StemFlipped True if the stemisflipped (read only).

StemletType Providesinformation about whether the NoteRest is set to display a stemlet using the options on the Keypad. Returns
either StemletCustomOfT (in which case the NoteRest definitely does not show astemlet), StemletCustomOn (in which casethe
NoteRest definitely does show a stemlet), or StemletUseDefaul t (in which case you should use the read-only variable HasStem-
et to determine whether the NoteRest currently shows a stemlet) (read/write).

Stemweight Returnsthe stem weight of a note, taking beams into account (read only). For an unbeamed note, thisisthe sum of the
stave positions of all the notesin the NoteRest, where the stave position of the middle lineis zero and the position increases as you move
up the stave and decreases as you move downwards. For abeamed note, it isthe sum of all the stem weights of the NoteRests under the
beam (treated as though they were unbeamed).

There are some special cases. If anote hasits stem direction forced due to voicing, then the stem weight will be one of the global con-
stants Stemwe ightUp or StemweightDown. If anote hasits stem direction forced due to the “flip” flag being set, the stem weight

will be either StemweightFlipUp or StemweightFlipDown. Finaly, cross-stave notes have stem weight equal to Stemweight-
Cross.

If the stem weight is less than zero, the stem will point up, otherwise it will point down.

SingleTremolos Givesthe number of tremolo strokes on the stem of thisnote, inthe range—1 (for “z on stem™) to 7. Means nothing
for rests (read/write).

Note
Only found in NoteRests. Correspond to individual noteheads.

Methods

Delete() Removesasingle note from achord.

Transpose (degree, interval type[,keep double accs]) Transposesand returnsasingle Note object up or down by a specified degree
and interval type*. To transpose up, use positive values for degree; to transpose down, use negative values. Note that degrees are
0-based, so 0 isequal to aunison, 1 to a second and so on. For descriptions of the various available interval types, see Global Con-
stants. By default, Sibeliuswill transpose using double sharps and flats where necessary, but thisbehavior may be suppressed by setting
the keep double accs flag to False. For help in calculating the interval and degree required for a particular transposition, see the docu-
mentation for the Sibelius.Calculatelnterval and Sibelius.CalculateDegree methods.

Q Individual note objects cannot be transposed diatonically.

Variables

Accidental Theaccidental, for which global constants such as Sharp, Flat and so on are defined; see Global Constants (read
only).

AccidentalStyle The style of the accidental (read/write). This can be any of following four global constants: NormalAcc,
HiddenAcc, CautionaryAcc (which forces an accidental to appear always) and BracketedAcc (which forces the accidental to
be drawn inside brackets).

Bracketed The bracketed state of the note, as shown on the F9 layout of the Keypad (read/write).
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Color Thecolor of this Note (read/write). The color valueisin 24-bit RGB format, with bits 0-7 representing blue, bits 8-15 green,
bits 1623 red and bits 24-31 ignored. Since ManuScript has no bitwise arithmetic, these values can be alittle hard to manipulate; you
may find the individual accessors for the red, green and blue components to be more useful (see below).

Q When all Notesin a given NoteRest are the same color, then that color is also promoted to the parent NoteRest itself. This allows
backwards compatibility with versions of Sbelius prior to 8.3 that did not support the individual coloring of Notes. Coloring of
NoteRest-attached objects, such as articulations and rhythm dots is not supported.

ColorAlpha The aphachannel component of the color of this Note, in the range 0-255 (read/write).
ColorRed Thered component of the color of this Note, in the range 0-255 (read/write).
ColorGreen The green component of the color of this Note, in the range 0—255 (read/write).
ColorBlue The blue component of the color of this Note, in the range 0-255 (read/write).

DiatonicPitch Thediatonic pitch of the note, that is the number of the “note name” to which this note corresponds, 7 per octave
(35 =middle C, 36 = D, 37 = E and so on). (read/write)

Q If Note.DiatonicPitch is changed fromthe full score (not a dynamic part), the written pitch and spelling of any accidental is changed
in both the full score and the part (where there is no differencein spelling). If changed from a part, Sbelius respells any accidental
inthe part only, leaving the full score unchanged. In both cases, while there may be a differencein written pitch, Sbelius guarantees
that thereis never a difference in the sounding pitch of a note between a part and the full score.

IsAccidentalVisible Returns True if the accidental on the noteisvisible, which is the equivalent of whether or not the corre-
sponding button on the Keypad isilluminated for that note (read only).

Name The pitch of the note as a string (read only).

NoteStyle Theindex of the notehead style of this Note (read/write). The styles correspond to those accessible from the Notes panel
of the Properties window in Sibelius; see Note Style Names for a complete list of the defined NoteStyles.

NoteStyleName The name of the notehead style of this Note (read/write). If an attempt is made to apply a non-existent style name,
the note in question will retain its current notehead.

OriginalDeltaSr The Live start position of this notehead (in 1/256th quarters), as shown in the Playback panel of Properties
(read/write). This value can be positive or negative, indicating that the note is moved forwards or backwards.

OriginalDuration The Live duration of this notehead (in 1/256th quarters), as shown in the Playback panel of Properties
(read/write).

OriginalVelocity ThelLive velocity of thisnotehead (in MIDI volume units, 0—127), as shown in the Playback panel of Properties
(read/write). Note that theword “original” refersto the fact that thisdatais preserved from the original performanceif the scorewasim-
ported from aMIDI file or input via Flexi-time. For further details on this value, and the ones following below, read the Live Playback
section in Sibelius Reference.

ParentNoteRest TheNoteRest object that holds this note (read only).
Pitch TheMIDI pitch of the note, in semitones, 60 = middle C (read only).
Slide IsTrue if the note has adide, Fal se otherwise (read/write).

SlideStyleld Thesdlideline style state of the note, allowing you to attach/detach glissandi and other linesto a note (read/write).

The following Line styles are available by default (as seen in the Inspector):
line.staff.gliss.straight
line.staff.gliss.wavy
line_staff_plain
line._staff.port._straight

62

Object Reference



Y ou can define and assign additional custom Line styles not based on the available default Line styles. For example:
// Add/set a note slide style
note_SlideStyleld = "line.staff_gliss.straight";
// Log a note slide style to the plug-in trace window
Trace(note._SlideStyleld);
// Using a custom line style
note.SlideStyleld = "line.staff.gliss.straight.user.0000001";

StringNum The string number of this note, only defined if the noteis on atablature stave. If no string is specified, reading thisvalue
will give —1. Strings are numbered starting at O for the bottom string and increasing upwards (read only).

Tied IsTrue if the noteistied to the following note (read/write).
WrittenAccidental Theaccidental, taking transposition into account (read only).

WrittenDiatonicPitch Thewrittendiatonic pitch of the note, taking transposition into account if Score . TransposingScore
isTrue (35 = middle C).

WrittenName The written pitch of the note as a string (taking transposition into account) (read only).

WrittenPitch Thewritten MIDI pitch of the note, taking transposition into account if Score. TransposingScore isTrue (60
=middle C) (read only).

UseOriginalDeltaSrForPlayback IsTrue if the Live start position of this Note should be used for Live Playback. Corre-
sponds to the Live start position checkbox in the Playback panel of the Properties window.

UseOriginalDurationForPlayback IsTrue if the Live duration of this Note should be used for Live Playback. Corresponds
to the Live duration checkbox in the Playback panel of the Properties window.

UseOriginalVelocityForPlayback IsTrue if theLive velocity of this Note should be used for Live Playback. Correspondsto
the Live velocity checkbox in the Playback panel of the Properties window.

NoteSpacingRule
Provides access to the settings from the Appearance > House Style > Note Spacing Rule dialog. Obtained by way of the Score ob-
ject, for example:

nsr = Sibelius._ActiveScore._NoteSpacingRule;

Methods

None.

Variables
The following variables are listed in the same order as the options to which they correspond in the Note Spacing Rule dialog.

FixedBarRestWidth Thewidth of an empty bar if the Fixed empty bar width n spaces radio button is chosen (read/write). This
valueisonly used if DetermineEmptyBarWidthBySrLength isFalse.

DetermineEmptyBarWidthBySrLength ReturnsTrue if Empty bar width is determined by time signature is chosen, otherwise
False (read/write).

StartOfBarGap The value of Before first note in bar n spaces (read/write).
MinimumDurationSpace Thevaue of Short notes n spaces (read/write).
SpaceForSixteenth Thevalue of 16th note (semiquaver) n spaces (read/write).
SpaceForEighth Thevalue of 8th note (quaver) n spaces (read/write).
SpaceForQuarter Thevalue of Quarter note (crotchet) n spaces (read/write).
SpaceForHalf The value of Half note (minim) n spaces (read/write).
SpaceForWhole Thevaue of Whole note (semibreve) n spaces (read/write).
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SpaceForDoubleWhole Thevalue of Double whole note (breve) n spaces (read/write).

AllowSpaceForVoiceConflicts ReturnsTrue if Allow extra space for colliding voices is switched on, otherwise False
(read/write).

SpaceAroundGraceNote Thevalue of Space around grace notes n spaces (read/write).
ExtraSpaceAfterLastGraceNote Thevalue of Extra space after last grace note n spaces (read/write).
IncludeChordSymbols Returns True if Allow space for chord symbols is switched on, otherwise Fal se (read/write).
ExtraSpaceBetweenGuitarFrames Thevaueof Minimum gap between chord symbols n spaces (read/write).
MinSpaceAroundNote Thevalue of Around noteheads (and dots) n spaces (read/write).
MinSpaceBeforeAccidental Thevaue of Before accidentals n spaces (read/write).

MinSpaceBeforeArpeggio Thevalue of Before arpeggio n spaces (read/write).

MinSpaceAfterHook Thevalue of After tails with stems up n spaces (read/write).

MinSpaceAroundLegerLine Thevaue of Around leger lines n spaces (read/write).

MinSpaceAtStartOfBar Thevalue of After start of bar n spaces (read/write).

MinSpaceAtEndOfBar The value of Before end of bar n spaces (read/write).

MinTieSpacing Thevaue of Min space (tie above/below note) n spaces (read/write).

MinTieSpacingChords The value of Min space (tie between notes) n spaces (read/write).

IncludeLyrics Returns True if Allow space for lyrics is switched on, otherwise False (read/write).
AllowFirstLyricOverhang ReturnsTrue if Allow first lyric to overhang barline is switched on, otherwise Fal se (read/write).
AllowSpaceForHyphen Returns True if Allow extra space for hyphens is switched on, otherwise False (read/write).

SpaceBetweenLyrics Thevaue of Minimum gap between lyrics n spaces (read/write).

PageNumberChange

Provides access to get and set the attributes of a page number change at the end of abar or on a blank page.

Methods

SetFormatChangeOnly(format change only) If format change only is True, this has the same effect as switching off the New page
number check box on the Page Number Change dialog in Sibelius. The page numbering will therefore continue counting consecu-
tively, but it’s possible to (for example) hide agroup of page numbers and restore visibility at alater point on the score without having
to keep track of the previous page numbers.

SetHideOrShow(page number visibility) Takes one of the three Page number visibility global constants to determine the visibility
of theinitial page number change and its subsequent pages; see Global Constants.

SetPageNumber (page number) Takes an integral number specifying the new number you wish to assign to the page.

SetPageNumberFormat(format) Takesone of the four Page number format global constantsto change the format used to display
the page number change; see Global Constants.

Variables
BarNumber Returnsthe bar number expressed as an integer (read only).

HideOrShow Returns one of the three Page number visibility global constants; see Global Constants (read only).

PageNumber Returnsthe page number expressed as an integer. For example, page x when using Roman numeralswould be 10, or 24
with alphabetics (read only).
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PageNumberAsString Returnsthe page number change as visible on the corresponding page in Sibelius (read only).
PageNumberBlankPageOffset

Returns the blank page offset of the page number change, or 0 if there are no blank pages following the bar containing the page number
change (read only).

PageNumberFormat Returnsone of four Page number format global constants describing the format of the page number change;
see Global Constants (read only).

PluginList

Anarray that isobtained from Sibelius.Plugins. It canbeusedinafor each loop or asan array with the [n] operator to access
each Plugin object.

Methods

Contains(pluginName) Returns True if aplug-in with the given name isinstalled. This can be used to query whether aplug-inis
installed before you try to cal it.

Variables
NumChildren Number of plug-ins (read only).

Plugin

This represents an installed plug-in. Typical usage:
for each p in Sibelius.Plugins

{
}

trace("Plugin: " & p-Name);

Methods

Thefollowing methods are intended to allow you to check the existence of specific methods, dataand dialogsin plug-ins, which allows
you to check in advance that calling a method in another plug-in will succeed, and fail gracefully if the method is not found:

MethodExists(method) Returns True if the specified method exists in the current Plugin object.
DataExists(data) Returns True if the specified data existsin the current Plugin object.

DialogExists(dialog) Returns True if the specified dialog exists in the current Plugin object.

Variables
File TheFile object corresponding to the file that the plug-in was loaded from (read only).

Name The name of the plug-in (read only).

RehearsalMark

Derived from aBarObject and found in the system staff only. RehearsalMarks have an internal numbering and a visible text repre-
sentation, both of which can be read from ManuScript.

Methods

None.
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Variables

Mark Theinternal number of thisrehearsal mark. By default rehearsal marks are consecutive (with the first one numbered zero), but
the user can also create marks with specific numbers.

MarkAsText Thetextua representation of thisrehearsal mark as drawn in the score. Thisis determined by the House Style > En-
graving Rules options, and can take various forms (numerical or alphabetical).

Score

Y ou can obtain the Score object by way of the Sibelius object, for example:
score = Sibelius.ActiveScore;

A Score contains one System Staff and one or more Staff objects.
for each variable in returns each staff in the score or the current dynamic part in turn (not the system staff).

for each typevariable in returns the objects in the score in chronological order, from the top staff to the bottom staff (for simulta-
neous objects) and then from left to right (again, not including the system staff).

Methods
AddBars(n) Addsn barsto the end of the score.

ApplyStyle(stylefile style™,[*'style]) Imports named styles from the given house style file (.lib) into the score. The stylefile pa-
rameter can either be afull path to thefile, or just the name of one of the styles that appearsin the House Style > Import House Style
dialog. You can import as many “style” elements as you like in the same method. Style names are as follows:
HOUSE, TEXT, SYMBOLS, LINES, NOTEHEADS, CLEFS, DICTIONARY, SPACINGRULE, DEFAULTPARTAPPEARANCE,
INSTRUMENTSANDENSEMBLES, MAGNETICLAYOUTOPTIONS or ALLSTYLES.

For instance:
score2._ApplyStyle(*'C:\NewStyle_lib", "HOUSE", "TEXT");

Note that the constant HOUSE refers, for historical reasons, only to those options in the House Style > Engraving Rules and Layout >
Document Setup dialogs, not the entire house style. To import the entire House Style, use the ALLSTYLES constant.

ClefStyleld(clef style name) Returnstheidentifier of the clef style with the given name, or the empty string if thereisno such clef
style.

Createlnstrument(style D[, change names, [**full name™,[**short name'*]]]) Creates a new instrument, given the style ID of
the instrument type required (see Instrument Types). If you want to supply the instrument names to be used in the score, set the op-
tional change names parameter to True, then supply strings for the full name and short name. Returns True if theinstrument was cre-
ated successfully and False if the instrument type could not be found.

CreatelnstrumentAtBottom(style ID[, change names, [**full name',[**short name™]]]) Behavesthe same way asCre-
atelnstrument, only the new instrument is always created below al other instruments that currently exist in the score. This can be
useful when programmatically copying alist of staves/instruments from one score to another, as you can guarantee the ordering of the
staves will be the same in both scores.

CreatelnstrumentAtBottomReturnStave(style D[, change names, [**full name',[**short name']]]) Asabove, but returns
the Staff object created, or null if unsuccessful.

CreatelnstrumentAtTop(style D[, change names, [**full name' ,["*short name']]]) Behavesin exactly the sameway asCre-
atelnstrumentAtBottom, only the new instrument is always created above al other instruments that currently exist in the score.

CreatelnstrumentAtTopReturnStave(style ID[, change names, [**full name™,[**short name']]]) Asabove, but returns the
Staff object created, or null if unsuccessful.

CreatelnstrumentReturnStave(style D[, change names,["'full name™,[*short name']]]) Like Createlnstrument, but
returns the Staff object created, or null if unsuccessful. Note that if the instrument being created contains more than one staff (such
as piano or harp), the top stave of the instrument in question will be returned.
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ExportPartsAsPDF (filename[ , singlefile , part D9 ,include score]]]) Exportsone dynamic part, aselection of dynamic parts, or
al dynamic partsin PDF format, either concatenated into asinglefile, or as separatefiles. Thefilename parameter should be acomplete
path. It may contain the following tokens, which Sibelius will expand automatically to generate a complete filename:

%T = Score filename

%t = Score title (as specified in the Title field in File > Info)

%p = Part name (as specified in the Part name field in File > Info)

%n = Part number

%0 = Total number of parts

%d = Date (format YYYY-MM-DD)

%h = Time (format HHMM)

The Boolean parameter singl e file specifies whether the chosen parts should be extracted into separate PDF files or concatenated into a
single PDF file. This parameter defaultsto True if not specified.

To specify which parts to export, create a sparse array of part 1Ds, and pass thisin as the third parameter, part 1Ds. For example:
s = Sibelius.ActiveScore;
partsToExport = CreateSparseArray();
parts = s._DynamicParts;
firstNPartsToExport = 2;
1 = 0;
for each part in parts {
if (i <= firstNPartsToExport) { // <= because the first "part"” in the
//DynamicPartsCollection is the full score.
partsToExport.Push(part);

s.ExportPartsAsPDF("'c:\\%f - %p.pdf'", true, partsToExport);
To export all parts, passin 0 instead of a sparse array.

Thefinal optional Boolean parameter, include score, defaultsto False. If set to True, the full score will also be exported along with
the parts.

ExportScoreAsPDF (filename) Exports the full score as a PDF, with the specified filename, which should be a complete path. The
filename parameter may use the same tokens as the ExportPartsAsPDF() method—see above.

ExtractParts([show_dialogq , parts path[ ,open parts]]]) Extracts partsfrom the score. Thefirst optional Boolean parameter can
beFalse, inwhich casethe parts are extracted without showing an optionsdialog. The second optional parameter specifiesafolder into
which to extract the parts (must end with atrailing folder separator). The third optional Boolean parameter, which defaultsto True,
specifies whether the extracted parts should be opened immediately, or simply saved.

FreezeMagneticlLayoutPositions() Doesthe same as selecting the whole score and choosing Layout > Magnetic Layout >
Freeze Positions, which explicitly setsthe Dx/Dy of every object to the position produced by Magnetic Layout, then disables Magnetic
Layout for each object.

GetLocationTime(bar number[,position],pass]]) Returnsthetime of agiven bar (by passing in its bar number) and optional posi-
tion within that bar in the score in milliseconds. If the score contains repeats, the value returned will always be the time on thefirst pass
through the score, but you can supply the optional pass parameter to specify a particular passin the repeat structure. If the bar and po-
sition are not valid, the return value will be -1.

GetVersions() Returnsthe score'sVersionHistory object (see VersionHistory).

HideEmptyStaves (startSaveNum, endSaveNum, startBar Num, endBarNum) Hidesany empty stavesbetween startSaveNumand
endSaveNum, from startBarNum to endBarNum. Both the staff numbers and bar numbers are 1-based, and refer to the active part.

InsertBars(n,barNum[,length]) Insertsn bars before bar number barNum. If no length has been specified, the bar will be created
with the correct length according to the current time signature. However, irregular bars may also be created by specifying avalue for
length.

InternalPageNumToExternalPageNum(pagenum) Returns a string containing the external page number of the given internal
page number pagenum.
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LineStyleld(line style name) Returnstheidentifier of the line style with the given name, or the empty string if thereisno such line
style.

NoteSty lelndex(notehead style name) Returnstheindex of the note style with the given name, or —1 if thereisno such note style.
NthStaff(staff index from 1) Returns the nth staff of the score or the current dynamic part.

OptimizeStaffSpacing (from staff number[, to staff number|[ ,from bar[ ,to bar]]]) Doestheequivalent of Layout > Optimize
Staff Spacing for the given range of staves or awhole score. from staff number must be specified; if to staff number is not specified, Si-
belius will optimize the distances between from staff number and the bottom staff in the score; if from bar is not specified, Sibelius sets
itto 1; if to bar isnot specified, Sibelius setsiit to the last bar of the score.

PlayLiveTempo(play) Switches Play > Live Tempo on or off; set play to True to switch it on, or False to switch it off.
RemoveAl IHighlights() Removesall highlightsin this score.

RemoveVideo() Removes an attached video from the score.

RenameTextStyle(*'old name', "'new name') Renames atext style to a new name.

Save (filename) Saves the score, overwriting any previous file with the same name.

SaveAs(filenametype| , use_defaults, foldername] ) Savesthe scorein aspecified format, overwriting any previousfilewith the same
name. The optional argument use_defaults only appliesto graphicsfiles, and specifies whether or not the default settings are to be used.
When set to False, the Export Graphics dialog will appear and allow the user to make any necessary adjustments. The optional folder-
name specifies the folder in which the file isto be saved, and will create the specified folder if it does not exist. The foldername param-
eter must not end with a path separator (whichis“\\” on Windows).

The possible values for type are:

SIBL Sibelius format (current version)
EMF EMF

BMP Windows bitmap

PICT PICT format

PDF PDF format

PNG PNG format

Midi MIDI format

TIFF TIFF format

XML Uncompressed MusicXML

MXL Compressed MusicXML

So, to save afile using the current Sibelius file format, you would write score . SaveAs(“filename.sib”, “SIBL™);

SaveAsAudio(filename[ , include all staveq] , play from start]]) Createsa WAV file (PC) or AIFF file (Mac) of the score, using Si-
belius's File » Export» Audio feature. If include all stavesis True (the default), Sibelius will first clear any existing selection from the
score so every instrument will be recorded; only selected staves will otherwise be exported. When play from start is True (also the de-
fault), Sibelius will record the entire score from beginning to end, otherwise from the current position of the playback line. Note that
SaveAsAudio will only have an effect if the user’s current playback configuration consists of solely VST and/or AU devices. The
functions returns True if successful, otherwise False (including if the user clicks Cancel during export).

SaveAsSibelius2(filenamg[ , foldername]) Savesthe scorein Sibelius 2 format, overwriting any previousfilewith the same name.
The optional foldername specifies the folder in which the file isto be saved. Note that saving as Sibelius 2 may alter some aspects of
the score; see Sibelius Reference for full details.

SaveAsSibelius3(filenamg[ , foldername] ) Savesthe scorein Sibelius 3 format. See documentation for SaveAsSibel 1us2
above.

SaveAsSibelius4(filenamg[ , foldername]) Saves the score in Sibelius 4 format. See documentation for SaveAsSibel ius2
above.

SaveAsSibelius5(filenamg[ , foldername]) Savesthe scorein Sibelius 5 format. See documentation for SaveAsSibel ius2
above.
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SaveAsSibelius6(filenamg[ , foldername] ) Savesthe scorein Sibelius 6 format. See documentation for SaveAsSibel 1us2
above.

SaveAsSibelius7(filenamg[ , foldername]) Saves the scorein Sibelius 7 format. See documentation for SaveAsSibel ius2
above.

SaveCopyAs(filename[ , foldername]) Savesacopy of the scorein the current version’ s format without updating the existing score’s
filenamein Sibelius.

SetPlaybackPos(bar number, sr) Setsthe position of the playback line to a given bar number and rhythmic (sr) position.

ShowEmptyStaves(startSaveNum, endSaveNum, startBarNum, endBarNum) Shows any empty staves currently hidden using
Layout > Hiding Staves > Hide Empty Staves between startSaveNum and endSaveNum, from startBar Num to endBar Num. Both the
staff numbers and bar numbers are 1-based, and refer to the active part.

StaveTypeld(stave type name) Returns the identifier of the stave type with the given name, or the empty string if thereis no such
stave type.

SystemCount(page num) The number of systems on a page (the first page of the scoreis page 1).
SymbolExists(symbol) Returns True if the symbol index or name symbol is found in the score, otherwise Fal se.
Symbo I Index(symbol name) Returns the index of the symbol with the given name, or —1 if thereis no such symbol.

TextStyleld(text style name) Returnstheidentifier of the text style with the given name, or the empty string if thereis no such text
style.

ViewLiveTempo(view) Switches View > Live Tempo on or off; set view to True to switch it on, or False to switch it off.

Variables

Arranger Arranger of score from File > Score Info (read/write).
Artist Artist of scorefrom File > Score Info (read/write)
Barlines ReturnsaBarlines object containing information about the barline groupings in the score (read only).

BarPlaybackOrder Returnsasparsearray containing alist of integersthat describes the order in which the barswill be played, ac-
cording to the repeat structure of the score or the settingsin Play > Interpretation > Repeats. To set the order in which bars should be
played, passin a sparse array containing alist of integers describing the order in which bars should be played back. To return to the
score’ s automatically-determined playback order, passin nul I (read/write).

BarPlaybackOrderString Returnsastring describing the order in which the barswill be played, according to the repeat structure
of the score. The string uses the same format as the read-out in Play > Interpretation > Repeats, for example, “1-8,

1-5,9-12". To set the order in which bars should be played, passin astring of the appropriate format. To return the score’s
automatically-determined playback order, passin nul I (read/write).

BracketsAndBraces ReturnsaBracketsAndBraces object containing information about the brackets and braces in the score
(read only).

Composer Composer of score from File > Score Info (read/write).
ComposerDates Valueof Composer’s dates from File > Score Info (read/write).
Copyist Copyist of score from File > Score Info (read/write).

Copyright Copyright of score from File > Score Info (read/write).

CurrentDynamicPart Returnsor setsthe current DynamicPart object for the Score (read/write). Sibeliuswill not automatically
display the new part: use Sibelius.ShowDynamicPart() to change the displayed part.

CurrentPlaybackPosBar Returnsthe bar number in which the playback lineis currently located.
CurrentPlaybackPosSr Returnsthe rhythmic position within the bar at which the playback line is currently located.
Dedication Dedication of score from File > Score Info (read/write).

DocumentSetup ReturnsaDocumentSetup object representing the settings in Layout > Document Setup (read only).
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DynamicParts ReturnsaDynamicPartCollection object representing the dynamic parts present in the Score. This object will
always stay up to date, even if parts are added or deleted (read only).

EnableScorchPrinting Corresponds to the Allow printing and saving checkbox in the Export Scorch Web Page dialog
(read/write).

EngravingRules Returnsan EngravingRules object corresponding to selected settingsin the House Style> Engraving Rules
diaog (read only).

FileName Thefilename for the score (read only).

FocusOnStaves IsTrue if View > Focus on Staves is switched on (read/write). See also Staff.ShowlnFocusOnStaves.
HitPoints TheHitPointList object for the score (read/write).

InstrumentChanges Value of Instrument changes from File > Score Info (read/write).

InstrumentTypes Returnsan InstrumentTypeList containing the score' sinstrument types, on which one may execute a for
each loop to get information about each instrument type within the score.

IsDynamicPart Returns True if the current active score view is a part (read only).

LiveMode IsTrue (1) if Play > Live Playback is on (read/write).

Lyricist Lyricist of score from File > Score Info (read/write).

MagneticLayoutEnabled ReturnsTrue if the current score has Layout > Magnetic Layout switched on (read/write).

MainMusicFontName Returnsthe name of the font specified asthe Main music font (such as“Opus’ or “Reprise”) in House Style
>Edit All Fonts (read/write).

MainTextFontName Returnsthename of thefont specified asthe Main text font (such as“ Times New Roman” or “Aria”) in House
Style > Edit All Fonts (read/write).

MusicTextFontName Returnsthe name of the font specified as the Music text font (such as“Opus Text” or “Reprise Text”) in
House Style > Edit All Fonts (read/write).

NumberOfPrintCopies The number of copiesto be printed (read/write).
OpusNumber Opus number of score from File > Score Info (read/write).

OriginalProgramVersion Theversion of Sibeliusin which this score was originally created, as an integer in the following
format:

(major version) * 1000 + (minor version) * 100 + (revision) * 10. So Sibelius at the time of this writing would be 8.3.1 would be
returned as 8310.

OtherlInformation Moreinformation concerning the score from File > Score Info (read/write).

PageCount The number of pagesin the score (read only).

PartName Vaue of Part Name from File > Score Info (read/write).

Publisher Publisher of score from File > Score Info (read/write).

Redraw Set thisto True (1) to make the score redraw after each changeto it, Fal se (0) to disallow redrawing (write only).
ScoreDuration Theduration of the score in milliseconds (read only).

ScoreEndTime Theduration of the score, plus the score start time (see above), in milliseconds (read only).

ScoreHeight Height of apagein the score, in millimeters (read only).

ScoreStartTime Thevaueof Timecode of first bar, from Play > Video and Time > Timecode and Duration, in milliseconds (read
only).

ScoreWidth Width of apagein the score, in millimeters (read only).

Selection TheSelection object for the score, which isalist of selected objects (read only).
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ShowMultiRests IsTrue (1) if Layout > Show Multirests is on (read/write).
StaffCount The number of stavesin the score (read only).

StaffHeight Staff height, in millimeters (read only).

Subtitle Subtitle of score (read/write).

SystemCount The number of systemsin the score (read only).

SystemObjectPositions ReturnsaSystemObjectPositions object corresponding to the settingsin House Style > System
Object Positions for the score (read only).

SystemStaff The SystemStaff object for the score (read only).
Title Titleof score from File > Score Info (read/write).
TransposingScore IsTrue (1) if Notes > Transposing Score ison (read/write).

UsingManualBarPlayOrder ReturnsTrue if Manual repeats playback ischosen in Play > Interpretation > Repeats, otherwise
False (read only).

YearOfComposition Vaueof Year of composition from File > Score Info (read/write).

Selection

for each variable in returns every BarObject (which is an object within a bar) in the selection.

for each typevariable in produces each object of type in the selection. Note that if the selection is a system selection (which is sur-
rounded by a double purple box in Sibelius) then objects in the system staff will be returned in such aloop.

Methods

Clear() Removes any existing selection(s) from the current active score.

ClipboardContainsData([clipboard Id]) Returns True if the given clipboard contains data. Aswith the Copy and Paste meth-
ods, 0 (or no arguments) refersto Sibelius' sinternal clipboard, and all other numeric values will interrogate the temporary clipboard
with the matching ID.

Copy ([ clipboard Id]) Copiesthe music within the current selection to Sibelius' s internal clipboard or a M anuScript-specific tempo-
rary clipboard, which goes out of scope along with the Selection object itself. If no clipboard Id is specified, or if it is set to 0, the
selection will be copied to Sibelius' sinternal clipboard. Any other numeric valueyou passinwill store the datain atemporary clipboard
adopting the ID you specify. Used in conjunction with Paste or PasteToPosi tion (see below).

Delete([remove staves]) Deletesthe music currently selected in the active score. Akin to making a selection manually in Sibeliusand
hitting Delete. If remove stavesis omitted or set to True, Sibelius will completely remove any wholly selected staves from the score.
If you wish Sibelius to simply hide such staves instead, set this flag to False.

ExcludeStaff(staff number) If a passage selection aready exists in the current active score, an individua stave may be removed
from the selection using this method.

HideSelectedEmptyStaves() If thecurrent selection contains staves that are empty, they will be hidden (equivalent to selecting
a passage and choosing Layout > Hiding Staves > Hide Empty Staves).

IncludeStaff(staff number) If apassage selection already existsin the current active score, anon-consecutive stave may be added
to the selection using this method.

Paste([clipboard Id[,reset positions]]) Pastesthe music from agiven clipboard to the start of the selection in the current active score.
If no clipboard Id is specified, or if it isset to 0, the datawill be pasted from Sibelius' sinternal clipboard. Any other numeric value you
passin will take the data from atemporary clipboard you must have previously created with acall to Copy (see above). Returns True
if successful.

If reset positionsis False, the positions of any objects that have been moved by the user in the source selection will be retained in the
copy. Thisisthe default behavior. If you wish Sibeliusto reset objectsto their default positions, set thisflag to True. This can be useful
when copying one or more single objects (which is a non-passage selection).
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Note that pasting into a score using this method will overwrite any existing music. Only one copy of the music will ever be made, so if
your selection happens to span more bars or staves than is necessary, the data will not be duplicated to fill the entire selection area.

PasteToPosi tion(stave num, bar num, position[, clipboard Id[,reset positions]]) Pastes the music from a given clipboard to a
specific location in the current active score. The optional parameters and pasting behavior works in the same way as callsto Paste.

RestoreSelection() Restoresthe selection previousdy recorded with acall to StoreCurrentSelection. Usefully called at
the end of a plug-in to restore the initial selection.

SelectPassage(start barNum[ , end barNum[ , top staveNun , bottom staveNum[ , start pos , end pos]]]]1]) Programmatically
makes a passage selection around a given area of the current active score. When no end barNum s given, only the start barNum will
be selected. If neither atop- nor bottom staveNum has been specified, every stavein the scorewill be selected, whereasif only atop stav-
eNum has been supplied, only that one staff will be selected. Sibeliuswill begin the selection from the start of thefirst bar if no start pos
has been given, similarly completing the selection at the end of the final bar if no end pos has been supplied.

Q The start pos and end pos you supply may be altered by ManuScript: Sibelius requires a passage selection to begin and end at a
NoteRest if it doesn’t encompass the entire bar.

SelectSystemPassage(start barNum[ , end barNum[ , start pog , end pos]]]) Programmatically makesasystem selection around
agiven area of the current active score. When no end barNum s given, only the start barNum will be selected. Sibeliuswill begin the
selection from the start of the first bar if no start pos has been given, similarly completing the selection at the end of the final bar if no
end pos has been supplied.

Q The start pos and end pos you supply may be altered by ManuScript: Sbelius requires a passage selection to begin and end at a
NoteRest if it doesn’t encompass the entire bar.

StoreCurrentSelection() Storesthe current selection in the active score internally. Can be retrieved with a call to Restore-
Selection (see below). Usefully called at the start of a plug-in to store the initial selection.

Transpose (degree, interval type| ,keep double accq,transpose keys|]) Transposes the currently selected music up or down by a
specified degree and interval type. To transpose up, use positive valuesfor degree; to transpose down, use negative values. Note that de-
grees are 0-based, so 0 isequal to aunison, 1 to asecond and so on. For descriptions of the various available interval types, see Global
Constants. By default, Sibeliuswill transpose using double sharps and flats where necessary, but this behavior may be suppressed by
setting the keep double accs flag to False. Sibelius will also transpose any key signatures within the selection by default, but can be
overridden by setting the fourth parameter to False.

For help in calculating the interval and degree required for a particular transposition, see the documentation for
theSibelius.Calculatelnterval and Sibelius.CalculateDegree methods.

Variables
BottomStaff The number of the bottom staff of a passage (read only).

FirstBarNumber Theinternal bar number of thefirst bar of a passage (read only).

FirstBarNumberString Theexterna bar number (including any bar number format changes) of the first bar of a passage (read
only).

FirstBarSr The position of the start of the passage selection in the first bar (read only).

IsPassage Trueif the selection represents a passage, as opposed to a multiple selection (read only).

IsSystemPassage Trueif the selection includes the system staff (read only).

LastBarNumber Theinterna bar number of the last bar of a passage (read only).

LastBarNumberString Theexternal bar number (including any bar number format changes) of thelast bar of apassage (read only).
LastBarSr The position of the end of the passage selection in the last bar (read only).

TopStaff The number of the top staff of a passage (read only).
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Copying Entire Bars

Copying passages from one location in ascore to another—or even from one score to another—is very simple. Hereis an example func-
tion demonstrating how one might go about achieving this:
CopyBar(scoreSrc, barFirstSrc, barLastSrc, scoreDest, barFirstDest,

{

}

barLastDest) // This is the function signature

sel = scoreSrc.Selection;
sel _SelectPassage(barFirstSrc.BarNumber, barLastSrc.BarNumber,
barFirstSrc.ParentStaff.StaffNum,
barLastSrc.ParentStaff.StaffNum);
sel .Copy(0);
selDest = scoreDest.Selection;
selDest.SelectPassage(barFirstDest.BarNumber, barLastDest.BarNumber,
barFirstDest.ParentStaff.StaffNum,
barLastDest.ParentStaff.StaffNum);
selDest.Paste(0);

Note that you may use any temporary clipboard or Sibelius's own internal clipboard if the source and destination locations are in the
same score, however you can only use Sibelius'sinternal clipboard if the dataiis being transfered between two individual scores. This
is because the temporary clipboards belong to the Selection object itself.

Copying Multiple Selections from One Bar to Another

Using a combination of the BarOb ject’s Select method and the Selection object’s Copy and PasteToPosition methods, it
ispossibleto copy anindividual or multiple selection from onelocation in ascore to another. Bear in mind that Paste will always paste
the material to the very start of the selection, soif you' re copying a selection that doesn’t start at the very beginning of abar, you’ll have
to store the position of thefirst item and passit to PasteToPosi tion when you later come to paste the music to another bar.

This example code below copies all items from position 256 or later from one bar to another. It is assumed that sourceBar isavalid
BarObject, and destStaffNum and destBarNum contain the destination staff number and bar number respectively:
sel = Sibelius.ActiveScore.Selection; // Get a Selection object for this score
sel.Clear(); // Clear the current selection
clipboardToUse = 1; // This clipboard ID we’re going to use
copyFromPos = 256; // Copy all objects from this point in the source bar
posToCopyTo = 0; // Variable used to store the position of the first object copied
for each obj in sourceBar { // lterate over all objects in the bar

if (obj.Position >= copyFromPos) { // Ignore objects before the start threshold
obj.Select(); // Select each relevant object in turn
if (posToCopyTo = 0) {
posToCopyTo = obj.Position; // Remember the position of the first item
{
}

sel .Copy(clipboardToUse); // Copy the objects we’ve selected to the clipboard
sel _PasteToPosition(destStaffNum, destBarNum, posToCopyTo, clipboardToUse); // And
paste them to the destination bar at the relevant offset

Sibelius

Thereisapredefined variabl e that representsthe Sibelius program. Y ou can use the Sibelius object to open scores, close scores, display
dialogs or (most commonly) to get currently open Score objects.

for each variable in returns each open score.

Methods

AppendLineToFi le(filename, text[ , use_unicode]) Appends aline of text to the file specified (adds line feed). See comment for
AppendTextFi le above for explanation of the use_unicode parameter. Returns True if successful.
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AppendLineToRTFFi le(filename, text) Appendsaline of text to the file specified. Times New Roman 12pt is used, unless you
specify achange of formatting. To change formatting, use the following backslash expressions:
\B\ bold on

\ I\ italic on

\U\ underline on

\n\ new line

\b\ bold off

\i\ italic off

\u\ underline off

\ffontname\ change to given font name (for example \FArial\ to switch to Arial)

\spoints\ set the font size to a specific point size (for example \s16\ to set the font to 16pts).

Note the difference in meaning of \s in the context of adding datato an RTF file, versusits use in the context of styling text directly
within Sibelius (see Syntax following).

AppendTextFi le(filename, text[ ,use_unicode]) Appendstext to thefile specified. If the optional Boolean parameter use_unicode
isTrue, thenthe string specified will be exported in Unicode format; if thisparameter isFal se thenit will be convertedto 8-bit Latin-1
before being added to the text file. This parameter is True by default. Returns True if successful.

CalculateDegree(source pitch, dest pitch, upward interval) Takestwo note namesin theform of astring (for example C, G#, Bb,
Fx or Ebb) and aboolean that should be True if theinterval you' rewishing to calculateisupward. Returns a 0-based number describing
the degree between the two notes.

For example, CalculateDegree(“C#”, “G”, False) would return 3.

Calculatelnterval (source pitch, dest pitch, upward interval) Takes two note namesin the form of astring (for example C, G#,
Bb, Fx or Ebb) and a boolean that should be True if the interval you' re wishing to calculate is upward. Returns a number representing
an Interval Type (see Global Constants). You can use the value returned in callsto NoteRest. Transpose and Selec-
tion.Transpose.

For example, Calculatelnterval (“Bb”, “G#”, True) would return IntervalAugmented.

Close(show dialogs) Closesthe current score or part view; if the current view isthe last tab in the current window, the window will
therefore also be closed. If the optional Boolean parameter is True then warning dialogs may be shown about saving the active score,
and if it is False then no warnings are shown (and the score will not be saved).

CloseAl IWindows(show dialogs) Closes al open document windows. If the optional Boolean parameter is True then warning di-
alogs may be shown about saving any unsaved scores, and if it is Fal se then no warnings are shown (and the scores will not be saved).

CloseDialog(dialogName, pluginName, returnValue) Closes the dialog dialogName belonging to the plug-in pluginName (nor-
mally this should be set to sel F), returning the Boolean value returnValue, which can be set to True (1) or False (0). Normally you
do not need to use this method to close adialog, as you can set buttons (typically with labelslike OK or Cancel) to close the dialog and
return avalue, but if you want greater control over when adialog is closed, this method providesiit.

CloseWindow(show dialogs) Closesthe current window (that closesall of the open tabsin the current window). If the optional Bool-
ean parameter is True then warning dialogs may be shown about saving the score, and if it is Fal se then no warnings are shown (and
the score will not be saved).

CreateFolder (foldername) Creates the folder of specified foldername; returns the Folder object created if successful, or null if it
fails.

CreateProgressDialog(caption, min value, max value) Creates the progress dialog, which shows a slider during along opera-
tion.

CreateRTFFi le(filename) Creates the Rich Text Format (RTF) file specified. Any existing file with the same name is destroyed.
Returns True if successful.
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CreateTextFile(filename) Createsthe plain text file specified. Any existing file with the same nameis destroyed. Returns True if
successful.

DestroyProgressDialog() Destroysthe progress dialog.

EnableControlByld(plugin,dialog, controlID, enable) Dynamically enables or disables a given control on aplug-in diaog:
plug-inisaPlugin object, for example Sel f; dialogisaDial og object, and therefore should not be passed in quotation marks; con-
trolI D isthe string corresponding to the control to be enabled or disabled; and enable is a Boolean parameter, which enables the control
when set to True and disables the control when set to Fal se.

EnableNthControl (nth control, enable) Dynamically enables or disables agiven control on aplug-in dialog. Can be called either
before adial og has been displayed (in which case the operation will apply to the next dialog you show), or whileadialog isaready vis-
ible (in which case the operation will affect the top-most currently visible dia og).

Notethat, using this method, controls can only beidentified according to their order upon creation; for thisreason, you are strongly rec-
ommended to use EnableControlByl1d() instead. To find out the creation order, open the appropriate dialog in the plug-in editor,
right click on the dialog’ s client area and choose Set Creation Order from the contextual menu that appears. Note that nth control ex-
pects a 0-based number, unlike the display given by Set Creation Order. By default, al controls will be enabled; to disable any given
control, set enable to false.

FileExists(filename) Returns True if afile exists or False if it doesn't.
FolderExists(foldername) Returns True if afolder existsor False if it doesn’t.
GetDocumentsFolder() Returnsthe user's My Documents (Windows) or Documents (Mac) folder.

GetElapsedCentiSeconds(timer number) Returns the time since ResetStopWatch was called for the given stop watch, in
100ths of a second.

GetElapsedMi I liSeconds(timer number) Returnsthe time since ResetStopWatch was called for the given stop watch, in
1000ths of a second.

GetElapsedSeconds(timer number) Returnsthe time since ResetStopWatch was called for the given stop watch in seconds.

GetFile(file path) Returns anew Fi le object representing afile path for example File=Sibelius.GetFile
("c:\\onion\\foo.txt");

GetFolder(file path) Returnsanew Folder object representing afile path for example folder=Sibelius.Get-
Folder(*'c:\"");

GetNotesForChord(chord name) Returns a ManuScript array giving the MIDI pitches corresponding to the named chord symbol.

GetNotesForGuitarChord(chord name) ReturnsaManuScript array giving the MIDI pitches and string numbers corresponding
to the named guitar chord, using the most suitable fingering according to the user’s preferences. Strings are numbered starting at 0 for
the bottom string and increasing upwards. The array returned has twice as many entries as the number of notesin the chord, because the
pitches and string numbers are interleaved thus:

array[0] = MIDI pitch for note O

array[1] = string number for note O

array[2] = MIDI pitch for note 1

array[3] = string number for note 1

GetScoresFolder() Returnsanew Folder object representing the default Scores folder (as defined on the Files page of File »
Preferences).

GetSyllabifier() Returnsanew Syllabifier object, providing accessto Sibelius' sinternal syllabification engine.
GetUserApplicationDataFolder() Returnsthe user’s Application Data (Windows) or Application Support (Mac) folder.
GoToEnd() Movesthe playback line to the end of the score.

GoToStart() Movesthe playback line to the start of the score.

IsDynamicPartOpen(dynamic part) ReturnsTrue if the specified part and its corresponding Scoreisvalid and isvisiblein a Score

window within Sibelius.
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IsFontFami lylnstal led(font name) Returns True if afont with the name font name exists on the system, otherwise Fal se.

LaunchApplication(path[, parameters , hide]]) Launchesan external application specified viaits path, which must be acomplete
path to the application to be launched. Y ou can optionally passin a sparse array of parameters (or a string if you want to passin only
asingle parameter); omit this or set it to nul 1 to pass no parameters to the launched application. To prevent the launched application
from gaining the focus once it is launched, set the optional hide parameter to True; if unspecified, this defaultsto Fal se, so the
launched application will gain the focus.

LiveTempoTap() Equivaent to tapping abeat during Live Tempo recording.

MakeSafeFileName (filename) Returnsa“safe” version of filename. The function removes characters that areillegal on Windows
or Unix, and truncates the name to 31 characters so it will be viewable on Mac OS 9.

MessageBox(string) Shows a message box with the string and an OK button.

MoveActiveViewToBar (bar number[ , position]) Bringsagiven internal bar number into view. Has the same effect as Go to Bar
in Sibelius. An optional position within the bar may also be specified, but if omitted, the very start of the bar will be brought into view.

MoveActiveViewToSelection([start of selection]) Bringsthe object(s) currently selected into view. If start of selectionisFalse,
the end of the selection will be brought into view. If the optional argument is True or omitted, the start of the selection will be visible.
Has the same effect as Shift + Home/End in Sibelius.

New([manuscript paper]) Createsand showsanew score. If the optional parameter manuscript paper isnot supplied, Sibeliuswill cre-
ate a blank score; manuscript paper should be the filename of the manuscript paper you want to create, minusits .sib file extension, op-
tionally including the name of the category (subfolder) in which it is located, for example both "String orchestra" and
"Orchestral/String orchestra" will work. Returns the score object corresponding to the new score.

NthScore(scoreindex from0) Returns the nth open score (zero-based), or null if the specified index is not valid.

Open(filename [, quiet]) Opensand displaysthegivenfile. Filename must includeits extension, for example Song.sib. If the optional
boolean parameter quiet isset to True, then no error messages or dialogswill be displayed, even if thefile could not be opened for some
reason. Returns True if thefile is opened successfully, Fal se otherwise.

Play() Playsthe current score, from the current position of the playback line.
PlayFromSelection() Playsfrom the current selection.

PlayFromStart() Playsfrom the start of the score.

PrependScreenreaderText(string) Prepends string to the default screen reader description.

Print(number of copieg , dynamic part[ , showdialog]]) Printsthe specified number of copies of the current score or dynamic part
using default settings. If number of copiesis missing or a negative number, then the default number of copies for the score or part is
printed, and if set to O no printing occurs. The optional dynamic part parameter must be avalid object of the active Score (this does not
affect or use Score.CurrentDynamicPart for the Score printed); if it is not supplied, the active Score is printed instead. Returns
True for success, Fal se for failure. The second optional parameter, showdialog, isaBoolean: if set to True, Sibelius will show the
Print dialog, and if not specified or set to False, Sibelius will not show the dialog.

PrintAl IDynamicParts([score]) Printsthe default number of copiesof all dynamic parts, but does not print the full score. Prints
the currently-active Score if the optional score parameter is not passed in. Returns True for success, False for falure.

RandomNumber () Returns arandom number.
RandomSeed (start number) Restarts the random number sequence from the given number.
RandomSeedTime() Restartsthe random number sequence based on the current time.

RefreshDialog() Refreshesthe databeing displayed by any controls on the currently active plug-in dialog. For example, if atext
object getsits string from a global variable and the value stored in this global variable has changed whilst the dialog is visible, calling
RefreshDialog will update the text object on the dialog accordingly. Returns True if successful.

ResetStopWatch(timer number) Resets the given stop watch. timer number must be an integer greater than 0.

ReadTextFile(filename, [unicode]) Readsthe given filenameinto an array of strings, one per line. If the unicode parameter istrue,
thefileistreated as Unicode, otherwise it istreated as ANSI (that is 8-bit) text, which is the default.
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The resulting array can be used in two ways:
lines = Sibelius.ReadTextFile("file.txt");
for each 1 in lines {
trace(l);
}

or:

lines = Sibelius.ReadTextFile("file.txt™);
for 1=0 to lines_NumChildren {
trace(lines[i]);

}

ScreenreaderText(string) Replaces Sibelius's default screen reader description with string.

SelectFileToOpen(caption,file,initial_dir, default extension, default type, default type description) Shows a dialog prompting

the user to select afileto open. All parameters are optional. The method returns afile object describing the selection. For example:
file=Sibelius.SelectFileToOpen("'Save Score","*_sib","c:\","sib","SIBE", " Sibelius

File™);

Note that the initial_dir parameter has no effect on Mac, because it is unsupported by Mac OS X.

SelectFileToSave(caption,file,initial_dir,default extension, default type, default type description) Shows a dialog prompting
the user to select afileto saveto. All parameters are optional. The method returnsaF i e object describing the selection. Filetypesand

extensions:

Description Type Extension
EMF graphics "EMFT emf
Windows bitmap "BMP" bmp
Macintosh PICT bitmap "PICT" pict
Sibelius score "SIBE" sib
MIDI file “Midi" mid
House style file "S1BS" lib
PhotoScore file ""SCMS" opt
Web page "TEXT™ html
TIFF graphics "TIFF" tif
PNG graphics "PNG™ png

Note that the initial_dir parameter has no effect on Mac, because it is unsupported by Mac OS X.

SelectFolder([caption]) Allowstheuser to select afolder and returnsaFolder object. The optional string parameter caption sets
the caption of the dialog that appears.

SetCurrentScoreViewType(view type) Allows plug-insto switch between Panoramaand normal view; valuesare ViewTypeP-
age (0) and ViewTypePanorama (1).

SetFocusToControl (pluginName, dialogName, controlID) Sets the focus on a specific control in aplug-in dialog. pluginName
will normally be set to se I F, dialogName is the name of the dial og in which the control isfound, and controlID isthe ID of the control
to receive the focus, which must be specified in quotation marks.

ShowDialog(dialogName, pluginName) Shows adial og dialogName from adial og description and sends messages and valuesto the
given Plugin object pluginName (normally set to Sel ). Returnsthe value True (1) or False (0) depending on which button you
clicked to close the dialog (typically OK or Cancel).

ShowDynami cPart(dynamic part[ , nesMMndow]) Shows the specified dynamic part. The second optional Boolean parameter new-
Window allows you to specify whether the part should open in anew tab (specify Fal se, the default) or anew window (specify True).
Returns True if the specified part can be shown, False otherwise. Can be used to bring a Score to the front by way of Sibel-
ius.ShowDynamicPart(Score.CurrentDynamicPart).
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ShowTraceWindow() ShowsthePlug-in Trace Window, or forcesit to thefront if it is already shown but currently behind another
window.

Sibelius.GetUserSibeliusFolder() Returnsthe path to the Sibeliusfolder inside the user Documentsfolder by default (this
value may be overridden in File > Preferences > Saving and Exporting > Saving scores). For example:

On Windows: C:\Users\<your user name>\Documents\Scores
On Mac: /Users/<your user name>/Documents/Scores

StartLiveTempoRecording() Startsrecording Live Tempo; equivalent to choosing Play > Record Live Tempo
StopLiveTempoRecording() Stopsrecording Live Tempo.

Stop() Stops the current score from playing.

UpdateProgressDialog(progress pos, status message) Returns O if the user clicked Cancel.

YesNoMessageBox(string) Shows a message box with Yes and No buttons. Returns True if Yes is chosen, else False.

Variables

ActiveScore Istheactive Score object (read/write). Setting Sibelius.ActiveScore makes active the current dynamic part
(which may be the full score rather than a part) of the score. If that window is not currently shown, a new window may be created ac-
cording to the user’s preferences. Returns null if it fails to make the specified score or part active.

ApplicationLanguage Returnsthelanguage of the version of S.ibelius currently running, awaysin English—such asEnglish,
German, French and so on. (read only)

ApplicationLanguagelsoString Returnsthetwo-letter 1ISO 3166 identifier of the language in which Sibeliusis currently
running, such asen, de, fr, and so on (read only).

CurrentTime Returnsastring containing the current timein the format hh:mm:ss, based on your own computer’slocale (read only).

CurrentDateShort Returnsastring containing the current date in the format dd/mm/yyyy, based on your own computer’s locale
(read only).

CurrentDatelLong Returnsastring containing the current date in the format dd MM yyyy, based on your own computer’s locale
(read only).

CurrentDate Returnsthe current date and time asaDateTime object in local time (read only).
FontFami lies Returnsasparse array of strings containing the names of all the available font families on the system (read only).
HouseStyles Thelist of house styles available, asa ComponentList.

LocalizedApplicationLanguage Returnsthelanguageinwhich Sibeliusiscurrently running, inthelocalized language, for ex-
ample it returns Deutsch when running in German (read only).

ManuscriptPapers Thelist of manuscript papers available, asaComponentList.

OSVersionString The current operating system in which the plug-in is running, as one of the following strings:

Windows 95 Mac 0OS X
Windows 98 Mac OS X Jaguar
Windows ME Mac OS X Panther
Windows NT 3.x Mac OS X Tiger
Windows NT 4 Mac OS X Leopard
Windows 2000 Mac OS X Snow Leopard
Windows XP Mac OS X Lion
Windows Vista Mac OS X Mountain Lion
Windows 7 Mac OS X Yosemite
Windows 8 Mac OS X El Capitan
Windows 10 Mac OS X Sierra

Mac OS X High Sierra
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If the operating system is unrecognized, the variable returns Unknown system version.
PathSeparator Returnsthe current path separator character (whichis“\” on Windows, “/” on M&c).
Plugins Thelist of plug-insinstalled. See the documentation for the Plugin object

Playing IsTrue if ascoreiscurrently being played (read only).

ProgramVersion The current version of Sibeliusin which the plug-in is running, as an integer in the following format:
(major version) * 1000 + (minor version) * 100 + (revision) * 10
So Sibelius 3.1.3 would be returned as 3130.

ScoreCount Isthe number of scores being edited (read only).

SuppressDefaultScreenreaderText Set to True to suppress the default score description for screen readers for blind and vi-
sually impaired users (read/write).

ViewHighlights IsTrue if View > Highlights is switched on (read/write).
ViewNoteVelocities IsTrue if View > Live Playback Velocities is switched on (read/write).

ViewNoteColors Thecurrent View > Note Colors setting used (read/write).
Description Value
None 0
Notes out of Range 1
Pitch Spectrum 2
Voice Colors 3

SoundlInfo

The Sound Info object contains information about the playback of a given staff.

To get the Sound Info object for a staff, use for example:
staff = Sibelius.ActivateScore _NthStaff(l);
soundinfo = staff.SoundinfoAtPosition(1,0,0);

The Sound Info object can be moved around the staff once you have created it, and it will return information about the sound IDsin
use throughout the staff.

Methods
Clone() Returnsanew SoundInfo object using the same credentials as the object on which the method is called.

CreateAt([barNumber, [position, [ nthRepeat]]]) Returns anew Sound Info object at the specified bar number, at the specified

rhythmic position in the bar (for example 256 for the second quarter note position), asif played through at the nth repeat (for example
2 for the second repeat). If no bar number is specified, theinformation returned will refer to bar 1. If no position is specified, theinfor-
mation will refer to the start of the bar. If nth repeat is not specified, the information returned will refer to thefirst passthrough the score.

MoveTo([barNumber , [position, [ nthRepeat]]]) Usesthe same parameters as CreateAt (). Allows the caller to move the existing
Sound Info object to an entirely new location on the current staff.

MoveToNext() Movesto the next sound change event. If there are no more changes, it returns fal se and doesn’t move.

MoveToPrevious() Movesto the previous sound change event. If there are no changes before, it returns fal se and doesn’t move.

Variables
ActualSoundld The actual sound ID at the current location (read only).

BarNum Returns the current location's bar number (read only).

IsDrumStave Returnstrue if the current location is on adrum staff (read only).
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NthRepeat Returnsor setsthe nth repeat (or pass) of the current location’s bar (read/write).
NumTimesBarPlayed The number of timesthe bar at the current location is played (read only).
PatchName The name of the patch in use at the current location (read only).

Position Returnsor setsthe current location’s position within the bar (read/write).
RequestedSoundld Therequested sound ID at the current location (read only).

SoundChangelndex The current index in the bar play sequence. This allows differentiation between different identical sound
changes (read only).

SoundSetName Returnsthe name of the sound set in use at the current location (read only).

StaveNum Returnsthe 1-based stave number (read only)

SparseArray

To create a sparse array, use the built-in method CreateSparseArray(al,a2, a3, a4...an).

for each allowsyou to iterate over the contents of a sparse array.

Methods

Concat(arrayl, array2 ... arrayN) Concatenate zero or more sparse arraysto this one, and return it as a one-level deep copy (soif a
sparse array contains other arrays, for example, then the new sparse array will contain references to those arrays, not copies of them).
This method does not modify the original sparse array.

Join([separator]) Returnsthearray asastring, with each populated element separated by the optional separator. If you don’t specify
separator, the default separator is a comma.

Push(valuel, value2, value3 ... valueN) Pushes one or more values to the end of the array.
Pop() Returnsthelast element of the array, and removesit from the array.

Reverse() Reversesthe sparse array in place, modifying the sparse array being operated on. The reversed array only populates the
elements needed to create the reversed array.

Slice(start[ ,end]) Returnsanew sparse array of the elements starting from start and up to, but not including, the optional end. start
and end can be negative indices referring to offsets from the end of the array.

Variables
Length Returnsor setsthe length of the array (read/write).

ValidIndices Returnsasparsearray containing only the populated indices of the original sparsearray, that isthose that are not null.

Converting Old-style Arrays to New Sparse Arrays

The SparseArray object is areplacement for the old Array object, which was a more limited kind of array that could only hold
strings and integers, but no other kind of objects. Y ou are recommended to use the new SparseArray object for al arraysin your
plug-ins, but if you have an existing plug-in in which old-style Arrays are used, you can convert them to SparseArrays asfollows:

Array.ConvertToSparseArray() Returnsanew SparseArray object, popul ated with strings converted from the old-style Ar-
ray.
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SpecialBarline

Derived from aBar object, these can only be found in system staves.

Methods

None.

Variables
BarlineType Thename of the type of special barline, expressed as a string.

BarlinelnternalType Thetype of the barline, expressed as a numeric ID which maps to one of the SpecialBarline global
constants (see Global Constants).

Staff

These can be normal staves or the system staff. The system staff contains objects that apply to al staves, such asSpecialBarlines
and text using a system text style.

A Staff contains Bar objects.
for each variable in returns each object in the staff.

for each typevariablein returnseach item of typein the staff in chronological order (that isin order of rhythmic position in each bar).

Methods

AddClef(pos, concert pitch clef[ , transposed pitch clef]) Adds a clef to the staff at the specified position. concert pitch clef deter-
minesthe clef style when Notes > Transposing Score is switched off; the optional transposed pitch clef parameter determinesthe clef
style when thisis switched on. Clef styles should be an identifier like “clef.treble”; for acomplete list of available clef styles, see Clef
Styles. Alternatively you can give the name of aclef style, such as“Treble,” but bear in mind that this may not work in non-English
versions of Sibelius.

AddLine(pos,duration, line style, [dx, [dy, [ voicenumber , [hidden]]]]) Adds aline to staff (please see the documentation in Bar
object below).

AddNote (pos, sounding pitch, duration, [tied [ , voice [ , diatonic pitch[ , string number]]]]) Adds anote to staff, adding to an exist-
ing NoteRest if already at this position (in which case the duration is ignored); otherwise creates a new NoteRest. Will add a new bar

if necessary at the end of the staff. The position isin 1/256th quarters from the start of the score. The optional tied parameter should be
True if you want the note to betied. Voice 1 is assumed unless the optional voice parameter (with avalue of 1, 2, 3 or 4) is specified.
Y ou can also set the diatonic pitch, that is the number of the “note name” to which this note corresponds, 7 per octave (35 = middle C,
36 =D, 37 = E and so on). If adiatonic pitch of zero is given then a suitable diatonic pitch will be calculated from the MIDI pitch. The
optional string number parameter gives a string number for this note, which is only meaningful if the noteis on atablature stave. If this
parameter isnot supplied then a default string number is calculated based on the current tablature stave type and the guitar tab fingering
options (specified on the Note Input page of File > Preferences). Returns the Note object created (to get the NoteRest containing the
note, use Note . ParentNoteRest).

When adding very short notesto tuplets, Sibelius may be unableto find alegal place for the note in the bar. Should this happen, Sibelius
will return null. Y ou should therefore check for avalid object if there is any likelihood that this situation may arise in your code.

Q If you add a noteto a score that intersects an existing tuplet, Sbeliuswill try to snap the note to the closest sensible place within
that tuplet. However, you are advised to use Tuplet.AddNote() for this purpose asit is void of any ambiguity.
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AddStaffAbove(ossia,[start bar number|[ , end bar number[ , start pog[ , end pos|]]]) Addsanew staff abovethe staff. Set ossiato
True to create an ossia (small) staff. The other, optional parameters determine where the staff should be visible: if you do not specify
astart bar number, the staff will be visible from the start of the score; if you do not specify an end bar number, the staff will be visible
to the end of the score. If you specify a start and/or end bar number, the staff will be hidden outside that range by way of an instrument
changetothe No instrument (hidden) instrument type. start pos and end pos represent the rhythmic position within the start bar number
and end bar number respectively, and if not specified, start poswill default to the start of the bar, and end pos will default to the end of
the bar. Returns the staff created, or null if the call fails.

AddstaffBelow(ossia, [start bar number[ ,end bar number[ , start pog[ , end pos]]]]) Adds anew staff below the staff. See
AddstaffAbove () abovefor details.

AddSymbol (pos, symbol index or name) Adds a symbol to staff (please see the documentation in Bar object below).
CurrentKeySignature(bar number) ReturnsaKeySignature valid at the bar number passed.
NthBar (n) Returnsthe nth bar in the staff, counting from 1.

ResetSpaceAroundStaff(above, below] ,frombar[ ,to bar]]) Doestheequivalent of Layout > Reset Space Above Staff and/or
Reset Space Below Staff for the given range of barsin astaff. Set aboveto True to reset the space above the staff, and below to True
to reset the space below the staff. If from bar is not specified, Sibelius setsit to 1; if to bar is not specified, Sibelius setsit to the last
bar of the score.

SetSound(stylel D[, set SoundSage] ) Changestheinitia playback sound of this staff to be the default sound for the given default in-
strument stylel D. For acomplete list of default instrument style IDsin Sibelius, seeInstrument Types. If the optional Boolean param-
eter is set to Fal se, then the SoundStage information (volume, pan and distance) for this staff will be unchanged. If it is omitted or set
to True, then the SoundStage information will be set to the default for the new sound.

SetSound1D(soundID) Changestheinitial playback sound of this staff to the given soundID.

Sound IDAtPosition([bar number,[position, [nth repeat]]]) Returnsanew SoundInfo object at the specified bar number, at
the specified rhythmic position in the bar (for example 256 for the second quarter note position), asif played through at the nth repeat
(for example 2 for the second repeat). If no bar number is specified, the information returned will refer to bar 1. If no position is spec-
ified, the information will refer to the start of the bar. If nth repeat is not specified, the information returned will refer to the first pass
through the score.

Staff[array element] Returnsthe nth bar (counting from 1) for example Staff[1].

Variables

BankHigh ControlsMIDI controller O, used to select the“coarse” bank number for this stave, and corresponding to the Mixer control
of the same name. Therangeis0-127, or —1 if you don’'t want to send this controller message at the start of playback. Note that not all
MIDI devices support multiple banks (read/write).

BankLow Controls MIDI controller 32, used to select the “fine” bank number for this stave, and corresponding to the Mixer control of
the same name. Therangeis 0-127, or -1 if you don’t want to send this controller message at the start of playback. Note that not all
MIDI devices support multiple banks (read/write).

BarCount Number of barsin the staff (read only).
BarNumber The bar number of this bar. Thisisthe internal bar number, which always runs consecutively from 1 (read only).
Channel The MIDI channel number of this staff, numbered 1-16 (read/write).

Distance Thereverb “distance’ of this staff, corresponding to the control of the same namein the Mixer. Thisis a percentage, used
to scale the overall reverb settings from the Performance dial og (read/write).

FullInstrumentName Givesthe full instrument name of the staff, empty for an unnamed staff (read/write).

Full InstrumentNameWithFormatting Givesthefull instrument name of the staff including any changes of font or style, if any
(read/write).

NumStavesInSameInstrument Thenumber of staves belonging to the default instrument from which this staff was created (read
only).

InitialClefStyle Thenameof theinitial clef on a staff, depending on the state of Notes > Transposing Score (read only).
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InitialClefStyleld Thestyleidentifier of theinitia clef on astaff, depending on the state of Notes > Transposing Score (read
only).

InitiallnstrumentType Returnsan InstrumentType object for the instrument type at the start of the staff.
InitialKeySignature ReturnstheKeySignature object at the start of this staff (read only).

InitialStyleld Returnsthestyleidentifier of the staff (read only). To create an instrument from such an I1D, passthe style asthe
first argument to Score . Create lnstrument. For acomplete list of al the default instrument names in Sibelius, see Instrument
Types.

InstrumentName Givesthe full instrument name of the staff in the form that is displayed on the Instruments and Staves dialogin
Sibelius (read only). For an unnamed stave, thiswill be “[Piano]” for example, where Piano is the default instrument name of the stave
(see below). To get the internal name (which will be empty for unnamed staves), use the read/write variables

Full InstrumentName or ShortlInstrumentName instead.

IsSystemStaff True or False depending on whether this staff is a system staff or not (read only).

IsVocalStaff ReturnsTrue if theinstrument type used by the staff hasthe Vocal staff option switched on, meaning that the default
positions of dynamics should be above the staff rather than below (read only).

MuteMode Specifieswhether or not this stave will play back. Corresponds to the mute button in the Mixer. The supported values are
defined as global constants (see Global Constants) and are Muted, Hal fMuted and NotMuted (read/write).

Pan TheMIDI stereo panning position of thisstaff (corresponding to the pan control inthe Mixer). Permissible values are—100 to 100,
with positive values being to the right and negative to the left (read/write).

ParentScore Returnsthe staff’s parent Score object (read only).
ShortinstrumentName Givesthe short instrument name of the staff, empty for an unnamed staff (read/write).

ShortinstrumentNameWithFormatting Givesthe short instrument name of the staff including any changes of font or style, if
any (read/write).

ShowlnFocusOnStaves If True then this staff will be shown when Layout > Focus on Staves is switched on (see aso
Score.FocusOnStaves). Thisvariable cannot be set to Fal se unlessitisaso True for at least one other staff in the score
(read/write).

Solo True or False depending on whether this staff plays back in“solo” mode, corresponding to the Mixer button of the same name
(read/write).

SoundldOverridel fAny Returnsastring containingthesound ID override set inthe mixer for the staff. If no override has been set,
an empty string isreturned (read only).

Small True if the staff issmall (such as an ossia staff), False if it isnormal sized (read/write).

StaffNum Returnsthe number of this stave, counting from 1 at the top of the currently-viewed part. Returns 0 for SystemStaff ob-
jects (read only).

Volume The overal MIDI volume of this staff, corresponding to its fader in the Mixer. Permissible values are 0-127 (read/write).

Syllabifier

Acts as awrapper around Sibelius’ sinterna Syllabification engine, exposing its functionality to ManuScript.

Methods

AbbreviateUsingApostrophe(useApostrophe) When the abbreviate flag is set to True when calling Syllabify, Sibelius will re-
place vowels that have been combined with the previous syllable with an apostrophe if this option is switched on—for example
Vege-ta-bles vs \eg' -ta-bles. Calling this method will cause the syllabification engine to recalculate its result if necessary.

GetNthSyl lable(n) Onceastring has been syllabified by calling the Sy 1 1abi fy method, you can use this method to return each
individua syllable as astring
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NthSyllableEndsWord(n) Onceastring has been syllabified by calling the Sy 1 labify method, you can use this method to find
out whether each syllable occurs at the end of aword

Syllabify(textToSyllabify[, language], abbreviate = False]]) Breaks a string down into its syllabic components, returning the
number of syllablesin the resultant syllabification, or O if an error has occurred. The rules of the specified language will be used, and
you may legally supply either alanguage 1D, or the localized language name. To get the individual syllables, you should call the Get-
NthSyllable and NthSyl lableEndsWord methods documented below.

If the language argument is omitted, Sibelius will attempt to automatically identify the language of the text. If thisis not possible, or
if an unrecognised language ID or name has been supplied, 0 will be returned.

When abbreviate is True, each ambiguous word in the string will be syllabified using the minimal number of syllables. For exam-
ple, syllabifying “ Everybody likes vegetables’ would return “Eve-ry-bod-y likes vege-ta-bles’ with this flag set to True, otherwise
“E-ve-ry-bod-y likes veg-e-ta-bles’.

Variables

AbbreviateUsingApostrophe ReturnsTrue/False depending onwhether the syllabification engineis set to abbreviate combined
syllables with an apostrophe (read only — call method with same name for write access)

AvailableLanguagelds Returnsanarray containingalist of theavailable syllabification languages asthree-letter non-translatable
IDs—such as ENG (English), GER (German), LAT (Latin). These IDs areidentical in al localized versions of Sibelius (read only)

AvailablelLanguages Returnsan array containing alist of the available syllabification languages as localized strings (read only)

NumberOfSyllables Returnsthe number of syllablesin the hyphenated string generated by calling the Sy 1 1ab i fy method (read
only)

SyllabifiedString Returnsthe resultant hyphenated string generated by calling the Syl 1abi fy method (read only)

Symbolltem and SystemSymbolltem

Derived from aBarObject. For system symbols (such as symbols belonging to the system staff, retrieved with for each on the
SystemStaff object), the type of symbol objectsis SystemSymbol 1tem, not Symbol I'tem.

Methods

None.

Variables

Index Theindex of thissymbol inthelist of symbols. This correspondsto its position in the Create > Symbol dialog, counting from
zero left-to-right and top-to-bottom (read only).

Name The name of this symbol. May be translated in non-English language versions of Sibelius (read only).

Size Thedraw size of the symbol, corresponding to the four available options in the Symbols dialog in Sibelius. The four available
valuesare NormalSize, CueSize, GraceNoteSize and CueGraceNoteSize, al defined as global constants (read/write).

SystemObjectPositions

Accessed from aScore object. Corresponds to the settings in House Style > System Object Positions.

Methods

GetNthStaffShowsSystemObjects(staffNum) Returns True if the given staff number staffNum (relative to the current part) is
showing system objects above it, otherwise False.
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SetNthStaffShowsSystemObjects(staffNum, show) Tellsthestaff withthegiven staff number staffNum (relativeto the current
part) either to show or not show system objectsaboveit. Thiswill have no effect if you passin thetop staff in the part, or if the maximum
number of staves allowed to show system objects has aready been met.

Clear ([removeBel owBottomSaff]) Allowsyou to clear al the system object positions (apart from the compul sory one above the top
staff) in asingle operation; set the optional Boolean parameter removeBel owBottomSaff to True to also clear the Below bottom staff
system object position.

Variables

NumStavesShowingSystemObjects Returnsthe current number of staves showing system object positions (read only)

ShowSystemObjectsBelowBottomStaff ReturnsTrue if system objectsshould show below the bottom staff, otherwise Fal se
(read/write).

SystemStaff, Staff, Selection, Bar and, all BarObject-derived Objects

Variables

IsALine Returnstrueif the object isaline object. (Note that thisisavariable, not amethod, unlike the 1sOb ject(Q) method for al
objects.)

Type A string giving the name of the type of an object. The stringsfor thefirst 4 types above are **SystemStave™, 'Stave™, ""Mu-
sicSelectionList", and "'Bar". Note that this variable is a'so amember of al objects that occur in bars.

SystemStaff

Thereisone SystemStaff object per score. The SystemStaff contains objects which apply to all staves, such as Specia Barlines
and text using asystem text style. Unlike normal staves, the SystemStaff doesnot appear in the scoreitself. Assuch, most of the vari-
ables and methods supported for Staff objectsare not available on a SystemStaff. Thosethat are supported by SystemStaff are
asfollows.

Methods
CurrentKeySignature(bar number) ReturnsaKeySignature valid at the bar number passed.

CurrentTimeSignature(bar number) ReturnsaTimeSignature valid at the bar number passed.
NthBar (n) Returns the nth bar in the staff, counting from 1.

SystemStaff[array element] Returnsthe nth bar (counting from 1) for example SystemStaff[1].

Variables
BarCount Number of barsin the staff (read only).

InitialKeySignature Returnsthe KeySignature object at the start of this staff (read only).

IsSystemStaff Returns True for a SystemStaff (read only).

Text and SystemTextltem

Derived from aBarObject. For system text (such as text belonging to the system staff, retrieved with for each on the System-
Staff object), the type of text objectsis SystemTextltem, not Text.

Methods

None.
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Variables

JumpAtEndOfBar ReturnsTrue if the system text object has Jump at bar end (in the Playback panel of the Inspector) set, otherwise
False. Alwaysreturns Fal se for staff text objects (read/write).

StyleAsText Thetext style name (read/write).
Styleld Theidentifier of the text style of this piece of text (read/write).
Text Thetext asastring (read/write).

TextWithFormatting Returns an array containing the various changes of font or style (if any) within the string in a new element
(read only). For example, “This text is \B\bold\b\, and this is \I\italic\i\” would return an array with eight elements containing the fol-

lowing data:
arr[0] = “This text is “
arr[1] = “\B\”
arr[2] = “bold”
arr[3] = “\b\”
arr[4] = *“, and this is “
arr[5] = “\I\”
arr[6] = “italic”
arr[7] = “\i\”

TextWithFormattingAsString Thetext including any changes of font or style (read only).

TimeSignature

Derived from aBarObject.

Methods

None.

Variables

AllowCautionary ReturnsTrue if the time signature is set to show a cautionary at the end of the previous system, if it occurs at
the start of a system (read/write).

Denominator Thetime signature's bottom number (read only).
Numerator Thetime signature'stop number (read only).

Text Thetime signature astext. Y ou can use thisto detect common time and alla breve time signatures by comparing it to the global
constants CommonT imeString and Al laBreveTimeString, which define the Unicode characters used by these symbols. Other
time signatures will be of the form “4\n4” (read only).

TreeNode

These are used internally by ManuScript to implement arrays and hashes (returned with the CreateArray and CreateHash meth-
ods), and to represent global data (defined in the plug-in editor). Each TreeNode can contain alabel, a piece of dataand alist of “chil-
dren,” which areaso TreeNodes. Normally, any accessto aTreeNode object will accessthe datathat is held, so that you don’t need
to know anything about them, but there are al so some extra variables and methods that may be useful in some circumstances. These can
be called on any array, hash or global variable, and on any member of such a structure.

Methods

WriteToString Returnsastring that represents the structure of this TreeNode object. In this representation, the data of a Tree-
Node is surrounded by double quotes and the label is not. Note that alabel need not be defined. Any children of the TreeNode (also
TreeNode objectsthemselves) are contained within curly braces { and }. To obtain child TreeNodes, use the normal array operator,
as described in the documentation for arrays and hashes.
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Variables
Label Thelabel of this TreeNode.

NumChildren The number of child TreeNodes belonging to this TreeNode object.

Tuplet

Derived from aBarObject.

Methods

AddNestedTuplet(posinTuplet, left, right, unit[, style], bracket[,fullDuration]]]]) Nests anew tuplet bracket within an exist-
ing tuplet at a position relative to the duration and scale-factor of the existing tuplet. The left and right parameters specify the ratio of
the new tuplet, for example 3 (Ieft) in the time of 2 (right). The unit parameter specifies the note value (in 1/256th quarters) on which
the tuplet should be based. For example, if you wish to create an eighth note (quaver) triplet group, you would use the value 128. The
optional style and bracket parameters take one of the pre-defined constants that affect the visual appearance of the created tuplet; see
Global Constants. If full Duration istrue, the bracket of the tuplet will span the entire duration of the tuplet. Returnsthe Tup let object
created.

Q If AddNestedTuplet() has been givenillegal parameters, it will not be ableto createa valid Tuplet object. Therefore, you should
test for inequality of the returned Tuplet object with null before attempting to useiit.

AddNote(posinTuplet, pitch, duration[, tied[, diatonic pitch[, string number]]]]) Adds anoteto an existing tuplet, adopting the
same voice number as used by the tuplet itself. Please note that posinTuplet is relative to the duration and scale-factor of the tuplet
bracket itself. Therefore, if you wanted to add aquarter note/crotchet to the second beat of aquarter note/crotchet triplet, you would sim-
ply use the value 256, not 341!

utils.SplitTuplet(tuplet,splitpoint) Split the Tuplet object tuplet at the specified splitpoint, which isanumber in relation to
the tuplet’s parent bar. It then splits a nest of tuplets at that point in the bar. This method is provided by the utils.plg—see Utils.

Variables

Bracket The bracket type of the tuplet (such as. none, auto; see Global Constants).
FullDuration Trueif the bracket of the tuplet spansits entire duration.
Left Theleft side of the tuplet, for example 3in 3:2 (read only).

ParentTupletlfAny If thetuplet intersectsatuplet, theinnermost Tup let object at that point in the score is returned. Otherwise,
null isreturned (read only).

PlayedDuration Thetruerhythmic duration of the tuplet, for example for quarter-note (crotchet) triplet this would be the duration
of aminim (read only).

PositionInTuplet Returnsthe position of the tuplet relative to the duration and scale-factor of its parent tuplet. If the tuplet does
not intersect atuplet, its position within the parent Bar is returned as usua (read only).

Right Theright side of the tuplet, for example 2 in 3:2 (read only).
Style Thestyle of the tuplet (for example, number, ratio, ratio + note; see Global Constants).
Text The text shown above the tuplet (read only).

Unit Theunit used for the tuplet, for example 256 for atriplet of quarter notes (read only).

Utils

Sibeliusinstalls a plug-in called utils.plg that contains a set of useful and common methods that can be called
directly by other plug-ins. It is not intended to be run as a plug-in in its own right, so does not appear in the Plug-ins menu.
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Methods
The methods available via utils.plg are as follows:
utils._AbsoluteValue(value) Returnsthe absolute value of a number, that isits numerical value without regard to its sign.

utils.AddFractions(x,Yy) Addstwo fractions x and y, passed in as ManuScript arrays. Returns an array with the result of the ad-
dition.

utils._BinaryString(x) Returnsabinary string (such as“101010") equivalent to the number x.

utils.bwAND(x, y) Equivalent to the C++ bitwise AND (&) operator. For example, utils_.bwAND(129,1) isequal to 1.
utils_.bwOR(x, y) Equivaent to the C++ bitwise inclusive OR (]) operator. For example, utils.bwOR(64,4) isequal to 68.
utils.bwXOR(x, y) Equivalent to the C++ bitwise exclusive XOR (") operator. For example, utils.bwXOR(4,6) isequd to 2.

utils.CapableOfDeletion() ReturnsTrue if the object can be deleted using Delete (), which is determined by checking Si-
belius' s version number.

utils.CaselnsensitiveComparison(sl, s2) Returns True if the two strings sl and s2 match, ignoring case.
utils.CastToBool (x) Returnsthe variable x explicitly cast as a Boolean.

utils.CastTolnt(x) Returnsthe variable x explicitly cast as an integer.

utils._CastToStr(x) Returnsthe variable x explicitly cast as a string.

utils.CombineArraysOfBool (arrl, arr2) Concatenates two arrays containing Boolean values and returns the resullt.
utils.CombineArraysOfint(arrl, arr2) Concatenates two arrays containing integral values and returns the result.
utils.CombineArraysOfString(arrl, arr2) Concatenates two arrays containing string values and returns the result.
utils.CopyTextFile(source, dest) Copiesan existing text file from one location to another, returning True if successful.

utils.CreateArrayBlanket(value, size) Returnsan array with size elements, each containing a blanket val ue specified by the
first parameter.

utils._DeleteStaff(score, nth staff, retain selection) Deletesan entire staff and its content from agiven score, returning True if
successful. If retain selection is True, Sibeliuswill ensure any item(s) that were selected prior to the staff’s deletion are still selected.

utils.DenaryValue(x) Returnsanumber in base 10 equivalent to binary number x, which must be provided as a string.

utils.DivideFractions(x,Yy) Dividesfraction x by fraction y, passed in as ManuScript arrays. Returns an array with the result
of the division.

utils._ExtractFileName (filename) Returnsjust the filename portion of a string filename containing both a path and a filename.

utils._Format(str, [vall,val2,val3...]) Provides asimple means of replacing human-readable datatypesin astring. Each succes-
siveinstance of %s in str is replaced with the value of the next remaining unused argument. for examples = utils.Format(*'The
%s brown %s jumps %s the lazy %s', 'quick', "fox", "over", "dog");

utils.FormatTime(ms) Formats atime, given in milliseconds, to a human-readable string using the format mm’ss.z (where z is
centiseconds).

utils._FractionAsDecimal (xX) Returnsthe decimal equivaent of the fraction x, which is passed in as an array.
utils._FractionDenominator (x) Returnsthe denominator of fraction x, which is passed in as an array.
utils._FractionNumerator(x) Returnsthe numerator of fraction x, which is passed in as an array.
utils._.GetAppDir() Returnsthe path of the Sibelius executable as a string.

utils._GetArraylndex(arr, value) Returnstheindex of valuein the array arr, or -1 if it doesn’t exist in the array.
utils.GetBits(x) Returnsan array containing the list of powers of two whose cumulative sum equates to the value of x.

utils.GetGlobalApplicationDataDir() Returnsthe path of the system’s global application data area as a string.
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utils.GetLocationTime(score, barNum, position) Returnsthe precisetime (in milliseconds) of a given location in ascore. The
position should be local to the start of the bar number you have supplied. Usethe utilslibrary to achieve thisif your plug-in needsto be
backwards compatible with Sibelius 4; otherwise call the Score object’ s function with the same name.

utils.GetMillisecondsFromTime(time) If you passin atime expressed in milliseconds (one minute being 60,000), this func-
tion returns the milliseconds portion of the number (in this case 60,000 modulus 1000 = 0).

utils._GetMinutesFromTime(time) If you passin atime expressed in milliseconds, this function returns the minutes portion of
the number (for exampleif time = 120,262 milliseconds, this function returns 2).

utils.GetObjectTime(score,obj) Returnsthe precise time (in milliseconds) that the object obj occurs from the start of agiven
score, taking into account tempo changes, performance markings and any other eventsin the score that have an effect on playback. Use
this method to achieve thisif your plug-in needs to be backwards compatible with Sibelius 4; otherwise use the Time property of the
BarObject object whose time you wish to determine.

utils.GetPluginld(plug-in) Thisenablesyou to identify a plug-in by entering the line of code PluginUniquelD =
“*someUniqueld™; inaplug-in’s Initial ize method. When you pass a P lugin object to this function, it scans the plug-in’s code
and returnsits unique ID if it has one, otherwise an empty string.

utils.GetSibeliusPluginsFolder() Thisisawrapper around the deprecated GetP luginsFolder () function, and returns
the path of the Plugins folder.

utils.GetSibMajorVersion() Returnsthe major version number of Sibelius.

utils.GreatestCommonDivisor(m,n) Returnsthegreatest common divisor of two non-zero integers, that isthelargest positive
integer that divides both numbers without remainder.

utils.IslnArray(arr, value) Returns True if value existsin the array arr.

utils.IsNumeric(str[, integer only]) Returns True if the string str is numeric. Set the optional Boolean parameter integer only
to True if you want the method to only return True if str isan integer (so that you can disallow floating point numbers).

utils.LowerCase(str) Returnsthe ANSI string str in lowercase.

utils._MakeFraction(X,Yy) Createsafraction with x as the numerator and y as the denominator. The fraction is returned as anor-
mal ManuScript array. (Manipulating fractions means you never have to worry about rounding errors.)

utils.max(x,Yy) Returnsthe greater of two numbers.
utils._min(X,y) Returnsthe lesser of two numbers.

utils.MultiplyFractions(x,y) Multipliesfractiony by fraction x, passed in as ManuScript arrays. Returnsan array with there-
sult of the multiplication.

utils._PatternCount(pattern,str) Returnsthe number of times the substring pattern existsin str.
utils._Pos(subStr,str) Returns the zero-based position of the first instance of the sub-string subSr in str, or -1 if it isn’t found.

utils.PosReverse(subSr, str) Returns the zero-based position of the last instance of the sub-string subStr in str, or -1 if itisn't
found.

utils_RaisePower(Xx,Y) Raisesx to the yth power, wherey is a positive integer.

utils_Replace(ingr,toFind, replaceWth, replaceAll) Replacesasub-stringinastring with anew value. It looksfor toFind in the
string inSr, and if it findsit, replaces it with replaceWth. If the Boolean replaceAll is Fal se, it only changes thefirst instance found,;
if it'sTrue, it replaces al instances.

utils.ReverseArrayOfBool (arr) Reversesthe order of the elementsin an array of Booleans.
utils.ReverseArrayOfint(arr) Reversesthe order of the elementsin an array of integers.
utils._ReverseArrayOfString(arr) Reversesthe order of the elementsin an array of strings.

utils.RoundToNDecimalPlaces(humber, precision) Returns astring containing the number rounded to precision decimal
places. The method handlesthe input asastring, in order to avoid rounding errors which would otherwise spoil results beyond the tenth
decimal place or so.
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utils_SetDefaultlfNotInArray(value, arr, Defaultindex) Scansthe array arr for the value specified by the first parameter.
Vaueisreturned if it existsin the array, otherwise, arr [Defaultindex].

utils.shl(x,y) Bitwise left-shift. Shiftsthe value x left by y bits. Equivalent to C++ << operator.
utils.shr(x,y) Bitwiseright-shift. Shifts the value x right by y bits. Equivalent to C++ >> operator.

utils.SortArray(arr,show progress) Sortsthe array arr using a case-insensitive a phabetic sort. Set show progressto True to
see aprogress bar while the sort is carried out, or set it to Fal se if you don’t want to see a progress bar.

utils.SortArrayCustom(arr,show progress, plug-in name, method) Sortsthe array arr using a custom sort order routine
method, which must be passed into this method. plug-in nameisthe name of the plug-in that containsthe sort order routine method. Y ou
can write your own sort order routine: it must be amethod that takes two strings (strA and strB) and returns 1 or O based on the results
of the comparison.

utils._SortArrayNumeric(arr,show progress) Sortsthearray arr in ascending numeric order. Set show progressto True to see
aprogress bar while the sort is carried out, or set it to Fal se if you don’t want to see a progress bar.

utils.SplitTuplet(tuplet, splitpoint) Split the Tuplet object tuplet at the specified splitpoint, which isanumber in relation to
the tuplet’s parent bar. It then splits a nest of tuplets at that point in the bar.

utils.StartComponentManager (componentName, callbackFunc) Returnsan array of filenames (strings) found on the system
inside afolder with a given name, following the same rules of precedence as Sibelius'sinternal component manager. Filesin the user’s
application data areatake priority over thosein the global application data area, followed lastly by thosein the Sibelius's application di-
rectory itself.

callbackFunc should point to afunction in the calling script that scans a supplied directory for files with a specific extension.

Such afunction might look something like this:
GetFooFiles(dir) { // This is the function signature
components = CreateArray();
for each FOO file in dir {
components[components._NumChildren] = file.NameWithExt;

}

return(components);

}

In the scenario above, the call to start the component manager would look like this (where “Foo Files” isthe name of the directory con-
taining your files):

files = utils.StartComponentManager(*'Foo Files",

"myPlugin.GetFooFiles™);

utils.SubtractFractions(x,Yy) Subtractsfractiony from fraction x, passed in as ManuScript arrays. Returns an array with the
result of the subtraction.

utils._UpperCase(str) Returnsthe ANSI string str in uppercase.

VersionHistory

Each Score object hasaVersionHistory object (obtained by way of the score. GetVersions() method), whichinturn provides
alist of Version objects. Each Version object represents a specific version, and also provides alist of VersionComment objects,
which represent the per-version comments (as opposed to bar-attached comments, which are represented to ManuScript as Comment

objects, derived from BarOb ject objects).

Methods

AddVersion([nameg[ ,comment]]) Addsanew Version object and returnsit if successful (or null if not), with an optional name and
comment for the version.

DeleteNthVersion(n) Deletesthe nth Version object, returning True if successful.

GetNthVersion(n) Returnsthe nth Version object.
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Variables

NumChi ldren Returnsthe number of versionsin the score’s VersionHistory object.

Version

Accessed viaa Score object’sVersionHistory object.

Methods
AddComment(text) Addsanew comment with the specified text, and returns the VersionComment object created.

Close() Closesal views of the version that are currently open in Sibelius, returning True if it has actually closed anything.
GetNthComment(n) Getsthe nth comment as aVersionComment object, or returns null if the index is out of range.
DeleteNthComment(n) Deletes the nth comment, returning True if successful, or null if the index is out of range.

OpenAndReturnScore() Opensthe specified version in Sibelius (if it’s not already open) and returnsits Score object.

Variables

EndDate ReturnsaDateTime object representing the version’send date (read only). 1sOpen returns True if theversionis currently
open in Sibelius (read only).

Name Returnsthe name of the version (read/write).
NumComments Returnsthe number of commentsin the version (read only).

StartDate ReturnsaDateTime object representing the version’s start date (read only).

VersionComment

Accessed viaVersion objects.

Methods

None.

Variables

Text Returns or changes the text of the comment, and this cannot be undone (read/write).
TimeStamp ReturnsaDateT ime object representing the time at which the comment was created.

UserName Returns the name of the user who created the comment (read only).
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Global Constants

Global Constants

These are useful variables held internally within ManuScript and are accessible from any plug-in. They are called “ constants” be-
cause you are encouraged not to change them.

Many of the constants are the names of note values, which you can useto specify apositionin abar. For example, instead of writing
320 you can write Quarter+Sixteenth or equally Crotchet+Semiquaver.

Truth Values

True 1

False 0
Measurements

Space 32

StaffHeight 128

Positions and Durations

Long 4096
Breve 2048
DottedBreve 3072
Whole or Semibreve 1024
DottedWhole 1536
Half or Minim 512
DottedHalf or DottedMinim 768
Quarter or Crotchet 256
DottedQuarter or DottedCrotchet 384
Eighth or Quaver 128
DottedEighth or DottedQuaver 192
Sixteenth or Semiquaver 64
DottedSixteenth or DottedSemiquaver 96
ThirtySecond or Demisemiquaver 32
DottedThirtySecond or DottedDemisemiquaver 48
SixtyFourth or Hemidemisemiquaver 16
DottedSixtyFourth or DottedHemidemisemiquaver 24
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OneHundredTwentyEighth or Semihemidemisemiquaver

DottedOneHundredTwentyEighth or DottedSemihemidemisemiquaver

12

Style Names

For the ApplyStyle() method of Score objects. Instead of the capitalized strings in quotes, you can use the equivaent variables
in mixed upper and lower case. Note again that the constant HOUSE refers to the options in House Style > Engraving Rules and
Layout > Document Setup only; to apply the entire House Style, use the ALLSTYLES constant.

House “HOUSFE” Dictionary “DICTIONARY”
Text “TEXT” SpacingRule “SPACINGRULE”"
Symbols “SYMBOLS” CustomChordNames “CUSTOMCHORDNAMES”
Lines “LINES” DefaultPartAppearance “DEFAULTPARTAPPEARANCE”"
Noteheads “NOTEHEADS” InstrumentsAndEnsembles “INSTRUMENTSANDENSEMBLES”
Clefs “CLEFS” AllStyles “ALLSTYLES”

Bar Number Formats

These constants can be used for the format argument of the AddBarNumber method.

BarNumberFormatNormal 0

BarNumberFormatNumberLetterLower 1

BarNumberFormatNumberLetterUpper 2
Text Styles

Hereisalist of al the text style identifiers which are guaranteed to be present in any scorein Sibelius. In previous versions of Manu-
Script text styles were identified by a numeric index; this usage has been deprecated but will continue to work for old plug-ins. New

plug-ins should use the identifiers given below. For each style we first give the English name of the style and then the identifier.

Instrument “text.instrumentname” Time signatures “text.staff.timesig.onestaffonly”
names (one staff only)
1st and 2nd “text.staff.1st_n_2nd_endings” “text.staff.tuplets”
. Tuplets
endings
Auto page “text.staff.autopagebreak.warnings” “text.system.barnumber”
break Bar numbers
warnings
Boxed text “text.staff.boxed” Metronome mark “text.system.metronome”
. “text.staff.expression” Multirests “text.system.multirestnumbers”
Expression
(numbers)
Chord “text.staff.fingering.chord_diagrams” “text.system.page_aligned.composer”
diagram Composer
fingering
Footnote “text.staff.footnote” Composer “text.system.page_aligned.composer.ontitlepage”
(on title page)
Block lyrics “text.staff.lyrics.block” Copyright “text.system.page_aligned.copyright”
Multirests “text.staff. multirests.tacet” . “text.system.page_aligned.dedication”
(tacet) Dedication
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“text.staff.plain”

Footer (inside

“text.system.page_aligned.footer.inside”

Plain text edge)

Small text text.staff.small Footgr text.system.page_aligned.footer.outside
(outside edge)

Chord “text.staff.space.chordsymbol” Worksheet “text.system.page_aligned.footer.worksheet.left”

symbol footer

y (first page, 1)

Figured “text.staff.space.figuredbass” “text.system.page_aligned.header”
Header

bass

“text.staff.space.fingering” Worksheet “text.system.page_aligned.header.worksheet.left”

Fingering header
(first page, 1)

Chord “text.staff.space.frethumbers” Worksheet “text.system.page_aligned.header.worksheet.right”
header

diagram fret

(first page, r)

Lyricsabove
staff

“text.staff.space.hypen.lyrics.above”

Header
(after first page)

“text.system.page_aligned.header_notpl”

. “text.staff.space.hypen.lyrics.chorus” Header “text.system.page_aligned.header_notpl.inside”
Lyrics ;
(after first page,
(chorus) S
inside edge)
Lyrics line 1 “text.staff.space.hypen.lyrics.versel” Instrument name “text.system.page_aligned.instrnametopleft”
y at top left
Lyrics line 2 “text.staff.space.hypen.lyrics.verse2” Lyricist “text.system.page_aligned.lyricist”
Lyrics line 3 “text.staff.space.hypen.lyrics.verse3” Page numbers “text.system.page_aligned.pagenumber”
Lyrics line 4 “text.staff.space.hypen.lyrics.verse4” Subtitle “text.system.page_aligned.subtitle”
Lyrics line 5 “text.staff.space.hypen.lyrics.verse5” Title “text.system.page_aligned.title”
Nashville “text.staff.space.nashvillechords” Title “text.system.page_aligned.title.ontitlepage”
chord (on title page)
numbers pag
Common “text.staff.symbol.common” “text.system.rehearsalmarks”
Rehearsal mark
symbols
Figured “text.staff.symbol.figured.bass.extras” “text.system.repeat”
bagss 4 9 Repeat (D.C./ y P
D.S./To Coda)
(extras)
Note tails “text.staff.symbol.noteflags” Tempo “text.system.tempo”
Special “text.staff.symbol.noteheads.special” . “text.system.timecode”
Timecode
noteheads
Percussion “text.staff.symbol.percussion” Duration at end “text.system.timecode.duration”
instruments of score
Special “text.staff.symbol.special” . . “text.system.timecode.hitpoints”
P 4 P Hit points y P
symbols
Tablature “text.staff.tab.letters” Time signatures “text.system.timesig.huge”
letters (huge)
Tablature “text.staff.tab.numbers” Time signatures “text.system.timesig.large”
numbers (large)
Technique “text.staff.technique” Time signatures “text.system.timesig.normal”
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Line Styles

Arpeggio

“line.staff.arpeggio”

Bracketed slur
below

“line.staff.slur.down.bracketed”

Arpeggio down

“line.staff.arpeggio.down”

Dashed slur below

“line.staff.slur.down.dashed”

Arpeggio up “line.staff.arpeggio.up” Dotted slur below “line.staff.slur.down.dotted”
Unused 2 “line.staff.arrow” Slur above “line.staff.slur.up”
Arrow “line.staff.arrow.black.right” Bracketed slur “line.staff.slur.up.bracketed”

above

Dashed arrow

“line.staff.arrow.black.right.dashed”

Dashed slur above

“line.staff.slur.up.dashed”

Double arrow

“line.staff.arrow.black.right.left”

Dotted slur above

“line.staff.slur.up.dotted”

Vertical arrow (2)

“line.staff.arrow.black.vertical”

String indicator
above (1)

“line.staff.string.above.1”

White arrow

“line.staff.arrow.white.right”

String indicator
above (2)

“line.staff.string.above.2”

Dashed white
arrow

“line.staff.arrow.white.right.dashed”

String indicator
above (3)

“line.staff.string.above.3”

Double white
arrow

“line.staff.arrow.white.right.left”

String indicator
above (4)

“line.staff.string.above.4”

Vertical arrow

“line.staff.arrow.white.vertical”

String indicator

“line.staff.string.above.5”

above (5)
“line.staff.oeam” String indicator “line.staff.string.above.6”
Beam
above (6)
Guitar Bend line.staff.bend String indicator line.staff.string.above.7

above (7)

Guitar hold bend

“line.staff.bend.hold”

String indicator
above (8)

“line.staff.string.above.8”

Box

“line.staff.box”

String indicator
below (1)

“line.staff.string.below.1”

Bracket above

“line.staff.bracket.above”

String indicator
below (2)

“line.staff.string.below.2”

Bracket above
(end)

“line.staff.bracket.above.end”

String indicator
below (3)

“line.staff.string.below.3”

Bracket above
(start)

“line.staff.bracket.above.start”

String indicator
below (4)

“line.staff.string.below.4”

Bracket below

“line.staff.bracket.below”

String indicator
below (5)

“line.staff.string.below.5”

Bracket below
(end)

“line.staff.bracket.below.end”

String indicator
below (6)

“line.staff.string.below.6”

Bracket below
(start)

“line.staff.bracket.below.start”

String indicator
below (7)

“line.staff.string.below.7”

Vertical bracket

“line.staff.bracket.vertical”

String indicator

“line.staff.string.below.8”

below (8)
Vertical bracket 2 “line.staff.bracket.vertical.2” Tie “line.staff.tie”
Dashed line “line.staff.dashed” Trill “line.staff.trill”
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Vertical dashed

“line.staff.dashed.vertical”

“line.staff.tuplet”

line Tuplet

Dotted line “line.staff.dotted” Vertical line “line.staff.vertical”
Gllss_ando line.staff.gliss.straight Vibrato line.staff.vibrato
(straight)

Glissando (wavy)

“line.staff.gliss.wavy”

Guitar vibrato bar

“line.staff.vibrato.bar”

Guitar effect

“line.staff.guitareffect”

Wide vibrato

“line.staff.vibrato.wide”

Crescendo “line.staff.hairpin.crescendo” Dashed system line “line.system.dashed”
Bracketed “line.staff.hairpin.crescendo.bracketed” Wide dashed “line.system.dashed.wide”
crescendo system line

Dashed crescendo “line.staff.hairpin.crescendo.dashed” 1st ending “line.system.repeat.1st”

Dotted crescendo

“line.staff.hairpin.crescendo.dotted”

1st and 2nd ending

“line.system.repeat.1st_n_2nd”

Crescendo from
silence

“line.staff.hairpin.crescendo.fromsilence

2nd ending

“line.system.repeat.2nd”

Diminuendo “line.staff.hairpin.diminuendo” 2nd ending (closed) | ‘“line.system.repeat.2nd.closed”
Bracketed “line.staff.hairpin.diminuendo.bracketed” . “line.system.repeat.3rd”
A 3rd ending
diminuendo
Dashed “line.staff.hairpin.diminuendo.dashed” Repeat ending “line.system.repeat.closed”
diminuendo (closed)
Dotted “line.staff.hairpin.diminuendo.dotted” Repeat ending “line.system.repeat.open”
diminuendo (open)
Diminuendo to “line.staff.hairpin.diminuendo.tosilence” Accel “line.system.tempo.accel”
silence '
Guitar artificial “line.staff.harmonic.artificial” Accel. “line.system.tempo.accel.italic”
harmonic (italic)
Guitar harp “line.staff.harmonic.harp” Accel. “line.system.tempo.accel.italic.textonly”
harmonic (italic, text only)
Guitar pinch “line.staff.harmonic.pinch” “line.system.tempo.accel.molto”
; Molto accel.
harmonic
Guitar touch “line.staff.harmonic.touch” Molto accel. “line.system.tempo.accel.molto.textonly”
harmonic (text only)
Guitar harmonics “line.staff.harmonics” Poco accel. “line.system.tempo.accel.poco”
. “line.staff.hauptstimme” Poco accel. “line.system.tempo.accel.poco.textonly”
Hauptstimme P y P P y
(text only)

Guitar let ring

“line.staff.letring”

Accel. (text only)

“line.system.tempo.accel.textonly”

Lyric line

“line.staff.lyric”

Tempo change
(arrow right)

“line.system.tempo.arrowright”

Guitar palm mute “line.staff.mute.palm” Rall. “line.system.tempo.rall”
Nebenstimme “line.staff.nebenstimme” Rall. (italic) “line.system.tempo.rall.italic”
“line.staff.octava.minus15” Rall. “line.system.tempo.rall.italic.textonly”

2 octaves down

(italic, text only)

Octave down “line.staff.octava.minus8” Molto rall. “line.system.tempo.rall.molto”
“line.staff.octava.plus15” Molto rall. “line.system.tempo.rall.molto.textonly”
2 octaves up
(text only)
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Octave up “line.staff.octava.plus8” Poco rall. “line.system.tempo.rall.poco”
Pedal “line.staff.pedal” Poco rall. (text only) “line.system.tempo.rall.poco.textonly”
Pedal lift “line.staff.pedal.lift” Rall. (text only) “line.system.tempo.rall.textonly”

Pedal lift again

“line.staff.pedal.lift.again”

Rit.

“line.system.tempo.rit”

Pedal lift finally

“line.staff.pedal.lift.finally”

Rit. (italic)

“line.system.tempo.rit.italic”

Pedal (no line)

“line.staff.pedal.noline”

Rit. (italic, text only)

“line.system.tempo.rit.italic.textonly”

Guitar pick scrape

“line.staff.pick.scrape”

Molto rit.

“line.system.tempo.rit.molto”

Line “line.staff.plain” Molto rit. (text only) “line.system.tempo.rit.molto.textonly”
Portamento “line.staff.port.straight” Poco rit. “line.system.tempo.rit.poco”

Guitar rake “line.staff.rake” Poco rit. (text only) “line.system.tempo.rit.poco.textonly”
Guitar slide “line.staff.slide” Rit. (text only) “line.system.tempo.rit.textonly”

Slur below “line.staff.slur.down”

Clef Styles

Hereisalist of al the clef styleidentifiersthat are guaranteed to be present in any scorein Sibelius, for use with the Stave . AddClef

method. For each style we first give the English name of the style, and then the identifier.

Alto “clef.alto” Small tab “clef.tab.small”
Baritone C “clef.baritone.c” Small tab (taller) “clef.tab.small.taller”
Baritone F “clef.baritone.f” Tab (taller) “clef.tab.taller”
Bass “clef.bass” Tenor “clef.tenor”

Bass down 8

“clef.bass.down.8”

Tenor down 8

“clef.tenor.down.8”

Bass up 15 “clef.bass.up.15” Treble “clef.treble”

Bass up 8 “clef.bass.up.8” Treble down 8 “clef.treble.down.8”

Null “clef.null” Treble (down 8) “clef.treble.down.8.bracketed”
Percussion “clef.percussion” Treble down 8 (old) “clef.treble.down.8.old”
Percussion 2 “clef.percussion_2" Treble up 15 “clef.treble.up.15”

Soprano “clef.soprano” Trebleup 8 “clef.treble.up.8”

Mezzo-soprano

“clef.soprano.mezzo”

French violin

“clef.violin.french”

Tab

“clef.tab”

Sub-bass F

“clef.sub-bass.f”

Instrument Types

Hereisalist of al the instrument type identifiers that are guaranteed to be present in any scorein Sibelius. For each style we first give
the English name of the style and then the identifier. Note that only the tablature stave types can be used with guitar frames; the rest are
included for compl eteness.

Alp-Horn in F instrument.brass.alp-horn.f

Alp-Horn in G instrument.brass.alp-horn.g

Baritone Bugle in G instrument.brass.bugle.baritone.g

Contrabass Bugle in G instrument.brass.bugle.contrabass.g
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Euphonium Bugle in G

instrument.brass.bugle.euphonium.g

Mellophone Bugle in G

instrument.brass.bugle.mellophone.g

Soprano Buglein G

instrument.brass.bugle.soprano.g

Cimbasso in Bb

instrument.brass.cimbasso.bflat

Cimbasso in Eb

instrument.brass.cimbasso.eflat

Cimbasso in F

instrument.brass.cimbasso.f

Cornetin A

instrument.brass.cornet.a

Cornet in Bb

instrument.brass.cornet.bflat

Soprano Cornet in Eb

instrument.brass.cornet.soprano.eflat

Euphonium in Bb [treble clef]

instrument.brass.euphonium

Euphonium in Bb [bass clef, treble transp.]

instrument.brass.euphonium.bassclef

Euphonium in C [bass clef]

instrument.brass.euphonium.bassclef.bassclef

Euphonium in Bb [bass clef]

instrument.brass.euphonium.bflat.bassclef.bassclef

Flugelhorn

instrument.brass.flugelhorn

Horn in A [no key]

instrument.brass.horn.a.nokeysig

Horn in Ab alto [no key]

instrument.brass.horn.alto.aflat.nokeysig

Alto Horn in Eb

instrument.brass.horn.alto.eflat

Alto Horn in F

instrument.brass.horn.alto.f

Horn in B [no key]

instrument.brass.horn.b.nokeysig

Baritone in Bb [treble clef]

instrument.brass.horn.baritone

Baritone in C [treble clef]

instrument.brass.horn.baritone.2

Baritone in Bb [bass clef, treble transp.]

instrument.brass.horn.baritone.bassclef

Baritone in C [bass clef]

instrument.brass.horn.baritone.bassclef.bassclef

Bass in Bb

instrument.brass.horn.bass.bflat

Bass in Bb [bass clef, treble transp.]

instrument.brass.horn.bass.bflat.bassclef

Bassin C

instrument.brass.horn.bass.c

Bass in Eb

instrument.brass.horn.bass.eflat

Bass in Eb [bass clef, treble transp.]

instrument.brass.horn.bass.eflat.bassclef

A Basso Horn [no key]

instrument.brass.horn.basso.a.nokeysig

Bb Basso Horn [no key]

instrument.brass.horn.basso.bflat.nokeysig

C Basso Horn [no key]

instrument.brass.horn.basso.c.nokeysig

Horn in Bb [no key]

instrument.brass.horn.bflat.nokeysig

Horn in C [no key]

instrument.brass.horn.c.nokeysig

Horn in D [no key]

instrument.brass.horn.d.nokeysig

Horn in Db [no key]

instrument.brass.horn.dflat.nokeysig

Horn in E [no key]

instrument.brass.horn.e.nokeysig

Horn in Eb

instrument.brass.horn.eflat
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Horn in Eb [no key]

instrument.brass.horn.eflat.nokeysig

Hornin F

instrument.brass.horn.f

Horn in F [bass clef]

instrument.brass.horn.f.bassclef

Horn in F [no key]

instrument.brass.horn.f.nokeysig

Horn in F# [no key]

instrument.brass.horn.fsharp.nokeysig

Horn in G [no key]

instrument.brass.horn.g.nokeysig

Tenor Horn

instrument.brass.horn.tenor

Mellophone in Eb

instrument.brass.mellophone.eflat

Mellophone in F

instrument.brass.mellophone.f

Mellophonium in Eb

instrument.brass.mellophonium.eflat

Mellophonium in F

instrument.brass.mellophonium.f

Ophicleide instrument.brass.ophicleide
Brass instrument.brass.section
Serpent instrument.brass.serpent

Sousaphone in Bb

instrument.brass.sousaphone.bflat

Sousaphone in Eb

instrument.brass.sousaphone.eflat

Trombone

instrument.brass.trombone

Alto Trombone

instrument.brass.trombone.alto

Bass Trombone

instrument.brass.trombone.bass

Trombone in Bb [bass clef, treble transp.]

instrument.brass.trombone.bassclef.trebleclef

Contrabass Trombone

instrument.brass.trombone.contrabass

Tenor Trombone

instrument.brass.trombone.tenor

Trombone in Bb [treble clef]

instrument.brass.trombone.trebleclef

Trumpet in A

instrument.brass.trumpet.a

Trumpet in B [no key]

instrument.brass.trumpet.b.nokeysig

Bass Trumpet in Bb

instrument.brass.trumpet.bass.bflat

Bass Trumpet in Eb

instrument.brass.trumpet.bass.eflat

Trumpet in Bb

instrument.brass.trumpet.bflat

Trumpet in Bb [no key]

instrument.brass.trumpet.bflat.nokeysig

Trumpetin C

instrument.brass.trumpet.c

Trumpet in D

instrument.brass.trumpet.d

Trumpet in Db

instrument.brass.trumpet.dflat

Trumpet in E [no key]

instrument.brass.trumpet.e.nokeysig

Trumpet in Eb

instrument.brass.trumpet.eflat

Trumpet in F

instrument.brass.trumpet.f

Trumpet in G [no key]

instrument.brass.trumpet.g.nokeysig

Piccolo Trumpet in A

instrument.brass.trumpet.piccolo.a
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Piccolo Trumpet in Bb

instrument.brass.trumpet.piccolo.bflat

Tenor Trumpet in Eb

instrument.brass.trumpet.tenor.eflat

Tuba

instrument.brass.tuba

TubainF

instrument.brass.tuba.f

Tenor Tuba (Wagner, in Bb)

instrument.brass.tuba.tenor

Tenor Tuba [bass clef]

instrument.brass.tuba.tenor.bassclef

Wagner Tuba in Bb

instrument.brass.tuba.wagner.bflat

Wagner Tubain F

instrument.brass.tuba.wagner.f

Applause instrument.exotic.applause
Birdsong instrument.exotic.birdsong
Helicopter instrument.exotic.helicopter

Ondes Martenot

instrument.exotic.ondes-martenot

Sampler instrument.exotic.sampler
Seashore instrument.exotic.seashore
Tape instrument.exotic.tape
Telephone instrument.exotic.telephone
Theremin instrument.exotic.theremin

Bajo [notation]

instrument.fretted.bajo.5lines

Bajo, 6-string [tab]

instrument.fretted.bajo.tab

Bajo, 4-string [tab]

instrument.fretted.bajo.tab.4lines

Bajo, 5-string [tab]

instrument.fretted.bajo.tab.5lines

Alto Balalaika [notation]

instrument.fretted.balalaika.alto.5lines

Alto Balalaika [tab]

instrument.fretted.balalaika.alto.tab

Bass Balalaika [notation]

instrument.fretted.balalaika.bass.5lines

Bass Balalaika [tab]

instrument.fretted.balalaika.bass.tab

Contrabass Balalaika [notation]

instrument.fretted.balalaika.contrabass.5lines

Contrabass Balalaika [tab]

instrument.fretted.balalaika.contrabass.tab

Prima Balalaika [notation]

instrument.fretted.balalaika.prima.5lines

Prima Balalaika [tab]

instrument.fretted.balalaika.prima.tab

Second Balalaika [notation]

instrument.fretted.balalaika.second.5lines

Second Balalaika [tab]

instrument.fretted.balalaika.second.tab

Bandola [notation]

instrument.fretted.bandola.5lines

Bandola [tab]

instrument.fretted.bandola.tab

Bandolén [notation]

instrument.fretted.bandolon.5lines

Bandolén [tab]

instrument.fretted.bandolon.tab

Bandurria [notation]

instrument.fretted.bandurria.5lines

Bandurria [tab]

instrument.fretted.bandurria.tab
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Banjo [notation]

instrument.fretted.banjo.5lines

Banjo (aDADE tuning) [tab]

instrument.fretted.banjo.aDADE.tab

Banjo (aEADE tuning) [tab]

instrument.fretted.banjo.aEADE.tab

Banjo (gCGBD tuning) [tab]

instrument.fretted.banjo.gCGBD.tab

Banjo (gCGCD tuning) [tab]

instrument.fretted.banjo.gCGCD.tab

Banjo (gDF#AD tuning) [tab]

instrument.fretted.banjo.gDFAD.tab

Banjo (gDGBD tuning) [tab]

instrument.fretted.banjo.gDGBD.tab

Banjo (gDGCD tuning) [tab]

instrument.fretted.banjo.gDGCD.tab

Tenor Banjo [notation]

instrument.fretted.banjo.tenor.5lines

Tenor Banjo [tab]

instrument.fretted.banjo.tenor.tab

Bordonua [notation]

instrument.fretted.bordonua.5lines

Bordonua [tab]

instrument.fretted.bordonua.tab

Cavaquinho [notation]

instrument.fretted.cavaquinho.5lines

Cavaquinho [tab]

instrument.fretted.cavaquinho.tab

Charango [notation]

instrument.fretted.charango.5lines

Charango [tab]

instrument.fretted.charango.tab

Cuatro [notation]

instrument.fretted.cuatro.5lines

Cuatro, Puerto Rico [tab]

instrument.fretted.cuatro.puerto-rico.tab

Cuatro, Venezuela [tab]

instrument.fretted.cuatro.venezuela.tab

Resonator guitar [notation]

instrument.fretted.guitar.resonator.5lines

Resonator Guitar, A6 tuning [tab]

instrument.fretted.guitar.resonator.a6.tab

Resonator Guitar, B11 tuning [tab]

instrument.fretted.guitar.resonator.b11.tab

Resonator Guitar, C#m tuning [tab]

instrument.fretted.guitar.resonator.c#m.tab

Resonator Guitar, C6+A7 tuning [tab]

instrument.fretted.guitar.resonator.c6-a7.tab

Resonator Guitar, C6 + high G tuning [tab]

instrument.fretted.guitar.resonator.c6-highg.tab

Resonator Guitar, standard tuning [tab]

instrument.fretted.guitar.resonator.c6.tab

Resonator Guitar, C#m7 tuning [tab]

instrument.fretted.guitar.resonator.cm?7.tab

Resonator Guitar, E13 Hawaiian tuning [tab]

instrument.fretted.guitar.resonator.e13-hawaiian.tab

Resonator Guitar, E13 Western tuning [tab]

instrument.fretted.guitar.resonator.e13-western.tab

Resonator Guitar, open A tuning [tab]

instrument.fretted.guitar.resonator.open.A.tab

Resonator Guitar, open G tuning [tab]

instrument.fretted.guitar.resonator.open.G.tab

Dulcimer

instrument.fretted.dulcimer

Dulcimer [notation]

instrument.fretted.dulcimer.5lines

Dulcimer (DAA tuning) [tab]

instrument.fretted.dulcimer.daa.tab

Dulcimer (DAD tuning) [tab]

instrument.fretted.dulcimer.dad.tab

Gamba [notation]

instrument.fretted.gamba.5lines

Gamba [tab]

instrument.fretted.gamba.tab
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12-string Acoustic Guitar [notation]

instrument.fretted.guitar.12-string.5lines

12-string Acoustic Guitar, DADGAD tuning [tab]

instrument.fretted.guitar.12-string.dadgad.tab

12-string Acoustic Guitar, double D tuning [tab]

instrument.fretted.guitar.12-string.double-d.tab

12-string Acoustic Guitar, dropped D tuning [tab]

instrument.fretted.guitar.12-string.dropped-d.tab

12-string Acoustic Guitar, open D tuning [tab]

instrument.fretted.guitar.12-string.open-d.tab

12-string Acoustic Guitar, open E tuning [tab]

instrument.fretted.guitar.12-string.open-e.tab

12-string Acoustic Guitar, open G tuning [tab]

instrument.fretted.guitar.12-string.open-g.tab

12-string Acoustic Guitar, standard tuning (no rhythms)
[tab]

instrument.fretted.guitar.12-string.tab

12-string Acoustic Guitar, standard tuning [tab]

instrument.fretted.guitar.12-string.tab.rhythms

Acoustic Guitar [notation]

instrument.fretted.guitar.acoustic.5lines

Acoustic Guitar, DADGAD tuning [tab]

instrument.fretted.guitar.acoustic.dadgad.tab

Acoustic Guitar, double D tuning [tab]

instrument.fretted.guitar.acoustic.double-d.tab

Acoustic Guitar, dropped D tuning [tab]

instrument.fretted.guitar.acoustic.dropped-d.tab

Acoustic Guitar, modal D tuning [tab]

instrument.fretted.guitar.acoustic.modal-d.tab

Acoustic Guitar, Nashville tuning [tab]

instrument.fretted.guitar.acoustic.nashville.tab

Acoustic Guitar, open A tuning [tab]

instrument.fretted.guitar.acoustic.open-a.tab

Acoustic Guitar, open C tuning [tab]

instrument.fretted.guitar.acoustic.open-c.tab

Acoustic Guitar, open D tuning [tab]

instrument.fretted.guitar.acoustic.open-d.tab

Acoustic Guitar, open Dm cross-note tuning [tab]

instrument.fretted.guitar.acoustic.open-dm.tab

Acoustic Guitar, open E tuning [tab]

instrument.fretted.guitar.acoustic.open-e.tab

Acoustic Guitar, open G tuning [tab]

instrument.fretted.guitar.acoustic.open-g.tab

Acoustic Guitar, standard tuning (no rhythms) [tab]

instrument.fretted.guitar.acoustic.tab

Acoustic Guitar, standard tuning [tab]

instrument.fretted.guitar.acoustic.tab.rhythms

4-string Bass Guitar [notation]

instrument.fretted.guitar.bass.4-string.5lines

4-string Bass Guitar [tab]

instrument.fretted.guitar.bass.4-string.tab

5-string Bass Guitar [notation]

instrument.fretted.guitar.bass.5-string.5lines

5-string Bass Guitar [tab]

instrument.fretted.guitar.bass.5-string.tab

Bass Guitar [notation]

instrument.fretted.guitar.bass.5lines

6-string Bass Guitar [notation]

instrument.fretted.guitar.bass.6-string.5lines

6-string Bass Guitar [tab]

instrument.fretted.guitar.bass.6-string.tab

Acoustic Bass [notation]

instrument.fretted.guitar.bass.acoustic.5lines

Acoustic Bass [tab]

instrument.fretted.guitar.bass.acoustic.tab

5-string Electric Bass [notation]

instrument.fretted.guitar.bass.electric.5-string.5lines

5-string Electric Bass [tab]

instrument.fretted.guitar.bass.electric.5-string.tab

Electric Bass [notation]

instrument.fretted.guitar.bass.electric.5lines

6-string Electric Bass [notation]

instrument.fretted.guitar.bass.electric.6-string.5lines

Global Constants

102




6-string Electric Bass [tab]

instrument.fretted.guitar.bass.electric.6-string.tab

5-string Fretless Electric Bass

instrument.fretted.guitar.bass.electric.fretless.5-string.5lines

5-string Fretless Electric Bass [tab]

instrument.fretted.guitar.bass.electric.fretless.5-string.tab

Fretless Electric Bass [notation]

instrument.fretted.guitar.bass.electric.fretless.5lines

6-string Fretless Electric Bass

instrument.fretted.guitar.bass.electric.fretless.6-string.5lines

6-string Fretless Electric Bass [tab]

instrument.fretted.guitar.bass.electric.fretless.6-string.tab

Fretless Electric Bass [tab]

instrument.fretted.guitar.bass.electric.fretless.tab

Electric Bass [tab]

instrument.fretted.guitar.bass.electric.tab

5-string Fretless Bass Guitar [notation]

instrument.fretted.guitar.bass.fretless.5-string.5lines

5-string Fretless Bass Guitar [tab]

instrument.fretted.guitar.bass.fretless.5-string.tab

Fretless Bass Guitar [notation]

instrument.fretted.guitar.bass.fretless.5lines

6-string Fretless Bass Guitar [notation]

instrument.fretted.guitar.bass.fretless.6-string.5lines

6-string Fretless Bass Guitar [tab]

instrument.fretted.guitar.bass.fretless.6-string.tab

Fretless Bass Guitar [tab]

instrument.fretted.guitar.bass.fretless.tab

Semi-Acoustic Bass [notation]

instrument.fretted.guitar.bass.semi-acoustic.5lines

Semi-Acoustic Bass [tab]

instrument.fretted.guitar.bass.semi-acoustic.tab

Bass Guitar [tab]

instrument.fretted.guitar.bass.tab

Bass Guitar [tab, with rhythms]

instrument.fretted.guitar.bass.tab.rhythms

Classical Guitar [notation]

instrument.fretted.guitar.classical.5lines

Classical Guitar, DADGAD tuning [tab]

instrument.fretted.guitar.classical.dadgad.tab

Classical Guitar, double D tuning [tab]

instrument.fretted.qguitar.classical.double-d.tab

Classical Guitar, dropped D tuning [tab]

instrument.fretted.guitar.classical.dropped-d.tab

Classical Guitar, open D tuning [tab]

instrument.fretted.guitar.classical.open-d.tab

Classical Guitar, open E tuning [tab]

instrument.fretted.guitar.classical.open-e.tab

Classical Guitar, open G tuning [tab]

instrument.fretted.guitar.classical.open-g.tab

Classical Guitar, standard tuning (no rhythms) [tab]

instrument.fretted.guitar.classical.tab

Classical Guitar, standard tuning [tab]

instrument.fretted.guitar.classical.tab.rhythms

Electric Guitar [notation]

instrument.fretted.guitar.electric.5lines

7-string Electric Guitar, low A tuning [tab]

instrument.fretted.guitar.electric.7-string.low-a.tab

7-string Electric Guitar, low B tuning [tab]

instrument.fretted.qguitar.electric.7-string.tab

Electric Guitar, DADGAD tuning [tab]

instrument.fretted.guitar.electric.dadgad.tab

Electric Guitar, double D tuning [tab]

instrument.fretted.guitar.electric.double-d.tab

Electric Guitar, dropped D tuning [tab]

instrument.fretted.qguitar.electric.dropped-d.tab

Electric Guitar, open D tuning [tab]

instrument.fretted.guitar.electric.open-d.tab

Electric Guitar, open E tuning [tab]

instrument.fretted.guitar.electric.open-e.tab

Electric Guitar, open G tuning [tab]

instrument.fretted.guitar.electric.open-g.tab

Electric Guitar, standard tuning (no rhythms) [tab]

instrument.fretted.guitar.electric.tab
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Electric Guitar, standard tuning [tab]

instrument.fretted.guitar.electric.tab.rhythms

Kora

instrument.fretted.guitar.kora

Semi-acoustic Guitar [notation]

instrument.fretted.guitar.semi-acoustic.5lines

Semi-acoustic Guitar, DADGAD tuning [tab]

instrument.fretted.guitar.semi-acoustic.dadgad.tab

Semi-acoustic Guitar, double D tuning [tab]

instrument.fretted.guitar.semi-acoustic.double-d.tab

Semi-acoustic Guitar, dropped D tuning [tab]

instrument.fretted.guitar.semi-acoustic.dropped-d.tab

Semi-acoustic Guitar, open D tuning [tab]

instrument.fretted.guitar.semi-acoustic.open-d.tab

Semi-acoustic Guitar, open E tuning [tab]

instrument.fretted.guitar.semi-acoustic.open-e.tab

Semi-acoustic Guitar, open G tuning [tab]

instrument.fretted.guitar.semi-acoustic.open-g.tab

Semi-acoustic Guitar, standard tuning (no rhythms) [tab]

instrument.fretted.guitar.semi-acoustic.tab

Semi-acoustic Guitar, standard tuning [tab]

instrument.fretted.guitar.semi-acoustic.tab.rhythms

10-string Hawaiian Steel Guitar [tab]

instrument.fretted.guitar.steel.hawaiian.10-string.tab

Hawaiian Steel Guitar [notation]

instrument.fretted.guitar.steel.hawaiian.5lines

6-string Hawaiian Steel Guitar, standard tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab

6-string Hawaiian Steel Guitar, alternate tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.alternative

6-string Hawaiian Steel Guitar, slack key
Bb Mauna Loa tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.bflat. mauna.loa

6-string Hawaiian Steel Guitar, slack key
C Mauna Loa tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.c.mauna.loa

6-string Hawaiian Steel Guitar, slack key
Wahine CGDGBD tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.cgdgbd.wahine

6-string Hawaiian Steel Guitar, slack key
Wahine CGDGBE tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.cgdgbe.wahine

6-string Hawaiian Steel Guitar, slack key
Wahine DGDF#BD tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.dgdfbd.wahine

6-string Hawaiian Steel Guitar, slack key
G Mauna Loa tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.g.mauna.loa

6-string Hawaiian Steel Guitar, slack key
G Taro Patch tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.g.taro.patch

6-string Hawaiian Steel Guitar, slack key
Wahine GCDGBE tuning [tab]

instrument.fretted.guitar.steel.hawaiian.6-string.tab.gcdgbe.wahine

8-string Hawaiian Steel Guitar [tab]

instrument.fretted.guitar.steel.hawaiian.8-string.tab

8-string Hawaiian Steel Guitar, alternate tuning [tab]

instrument.fretted.guitar.steel.hawaiian.8-string.tab.alternative

Hawaiian Steel Guitar [tab]

instrument.fretted.guitar.steel.hawaiian.tab

Pedal Steel Guitar [notation]

instrument.fretted.guitar.steel.pedal.5lines

Pedal Steel Guitar [tab]

instrument.fretted.guitar.steel.pedal.tab

Guitarra [notation]

instrument.fretted.guitarra.5lines

Guitarra, Coimbra [tab]

instrument.fretted.guitarra.coimbra.tab

Guitarra, Lisboa [tab]

instrument.fretted.guitarra.lisboa.tab

Guitarra, Portuguesa [tab]

instrument.fretted.guitarra.portuguesa.tab
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Guitarrén [notation]

instrument.fretted.guitarron.5lines

Guitarrén [tab]

instrument.fretted.guitarron.tab

Ladd [notation]

instrument.fretted.laud.5lines

Laud [tab]

instrument.fretted.laud.tab

Tenor Lute [notation]

instrument.fretted.lute.5lines

Bass Lute [notation]

instrument.fretted.lute.bass-d.french.english.5lines

Bass Lute, D tuning, French/English [tab]

instrument.fretted.lute.bass-d.french.english.tab

Bass Lute, D tuning, Italian [tab]

instrument.fretted.lute.bass-d.italian.tab

Bass Lute, D tuning, Spanish [tab]

instrument.fretted.lute.bass-d.spanish.tab

Tenor Lute, G tuning, Italian [tab]

instrument.fretted.lute.italian.tab

Tenor Lute, G tuning, Spanish [tab]

instrument.fretted.lute.spanish.tab

Tenor Lute, G tuning, French/English [tab]

instrument.fretted.lute.tab

Tenor Lute, A tuning, French/English [tab]

instrument.fretted.lute.tenor-a.french.english.tab

Tenor Lute, A tuning, Italian [tab]

instrument.fretted.lute.tenor-a.italian.tab

Tenor Lute, A tuning, Spanish [tab]

instrument.fretted.lute.tenor-a.spanish.tab

Treble Lute [notation]

instrument.fretted.lute.treble-d.french.english.5lines

Treble Lute, D tuning, French/English [tab]

instrument.fretted.lute.treble-d.french.english.tab

Treble Lute, D tuning, Italian [tab]

instrument.fretted.lute.treble-d.italian.tab

Treble Lute, D tuning, Spanish [tab]

instrument.fretted.lute.treble-d.spanish.tab

Mandolin [notation]

instrument.fretted.mandolin.5lines

Mandolin [tab]

instrument.fretted.mandolin.tab

Oud [notation]

instrument.fretted.oud.5lines

oud [tab]

instrument.fretted.oud.tab

Qanoon

instrument.fretted.qanoon.5lines

Requinto [notation]

instrument.fretted.requinto.5lines

Requinto [tab]

instrument.fretted.requinto.tab

Santoor

instrument.fretted.santoor.5lines

Sitar [notation]

instrument.fretted.sitar.5lines

Sitar (Ravi Shankar) [tab]

instrument.fretted.sitar.ravi-shankkar.tab

Sitar (Vilayat Khan) [tab]

instrument.fretted.sitar.vilayat-khan.tab

Tambura (Female) [notation]

instrument.fretted.tambura.female

Tambura (Male) [notation]

instrument.fretted.tambura.male

Tiple [notation]

instrument.fretted.tiple.5lines

Tiple, Argentina [tab]

instrument.fretted.tiple.argentina.tab

Tiple, Colombia ADF#B tuning [tab]

instrument.fretted.tiple.colombia.tab.adfb

Tiple, Colombia DGBE tuning [tab]

instrument.fretted.tiple.colombia.tab.dgbe

Tiple, Cuba [tab]

instrument.fretted.tiple.cuba.tab
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Tiple, Peru [tab]

instrument.fretted.tiple.peru.tab

Tiple, Santo Domingo [tab]

instrument.fretted.tiple.santo.domingo.tab

Tiple, Uruguay [tab]

instrument.fretted.tiple.uruguay.tab

Tres [notation]

instrument.fretted.tres.5lines

Tres, GCE tuning [tab]

instrument.fretted.tres.tab

Tres, ADF# tuning [tab]

instrument.fretted.tres.tab.adf

Tres, GBE tuning [tab]

instrument.fretted.tres.tab.gbe

Ukulele [notation]

instrument.fretted.ukulele.5lines

Ukulele [tab]

instrument.fretted.ukulele.tab

Vihuela [notation]

instrument.fretted.vihuela.5lines

Vihuela [tab]

instrument.fretted.vihuela.tab

Zither instrument.fretted.zither
Keyboard instrument.keyboard
Accordion instrument.keyboard.accordion
Bandoneon instrument.keyboard.bandoneon
Celesta instrument.keyboard.celesta
Clavichord instrument.keyboard.clavichord
Harmonium instrument.keyboard.harmonium

Harpsichord

instrument.keyboard.harpsichord

Keyboards

instrument.keyboard.keyboards

Tape Sampler Keyboard [Brass]

instrument.keyboard.tape sampler.brass

Tape Sampler Keyboard [Choir]

instrument.keyboard.tape sampler.choir

Tape Sampler Keyboard [Flute]

instrument.keyboard.tape sampler.flute

Tape Sampler Keyboard [Strings]

instrument.keyboard.tape sampler

Melodeon

instrument.keyboard.melodeon

Electric Organ

instrument.keyboard.organ.electric

Organ [manuals]

instrument.keyboard.organ.manuals

Manual [solo organ manuals]

instrument.keyboard.organ.manuals.solo

Ped. [Organ pedals]

instrument.keyboard.organ.pedals

Pedal [solo organ pedals]

instrument.keyboard.organ.pedals.solo

Piano

instrument.keyboard.piano

Electric Piano

instrument.keyboard.piano.electric

Electric Clavichord

instrument.keyboard.piano.electric.clavichord

Electric Stage Piano

instrument.keyboard.piano.electric.stage

Overdriven Electric Piano

instrument.keyboard.piano.electric.overdriven

Honky-tonk Piano

instrument.keyboard.piano.honky-tonk

Synthesizer

instrument.keyboard.synthesizer
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Unnamed (2 lines)

instrument.other.2lines

Unnamed (3 lines)

instrument.other.3lines

Unnamed (4 lines)

instrument.other.4lines

Unnamed (bass staff)

instrument.other.bassclef

No instrument (barlines shown)

instrument.other.none.barlines

No instrument (bar rests shown)

instrument.other.none.barrests

No instrument (hidden)

instrument.other.none.hidden

Solo

instrument.other.solo.real

Unnamed (treble staff)

instrument.other.trebleclef

Almglocken

instrument.pitchedpercussion.almglocken

Antique Cymbals

instrument.pitchedpercussion.antiquecymbals

Chimes

instrument.pitchedpercussion.bells.chimes

Chimes [no key]

instrument.pitchedpercussion.bells.chimes.nokeysig

Bell lyre [marching band]

instrument.pitchedpercussion.bells.marching

Orchestral Bells

instrument.pitchedpercussion.bells.orchestral

Tubular Bells

instrument.pitchedpercussion.bells.tubular

Cimbalom instrument.pitchedpercussion.cimbalom
Crotales instrument.pitchedpercussion.crotales
Steel Drums instrument.pitchedpercussion.drums.steel

Steel Drums [bass clef, treble transp.]

instrument.pitchedpercussion.drums.steel.bassclef

Gamelan Kengong

instrument.pitchedpercussion.gamelan.kengong

Gamelan Slentam

instrument.pitchedpercussion.gamelan.slentam

Glockenspiel

instrument.pitchedpercussion.glockenspiel

Alto Glockenspiel

instrument.pitchedpercussion.glockenspiel.alto

Soprano Glockenspiel

instrument.pitchedpercussion.glockenspiel.soprano

Handbells instrument.pitchedpercussion.handbells
Harp instrument.pitchedpercussion.harp
Lever Harp instrument.pitchedpercussion.harp.lever
Kalimba instrument.pitchedpercussion.kalimba

Marimba [grand staff]

instrument.pitchedpercussion.marimba

Marimba [treble staff]

instrument.pitchedpercussion.marimba.trebleclef

Alto Metallophone

instrument.pitchedpercussion.metallophone.alto

Bass Metallophone

instrument.pitchedpercussion.metallophone.bass

Soprano Metallophone

instrument.pitchedpercussion.metallophone.soprano

Roto-toms

instrument.pitchedpercussion.roto-toms

Temple Blocks

instrument.pitchedpercussion.templeblocks

Timpani [with key]

instrument.pitchedpercussion.timpani
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Timpani [no key]

instrument.pitchedpercussion.timpani.nokeysig

Vibraphone

instrument.pitchedpercussion.vibraphone

Wood Blocks [5 lines]

instrument.pitchedpercussion.woodblocks

Xylophone

instrument.pitchedpercussion.xylophone

Alto Xylophone

instrument.pitchedpercussion.xylophone.alto

Bass Xylophone

instrument.pitchedpercussion.xylophone.bass

Contra Bass Bar

instrument.pitchedpercussion.xylophone.contrabass.bar

Gyil

instrument.pitchedpercussion.xylophone.gyil

Soprano Xylophone

instrument.pitchedpercussion.xylophone.soprano

Xylorimba instrument.pitchedpercussion.xylorimba
Alto instrument.singers.alto

Solo Alto instrument.singers.alto.solo

Altus instrument.singers.altus

Baritone instrument.singers.baritone

Solo Baritone

instrument.singers.baritone.solo

Bass instrument.singers.bass

Solo Bass instrument.singers.bass.solo
Bassus instrument.singers.bassus
Cantus instrument.singers.cantus

Choir instrument.singers.choir
Contralto instrument.singers.contralto
Countertenor instrument.singers.counter-tenor
Mean instrument.singers.mean

Mezzo-soprano

instrument.singers.mezzo-soprano

Quintus instrument.singers.quintus
Secundus instrument.singers.secundus
Soprano instrument.singers.soprano

Solo Soprano

instrument.singers.soprano.solo

Tenor instrument.singers.tenor
Solo Tenor instrument.singers.tenor.solo
Treble instrument.singers.treble
Solo Treble instrument.singers.treble.solo
Voice instrument.singers.voice

Voice [male]

instrument.singers.voice.male

Contrabass

instrument.strings.contrabass

Bass [Double]

instrument.strings.contrabass.bass

Double Bass

instrument.strings.contrabass.double-bass
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Solo Contrabass

instrument.strings.contrabass.solo

String Bass

instrument.strings.contrabass.string

Upright Bass

instrument.strings.contrabass.upright

Hurdy-gurdy

instrument.strings.hurdy-gurdy

Sarangi

instrument.strings.sarangi

Strings

instrument.strings.section

Strings [reduction]

instrument.strings.section.reduction

Bass Viol instrument.strings.viol.bass
Tenor Viol instrument.strings.viol.tenor
Treble Viol instrument.strings.viol.treble
Viola instrument.strings.viola
Solo Viola instrument.strings.viola.solo
Violin 1 instrument.strings.violin.1
Violin 2 instrument.strings.violin.2
Violin | instrument.strings.violin.|
Violin 1l instrument.strings.violin.ii
Solo Violin instrument.strings.violin.solo
Violoncello instrument.strings.violoncello

Solo Violoncello

instrument.strings.violoncello.solo

Anvil

instrument.unpitched.anvil

Cha-cha bell [1 line]

instrument.unpitched.bells.cha-cha

Mambo bell [1 line]

instrument.unpitched.bells.mambo

Sleigh Bells

instrument.unpitched.bells.sleigh

Brake Drum [1 line]

instrument.unpitched.brake-drum.1line

Cabasa[lline]

instrument.unpitched.cabasa

Cabasa[2 lines]

instrument.unpitched.cabasa.2lines

Castanets

instrument.unpitched.castanets

Shaker, Caxixi [1 line]

instrument.unpitched.caxixi.lline

Claves [1 line]

instrument.unpitched.claves

Shaker, Cocoa Bean Rattle [1 line]

instrument.unpitched.cocoa bean.1line

Finger Cymbals [1 line]

instrument.unpitched.cymbals.finger.1line

Percussion [1 line]

instrument.unpitched.drums.1line

Percussion [2 lines]

instrument.unpitched.drums.2lines

Berimbau

instrument.unpitched.drums.2lines.berimbau

Percussion [3 lines]

instrument.unpitched.drums.3lines

Percussion [4 lines]

instrument.unpitched.drums.4lines

Percussion [5 lines]

instrument.unpitched.drums.5lines
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Agogos [2 lines]

instrument.unpitched.drums.agogos

Bass Drum

instrument.unpitched.drums.bass

Bass Drum [5 lines]

instrument.unpitched.drums.bass.5lines

Marching Bass Drum [3 lines]

instrument.unpitched.drums.bass.marching.3lines

Marching Bass Drum [5 lines]

instrument.unpitched.drums.bass.marching.5lines

Itétele [Bata Drum]

instrument.unpitched.drums.bata.itotele

lya [Bata Drum]

instrument.unpitched.drums.bata.iya

Okoénkolo [Bata Drum]

instrument.unpitched.drums.bata.okonkolo

Bongos [2 lines]

instrument.unpitched.drums.bongos

Bongo Bell [High]

instrument.unpitched.drums.bongos.bell.high

Bongo Bell [Low]

instrument.unpitched.drums.bongos.bell.low

Box

instrument.unpitched.drums.box.3lines

Cajon [2 lines]

instrument.unpitched.drums.cajon

Congas [2 lines]

instrument.unpitched.drums.congas

Congas [1 line]

instrument.unpitched.drums.congas.1line

Congas [3 lines]

instrument.unpitched.drums.congas.3lines

Congas [4 lines]

instrument.unpitched.drums.congas.4lines

Cuica [3 lines]

instrument.unpitched.drums.cuica.3lines

Cymbals

instrument.unpitched.drums.cymbal

Marching Cymbals [5 lines]

instrument.unpitched.drums.cymbals.marching.5lines

Djembe [3 lines]

instrument.unpitched.drums.djembe.3lines

Drum Set (Rock)

instrument.unpitched.drums.drumset

Drum Set (Alternative)

instrument.unpitched.drums.drumset.alternative

Drum Set (Brushes)

instrument.unpitched.drums.drumset.brushes

Drum Set (Dance)

instrument.unpitched.drums.drumset.dance

Drum Set (Disco)

instrument.unpitched.drums.drumset.disco

Drum Set (Electronica)

instrument.unpitched.drums.drumset.electronic

Drum Set (Fusion)

instrument.unpitched.drums.drumset.fusion

Drum Set (Garage)

instrument.unpitched.drums.drumset.garage

Drum Set (Hip-hop)

instrument.unpitched.drums.drumset.hip-hop

Drum Set (Industrial)

instrument.unpitched.drums.drumset.industrial

Drum Set (Jazz)

instrument.unpitched.drums.drumset.jazz

Drum Set (Lo-Fi)

instrument.unpitched.drums.drumset.lo-fi

Drum Set (Metal)

instrument.unpitched.drums.drumset.metal

Drum Set (Motown)

instrument.unpitched.drums.drumset.motown

Drum Set (New Age)

instrument.unpitched.drums.drumset.new age

Drum Set (Pop)

instrument.unpitched.drums.drumset.pop
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Drum Set (Reggae)

instrument.unpitched.drums.drumset.reggae

Drum Set (Stadium Rock)

instrument.unpitched.drums.drumset.rock.stadium

Drum Set (Rods)

instrument.unpitched.drums.drumset.rods

Drum Set (Drum Machine)

instrument.unpitched.drums.drumset.tr-808

Dumbek [3 lines]

instrument.unpitched.drums.dumbek.3lines

Kidi [Ewe Drum]

instrument.unpitched.drums.ewe.kidi

Sogo [Ewe Drum]

instrument.unpitched.drums.ewe.sogo

Gankokwe (Bell)

instrument.unpitched.drums.gankokwe

Jam Blocks [2 lines]

instrument.unpitched.drums.jamblocks

Jawbone [1 line]

instrument.unpitched.drums.jawbone.lline

Pandeiro [2 lines]

instrument.unpitched.drums.pandeiro

Rain Stick (High) [1 line]

instrument.unpitched.drums.rainstick.high.1line

Rain Stick (Low) [1ling]

instrument.unpitched.drums.rainstick.low.1line

Egg Shaker (High) [1 line]

instrument.unpitched.drums.shaker.high.1line

Egg Shaker (Low) [1 line]

instrument.unpitched.drums.shaker.low.1line

Egg Shaker (Medium) [1 line]

instrument.unpitched.drums.shaker.medium.1line

Side Drum

instrument.unpitched.drums.side

Snare Drum

instrument.unpitched.drums.share

Marching Snare Drums [5 lines]

instrument.unpitched.drums.snare.5lines

Surdo [2 lines]

instrument.unpitched.drums.surdo

Tabla instrument.unpitched.drums.table
Taiko Drum instrument.unpitched.drums.taiko
Tenor Drum instrument.unpitched.drums.tenor

Marching Tenor Drums [5 lines]

instrument.unpitched.drums.tenor.marching

Quads [5 lines]

instrument.unpitched.drums.tenor.marching.quads

Tom-toms [5 lines]

instrument.unpitched.drums.tom-toms

Tom-toms [4 lines]

instrument.unpitched.drums.tom-toms.4lines

Udu

instrument.unpitched.drums.udu

Shaker, Egg Shaker [1 line]

instrument.unpitched.egg shaker.1line

Finger Click [1 line]

instrument.unpitched.fingerclick

Gamelan Gong Ageng (High) [1 line]

instrument.unpitched.gamelan.gong-ageng.high

Gamelan Gong Ageng (Low) [1 line]

instrument.unpitched.gamelan.gong-ageng.low

Gamelan Kempyang and Ketuk [2 lines]

instrument.unpitched.gamelan.kempyang-ketuk

Gamelan Khendang Ageng [1 line]

instrument.unpitched.gamelan.khendang-ageng

Gamelan Khendang Ciblon [1 line]

instrument.unpitched.gamelan.khendang-ciblon

Large Gong [1 line]

instrument.unpitched.gong.large.1line

Medium Gong [1 line]

instrument.unpitched.gong.medium.1line
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Gourd [1 line]

instrument.unpitched.gourd

Guira[1 line]

instrument.unpitched.guira

Guiro (High) [1 line]

instrument.unpitched.guiro.high

Guiro (Medium) [1 line]

instrument.unpitched.guiro.medium

Handclap [1 line]

instrument.unpitched.handclap

Shaker, Kayamba [1 line]

instrument.unpitched.kayamba.lline

Maracas

instrument.unpitched.maracas

Shaker, Gourd Maracas [1 line]

instrument.unpitched.maracas.gourd.1line

Maracas [High]

instrument.unpitched.maracas.high

Maracas [Medium]

instrument.unpitched.maracas.medium

Mark tree [1 line]

instrument.unpitched.marktree

Shaker, Nsak Rattle [1 line]

instrument.unpitched.nsak.1line

Finger Snaps

instrument.unpitched.orff.fingersnaps

Hand Claps instrument.unpitched.orff.handclaps
Patsch instrument.unpitched.orff.patsch
Stamp instrument.unpitched.orff.stamp

Salsa bell [1 line]

instrument.unpitched.salsa.bell

Shaker [1 line]

instrument.unpitched.shaker

Shaker, Shekere [1 line]

instrument.unpitched.shekere.lline

Tam-tam

instrument.unpitched.tam-tam

Tambourine

instrument.unpitched.tambourine

Timbales [2 lines]

instrument.unpitched.timbales.2lines

Timbales [5 lines]

instrument.unpitched.timbales.5lines

Triangle

instrument.unpitched.triangle

Shaker, Wasembe Rattle (High) [1 line]

instrument.unpitched.wasembe.high.1line

Shaker, Wasembe Rattle (Low) [1 line]

instrument.unpitched.wasembe.low.1line

Shaker, Wasembe Rattle (Medium) [1 line]

instrument.unpitched.wasembe.medium.1line

Whip

instrument.unpitched.whip

Whistle

instrument.unpitched.whistle

Wind Chimes [1 line]

instrument.unpitched.wind-chimes.1line

Wood Block [1 ling]

instrument.unpitched.woodblock.1line

Bagpipes

instrument.wind.bagpipe

Basset Horn

instrument.wind.basset-horn

Bassoon

instrument.wind.bassoon

Contrabassoon

instrument.wind.bassoon.contrabassoon

Quart Bassoon

instrument.wind.bassoon.quart

Quint Bassoon

instrument.wind.bassoon.quint
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Clarinet in A

instrument.wind.clarinet.a

Clarinet in Ab

instrument.wind.clarinet.aflat

Alto Clarinet in Eb

instrument.wind.clarinet.alto.eflat

Alto Clarinet in Eb [bass clef, treble transp.]

instrument.wind.clarinet.alto.eflat.bassclef

Bass Clarinet in Bb

instrument.wind.clarinet.bass.bflat

Bass Clarinet in Bb [score sounds 8vb]

instrument.wind.clarinet.bass.bflat.8vb-score

Bass Clarinet in Bb [bass clef, treble transp.]

instrument.wind.clarinet.bass.bflat.bassclef

Clarinet in Bb

instrument.wind.clarinet.bflat

Clarinetin C

instrument.wind.clarinet.c

Contra Alto Clarinet in Eb

instrument.wind.clarinet.contra.alto.eflat

Contra Alto Clarinet in Eb [score sounds 8vb]

instrument.wind.clarinet.contra.alto.eflat.8vb-score

Contra Alto Clarinet in Eb [bass clef, treble transp.]

instrument.wind.clarinet.contra.alto.eflat.bassclef

Contrabass Clarinet in Bb

instrument.wind.clarinet.contrabass.bflat

Contrabass Clarinet in Bb [score sounds 15mb]

instrument.wind.clarinet.contrabass.bflat.15mb-score

Contrabass Clarinet in Bb [bass clef, treble transp.]

instrument.wind.clarinet.contrabass.bflat.bassclef

Clarinet in D

instrument.wind.clarinet.d

Clarinet in Eb

instrument.wind.clarinet.eflat

Clarinetin G

instrument.wind.clarinet.g

Cor Anglais instrument.wind.coranglais
Didgeridoo instrument.wind.didgeridoo
Duduk instrument.wind.duduk
English Horn instrument.wind.englishhorn
Flageolet instrument.wind.flageolet
Flute instrument.wind.flute

Alto Flute instrument.wind.flute.alto
Bansuri instrument.wind.flute.bansuri
Bass Flute instrument.wind.flute.bass
Eb Flute instrument.wind.flute.eflat
G Flute instrument.wind.flute.g
Harmonica instrument.wind.harmonica

Heckelphone

instrument.wind.heckelphone

Mey instrument.wind.mey
Nai instrument.wind.nai
Oboe instrument.wind.oboe

Baritone Oboe

instrument.wind.oboe.baritone

Bass Oboe

instrument.wind.oboe.bass

Oboe d'Amore

instrument.wind.oboe.damore
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Ocarina instrument.wind.ocarina
Panpipes instrument.wind.panpipes
Piccolo instrument.wind.piccolo

Military Piccolo in Db

instrument.wind.piccolo.dflat

Alto Recorder

instrument.wind.recorder.alto

Bass Recorder

instrument.wind.recorder.bass

Great Bass Recorder

instrument.wind.recorder.bass.great

Contrabass Recorder

instrument.wind.recorder.contrabass

Descant Recorder

instrument.wind.recorder.descant

Sopranino Recorder

instrument.wind.recorder.sopranino

Soprano Recorder

instrument.wind.recorder.soprano

Tenor Recorder

instrument.wind.recorder.tenor

Treble Recorder

instrument.wind.recorder.treble

Alto Saxophone

instrument.wind.saxophone.alto

Baritone Saxophone

instrument.wind.saxophone.baritone

Baritone Saxophone [score sounds 8vb]

instrument.wind.saxophone.baritone.8vb-score

Baritone Saxophone [bass clef, treble transp.]

instrument.wind.saxophone.baritone.bassclef

Bass Saxophone

instrument.wind.saxophone.bass

Bass Saxophone [score sounds 15mb]

instrument.wind.saxophone.bass.15mb-score

Bass Saxophone [bass clef, treble transp.]

instrument.wind.saxophone.bass.bassclef

C Melody Saxophone

instrument.wind.saxophone.c-melody

Contrabass (Tubax) Saxophone

instrument.wind.saxophone.contrabass

Contrabass (Tubax) Saxophone [score sounds 15mb]

instrument.wind.saxophone.contrabass.15mb-score

Contrabass (Tubax) Sax [bass clef, treble transp.]

instrument.wind.saxophone.contrabass.bassclef

F Mezzo Soprano Saxophone

instrument.wind.saxophone.mezz-soprano.f

Sopranino Saxophone

instrument.wind.saxophone.sopranino

Piccolo Saxophone in Bb [Soprillo]

instrument.wind.saxophone.sopranino.bflat

Soprano Saxophone

instrument.wind.saxophone.soprano

C Soprano Saxophone

instrument.wind.saxophone.soprano.c

Subcontrabass (Tubax) Saxophone

instrument.wind.saxophone.subcontrabass

Subcontrabass (Tubax) Saxophone [score sounds 15mb]

instrument.wind.saxophone.subcontrabass.15mb-score

Subcontrabass (Tubax) Sax [bass clef, treble transp.]

instrument.wind.saxophone.subcontrabass.bassclef

Tenor Saxophone

instrument.wind.saxophone.tenor

Tenor Saxophone [score sounds 8vb]

instrument.wind.saxophone.tenor.8vb-score

Tenor Saxophone [bass clef, treble transp.]

instrument.wind.saxophone.tenor.bassclef

Woodwind

instrument.wind.section
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Shakuhachi

instrument.wind.shakuhachi

Tin Whistle

instrument.wind.whistle.tin

Beam Options

For the Beam variable of NoteRest objects.

NoBeam 1
StartBeam 2
ContinueBeam 3
SingleBeam 4

Bracket Types

For the AddBracket () method of BracketList objects, and the BracketType variable of Bracket objects.

BracketFull 0

BracketBrace 1

BracketSub 2
Breaks

These constants are used by the SetBreakType () method of Score objects.

MiddleOfSystem

EndOfSystem 2
MiddleOfPage 3
EndOfPage 4
NotEndOfSystem 5
EndOfSystemOrPage 6
Default 7
SpecialPageBreak 8

These constants correspond to the menu entries in the Bars panel of the Properties window in the following way:

MiddleOfSystem Middle of system. The bar can only appear in the middle of a system, not at the end.

EndOfSystem No menu entry; created by Layout > Lock Format. The bar can only appear at the end of a mid-page system,
not the middle of a system or the end of a page.

MiddleOfPage Middle of page. The bar can appear anywhere except at the end of a page.

EndOfPage Page break. The bar can only appear at the end of a page.

NotEndOfSystem No menu entry. The bar can appear anywhere except the end of a mid-page system.

EndOfSystemOrPage System break. The bar can only appear at the end of a mid-page system or the end of a page.

Default No break. The bar can appear anywhere.
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Notethat in older versions of ManuScript the constant Midd 1eO0fSystem was called NoBreak and the constant EndOfSystem was
caled SystemBreak. These older names were confusing, because they implied a correlation with the similarly-named menu itemsin
the Properties window that was not accurate. The old names are still supported for old plug-ins, but should not be used for new plug-ins.
For consistency, the old constant PageBreak has also been renamed EndOfPage, even though this did correlate correctly with the

Properties window.

Accidentals

For the Accidental variable of Note objects.

DoubleSharp 2
Sharp 1
Natural 0
Flat -1
DoubleFlat -2

Note Style Names

For the NoteStyl e variable of Note objects; these correspond to the noteheads available from the Notes panel of the Properties
window in the manuscript papers that are supplied with Sibelius.

NormalNoteStyle 0 BackSlashedNoteStyle 12
CrossNoteStyle 1 ArrowDownNoteStyle 13
DiamondNoteStyle 2 ArrowUpNoteStyle 14
BeatWithoutStemNoteStyle 3 InvertedTriangleNoteStyle 15
BeatNoteStyle 4 ShapedNotelNoteStyle 16
CrossOrDiamondNoteStyle 5 ShapedNote2NoteStyle 17
BlackAndWhiteDiamondNoteStyle 6 ShapedNote3NoteStyle 18
HeadlessNoteStyle 7 ShapedNote4StemUpNoteStyle 19
StemlessNoteStyle 8 ShapedNote4StemDownNoteStyle 23
SilentNoteStyle 9 ShapedNote5NoteStyle 20
CueNoteStyle 10 ShapedNote6NoteStyle 21
SlashedNoteStyle 11 ShapedNote7NoteStyle 22

MuteMode Constants

These are the possible values of Stave .MuteMode:

Muted 0
HalfMuted 1
NotMuted 2
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Articulations

Used with Note.GetArticulation and Note.SetArticulation.

Custom3Artic 15
TriPauseArtic 14
PauseArtic 13
SquarePauseArtic 12
Custom2Artic 11
DownBowArtic 10
UpBowArtic 9
PlusArtic 8
HarmonicArtic 7
MarcatoArtic 6
AccentArtic 5
TenutoArtic 4
WedgeArtic 3
StaccatissimoArtic 2
StaccatoArtic 1
Custom1Artic 0
SyllableTypes for Lyricltems
UsedinLyricltem.
MiddleOfWord 0
EndOfWord 1
Accidental Styles
Asused by Note.AccidentalStyle.
NormalAcc “0”
HiddenAcc “1"
CautionaryAcc “2"
BracketedAcc “3”

Time Signature Strings

These define the unicode characters used to draw common time and alla breve time signatures, so that you can recognize these by

comparison with TimeSignature . Text.
CommonTimeString

AllaBreveTimeString
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Symbols

There are alot of symbolsin Sibelius. We' ve defined named constants for the indices of some of the most frequently used symbols,
which can be passed to Bar . AddSymbol. For other symbols, you can work out the required index by “counting along” in the
Create > Symbol dialog of Sibelius, or by using the method Score . Symbol Index. To help with the“counting along,” we' ve defined
aconstant for the start of every group of symbolsin the Create > Symbol dialog, and these are also given below. Then for exampleyou
can access the 8va symbol as OctaveSymbols + 2.

Common Symbol Indices
SegnoSymbol “1”
CodaSymbol “2"
RepeatBeatSymbol “5”
RepeatBarSymbol “6”
RepeatTwoBarsSymbol “rr
TrillSymbol “32"
BracketedTrillSymbol “33”
MordentSymbol “36”
InvertedMordentSymbol “37"
TurnSymbol “38”
InvertedTurnSymbol “39”
ReversedTurnSymbol “40”
TripleMordentSymbol ‘41"
InvertedTripleMordentSymbol ‘42"
PedalSymbol ‘48"
PedalPSymbol “49”
PedalUpSymbol “50”
LiftPedalSymbol “51”
HeelOneSymbol “52"
HeelTwoSymbol “53"
ToeOneSymbol “54”
ToeTwoSymbol “55”
CommaSymbol ‘247"
TickSymbol ‘248"
CaesuraSymbol ‘249"
ThickCaesuraSymbol “250”
Indices at the Start of Each Group of Symbols

RepeatSymbols “0”
GeneralSymbols “16”
OrnamentSymbols “32”
KeyboardSymbols “48”

118

Global Constants



ChromaticPercussionSymbols “64”
DrumPercussionSymbols “80”
MetallicPercussionSymbols “96”
OtherPercussionSymbols “112”
BeaterPercussionSymbols “128"
PercussionTechniqueSymbols “160”
GuitarSymbols “176”
ArticulationSymbols “208"
AccidentalSymbols “256”
NoteSymbols 288"
NoteheadSymbols “320"
RestSymbols “368"
ConductorSymbols “400”
ClefSymbols “416"
OctaveSymbols “448"
BreakSymbols ‘464"
TechniqueSymbols “480"
AccordionSymbols ‘496"
HandbellSymbols “528"
MiscellaneousSymbols “544"
Symbol Size Constants
NormalSize “0”
CueSize “1”
GraceNoteSize “2"
CueGraceNoteSize “3"
Special Page Break Types

NoPageBreak “0”
MusicRestartsAfterXPages “1”
MusicRestartsOnNextLeftPage “2"
MusicRestartsOnNextRightPage “3”
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Interval Types

IntervalDiatonic “-1"
Interval5xDiminished “0”
Interval4xDiminished “1”
Interval3xDiminished “2"
Interval2xDiminished “3"
IntervalDiminished “4r
IntervalMinor “qr
IntervalMajor “5"
IntervalPerfect “5”
IntervalAugmented “6”
Interval2xAugmented T
Interval3xAugmented “8”
IntervaldxAugmented ‘9"
Interval5xAugmented “10”
InMultirest Values
NoMultirest “0”
StartsMultirest “1”
EndsMultirest “2"
MidMultirest “3”
Page Number Visibility Values
PageNumberShowAll “0”
PageNumberHideFirst “1”
PageNumberHideAll “2"
Page Number Format Values
PageNumberFormatNormal “0”
PageNumberFormatRomanUpper “1"
PageNumberFormatRomanLower “2"
PageNumberFormatLetterLower “3"
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Special Barlines

SpecialBarlineStartRepeat “0”
SpecialBarlineEndRepeat “1r
SpecialBarlineDashed “2"
SpecialBarlineDouble “3”
SpecialBarlineFinal “4”
SpecialBarlinelnvisible “5”
SpecialBarlineBetweenStaves “6”
SpecialBarlineNormal T
SpecialBarlineTick “8”
SpecialBarlineShort “9”
Bar Rest Type Values
WholeBarRest “0”
BreveBarRest “1”
OneBarRepeat “2"
TwoBarRepeat “3"
FourBarRepeat “4"

GuitarScaleDiagram Type Values

ScaleTypeMajor “0”
ScaleTypeMinor “1”
ScaleTypeHarmonicMinor “r
ScaleTypeMelodicMinor “3"
ScaleTypeDorian “4r
ScaleTypePhrygian “5”
ScaleTypelLydian “6”
ScaleTypeMixolydian “rr
ScaleTypeLocrian “8”
ScaleTypeWholeTone “9”
ScalrTypeDiminishedHalfWhole “10”
ScaleTypeDiminishedWholeHalf “11”
ScaleTypeAlteredDominant “12”
ScaleTypeLocrianSharp2 “13”
ScaleTypelLydianFlat7 “14”
ScaleTypeMajorBebop “15”
ScaleTypeDominantBebop “16”
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ScaleTypeLydianSharp5 “17”
ScaleTypePhrygianDominant “18”
ScaleTypeAugmentedArpeggio “19”
ScaleTypeMajor7thArpeggio “20”
ScaleType7thArpeggio “21”
ScaleTypeMin7Flat5Arpeggio ‘22"
ScaleTypeDiminished7thArpeggio “23"
ScaleTypeMajorPentatonic “24”
ScaleTypeMinorPentatonic “25”
ScaleTypeOther “26”

FeatheredBeamType Values

For the FeatheredBeamType variable of NoteRest objects.

FeatheredBeamNone “0”
FeatheredBeamAccel “1r
FeatheredBeamRit “2"

Units Values

For the DocumentSetup object.
DocumentSetupUnitsmm “0”
DocumentSetupUnitsinches “1”
DocumentSetupUnitsPoints “2"

Orientation Values

For the Orientation variable of DocumentSetup objects.

OrientationPortrait

Qg

OrientationLandscape

wpn

PageSize Values

For the PageSize variable of DocumentSetup objects.

PageSizeL etter “0”
PageSizeTabloid “1r
PageSizeA5 “2"
PageSizeB5 “3”
PageSizeA4 “4”
PageSizeB4 “5”
PageSizeA3 “6”
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PageSizeUSBand “rr

PageSizeStatement “8”

PageSizeHymn “9”

PageSizeOctavo “10”
PageSizeExecutive “11”
PageSizeQuarto “12”
PageSizeConcert “13”
PageSizeFolio “14”
PageSizelegal “15”
PageSize9_5x12 5 “16”
PageSize1l0x13 “17”
PageSizeCustom “18”

MarginType Values

For the MarginType variable of DocumentSetup objects.

PageMarginsSame “0”
PageMarginsMirrored “1”
PageMarginsDifferent “2"

Tuplets

These define the constants that can be passed as a style parameter to Bar.AddTuplet() and Tuplet. AddNestedTuplet().

TupletNoNumber “0”
TupletLeft “1”
TupletLeftRight “2"
TupletLeftRightNote “3”

These define the constants that can be passed as a bracket parameter:

TupletBracketOff “0”
TupletBracketOn “1”
TupletBracketAuto “2"

SingleTremolos

For the SingleTremolos variable of NoteRest objects, the constants are numbers in the range 0 to 7, representing the number of

tremolo beams on the stem of the note or chord. For a“z on stem” (for buzz rolls), use the value —1 or the constant ZOnStem.
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DoubleTremolo Values

For the double tremolo style variables of EngravingRules objects.

DoubleTremolosTouchingStems ‘0"
DoubleTremolosBetweenStems “1”
DoubleTremolosOuterTremoloTouchingStems “2"

Instrument Name Values

For the instrument name variables of EngravingRules objects.

InstrumentNamesFull “0”
InstrumentNamesShort “1”
InstrumentNamesNone “2"

Types of Objects in a Bar

The Type field for objectsin a bar can return one of the following values:
Clef, SpecialBarline, TimeSignature, KeySignature

Line, ArpeggioLine, Bend, CrescendoLine, DiminuendoLine, GlissandoLine, OctavalLine, PedalLine,
RepeatTimeLine, Slur, Trill, Box, BeamLine, Tuplet, RitardLine, HighLight

Lyricltem, Text, SystemTextltem, GuitarFrame, GuitarScaleDiagram, RehearsalMark, InstrumentChange
BarRest, NoteRest, Graphic, Comment, Bracket, BarNumber
Symbol I'tem, SystemSymbol I'tem
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